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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON'’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Introduction

Digital Photo Professional (hereinafter, “DPP”) is a high-performance
RAW image processing, viewing and editing software for EOS DIGITAL
cameras. It is often thought that RAW images are difficult to handle
compared with ordinary JPEG images, but using DPP, you can perform
advanced edits and print RAW images with ease.

RAW Images and Their Features
What is a RAW Image?

A RAW image is image data that has recorded output data of imaging
sensor. Because image processing does not occur inside the camera
when a photo is taken and the photo has been recorded in the special
form of “RAW image data + Image processing conditions information at
the time of shooting”, special software is needed to view or edit the
image.

* “RAW” means “in a natural condition” or “not processed or refined”.

What is RAW Development?

If described in terms of film, the concept of a RAW image is a shot
image not yet developed (latent image).

With film, the image appears for the first time when it is developed. In
the same way, for RAW images too, you cannot view them as images on

your computer unless you perform subsequent image signal processing.

Therefore, even though it is digital, this processing is called
“development”.

When is RAW Development done?

DPP automatically carries out this “development” processing when
RAW images are displayed in DPP.

As a result, RAW images displayed in DPP are images whose
development processing has been completed.

With DPP, you can view, edit and print RAW images without having to be
particularly conscious of the development processing.

What Advantages Does a RAW Image Have?

RAW images are recorded in the format “RAW image data + Image
processing conditions information at the time of shooting”. When you
open a RAW image in DPP, the image is automatically developed and
you can view the image as an image to which image processing
conditions at the time of shooting have been applied.

Even if you perform various adjustments to the image you have opened
(it undergoes automatic development processing each time), only the
image processing conditions (development conditions) change and the
“original image data itself” remains unaffected. Consequently, image
deterioration is not a problem and it is the perfect image data for users
who want to get creative with their images after they have been shot.
In DPP, the “Image processing conditions information” that can be
adjusted is called a “Recipe”.

RAW image data

Image processing conditions information
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Main Features of DPP

Following are the main tasks you can perform with images you have
downloaded to your computer.

View and organize RAW images

Real-time adjustment of a RAW image
Various image adjustments while maintaining the original image
Freely apply a Picture Style
View your image before and after adjustment in the same window

Trimming and adjusting the angle of an
image

Change image size
Correction of lens aberration
Automatic/manual dust erasure processing

Convert from a RAW image to a JPEG or

TIFF image and save
Process large numbers of RAW images in batches
Transfer the image to image editing software

Print a RAW image
View and organize JPEG and TIFF images

Real-time adjustment of JPEG and TIFF
images
Various image adjustments while maintaining the original image

Print JPEG and TIFF images

Color management compatibility
CMYK simulation for commercial printing

System Requirements

(O Mac OS X 10.4 to 10.6

Computer | Macintosh with one of the above OS installed
CPU* PowerPC G4, G5 or Intel processor

RAM Minimum 1GB

Display Resolution : 1024 x 768 or more

Colors : Thousands or more

* Core2 Duo or higher is recommended

This software program is not compatible with UFS (UNIX File System)
formatted disks.

Supported Images

This software supports the following image types.

Image type Extension
RAW images*! shot with EOS DIGITAL
cameras, excluding EOS DCS1 and .CR2
RAW images | EOS DCS3 TIF
RAW images*2 shot with PowerShot .CRW
cameras
JPEG images Exn‘ 2.2, 2.21 or 2.3-compatible JPEG JPG, .JPEG
images
TIFF images | Exif-compatible TIFF images TIF, . TIFF

*1 Compatible with RAW images shot with EOS D6000 or EOS D2000

*2

that have been converted to RAW images using the CR2 Converter

and have the “.CR2” extension.

For information on CR2 Converter, refer to Canon’s web site.

» Only models where Digital Photo Professional is listed in the “Data
Type” item in the “Specifications” section near the end of the
Camera User Guide.

* Use the dedicated CameraWindow application to download images
from a PowerShot camera to a computer. See the Software Starter
Guide for details.

* Lens aberration correction can only be used with some camera and
lens models.

» Automatic dust erasure processing and other EOS DIGITAL specific
functions cannot be used.

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00




Contents at a Glance i) gt = BEEEENRREREEENEE0

Downloading Images to Your Computer Erase dust shot with the image -» p.67, p.69
Download images by connecting your cameraand ~ _, 07 Erase unwanted parts of an image =p.71 Contents at
computer ' Auto correct RAW images with the Auto Lighting Optimizer =» p.61 a Glance
Download images using a card reader =p9 Adjust brightness of shadows/highlights - p.57
— : Reduce image noise - p.62 o Beérlzitfon
Viewing and Checking RAW Images Correct lens aberration = p.63 i
Quickly enlarge parts of an image = p.l1 Use a Picture Style file - p.59
Sort images (check marks, rating) = p.18, p.19 Edit efficiently - p.34 Advanced
. . . : Operation
Display an image shot simultaneously as a RAW - p.22 Edit an image while comparing the image before and
image and JPEG image as a single image after adjustment = p.53
Display the images in the thumbnail list display at high ; inla i Advanced
resolution -p.23 Synchronize multiple images - p.54 Imadge o
Display an area beyond the set range as a warnin and Printin
Check shooting information such as the shooting date =» p.10, p.23 indti):at)c/)r (Highlight/yShadow warning) 9 apss 2
o ) ] © Restore an adjusted image to its condition at the time  _, - Processing
Editing RAW Images (Adjusting) of shooting P Lagge”hlgrgggrs
Adjust brightness/darkness - p.12, p.26 -
Use automatic adjustment = p.33 Printing Editing
Change the Picture Style = p.26 Print well on a Canon printer =» p.43, p.74, p.75 JITEG/TIFF
Sharpen the modulation and contrast of colors . . mages
-*p.29 Faithfully reproduce the color of the subject
(contrast) b when pr?/ntin% ) = p.43, p.74, p.75
Make skln. tone look healthier (.c.olor tone) | p.29 Print with the shooting information >p72 Reference
Make the image colors more vivid (color saturation)  =» p.29 Print a thumbnail list of images -p73
i - p. . . '
Mjke an image sharp E(sharrl)ness) I p-31 Approximate the color seen on screen with your - p.80
Adjust an image to make color tone more natura rintina results :
(white balance) = p.27 P g Index
Change an image to black-and-white or sepia tones Conversion of Images -
(monochrome) = p-30 : :
X . X . Convert a RAW image to a JPEG image =>p.42, p.86
Trim an image and adjust the angle of an image - p.38 "
. . _ Edit in Photoshop =>p.71, p.87
Specify an aspect ratio that matches the size of the - D38 .
paper on which an image is to be printed P Perform batch processing = .86
Edit (adjust) a JPEG image =» p.90
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Basic Operation

The basic operational flow — from how to download to your computer
images shot with a camera to checking, editing, saving and printing a
downloaded RAW image — is explained here.

)
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Starting up DPP

Click the Dock icon.

Digital Photo Professional

Click

DPP starts up and the main window ([Folder] window) appears.

v

Main window ([Folder] window)

@ Dighal Photo Professionsl imark Label Admaimens  Toolh Wiedow Heip
[iTala) Dugptal ot Professisnal - [ Wi D008 (Utrs caress) Desiton |

S dos b ol s 3

b o seeined e ©

Main Window Display

In the main window, you can use tabs to select either the [Folder]
window or the [Collection] window. The [Folder] window displays the
images in folders on your computer, while the [Collection] window (p.36)

displays images selected randomly by the user from one or more folders

and gathered together.
Unless noted otherwise, the [Folder] window will be described as the
main window from this point on.
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Downloading an Image to Your Computer

Connect the camera and computer with the cable provided and Start up EOS Utility_

download the images saved on the memory card inserted in the camera. Select the [Tools] menu » [Start EOS Utility].
For downloading images, start up the camera software “EOS Utility”
from DPP and use.

Introduction
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a Glance

Start Quick check tool TEF
Select the save destination for the images. Start Stamp too -9¢S
Select the save destination in the folder area on the left of the Start Trimming/Angle Adjustment tool 3T B1ip
main window. Opergtion
When creating a folder, refer to p.50.
606 Digit I Advanced
& = Transfer tao Phatoshon =98 P Operation
=] i 3 Photoshop B
nc folder with EO
Folder Collection(0) o Advanced
5 B sz EOS Utility starts up. Image Editing
» [& Applications —_ and Printin
i T:iporaryltems EOS Ut|||ty g
\ 4 : isec:mn 800 EOS Utility .
:u PRk Processing
» [ Documents Control Camera Accessories Large Numbers
> [# Library - of Images
= Movies
:e. Music
V it Starts to download images Edltlng
A JPEG/TIFF
T Images
’ Sltes Lets you select and download Images g
» |2 Shared
Camera settings/Remote shooting Reference
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! Index




Connect your camera and computer and turn the
camera on.
Connect the camera and your computer with the interface cable
provided with the camera and turn the camera on.
For detailed instructions on connecting your camera and
computer, refer to the “EOS Utility Instruction Manual” (PDF
electronic manual).

Accessories

Starts to download images

Lets you select and download images

Camera settings/Remote shooting

Monitor Folder

Downloading of images begins.

The downloaded images are saved in the folder selected in step
1 and are displayed in the main window of DPP.

The downloaded images are sorted by date into folders and
saved.

-I\@/E Advantages of using EOS Utility to download images

Using EOS Utility to download images makes it easier to organize your
images as they are downloaded, sorted and saved into folders by date.

5

You cannot start up EOS Utility in the [Collection] window
(p.6, p.36).
When EOS Utility has been started up from DPP, you cannot use
the following functions.
* Quick check window view (p.16)
e Trimming and adjusting the angle of an image (p.38, p.98)
e Dust erasure processing (copy stamp function)
(p.67.t0 pi71, p.101 to p.105)
« Batch change file names (rename function) (p.88)
« Printing with shooting information (p.72)
* Printing a thumbnail list (contact sheet printing) (p.73)
* Printing using Easy-PhotoPrint EX or Easy-PhotoPrint
(Plug-in printing) (p.43, p.46)
« Transferring images to Photoshop (p.71)
 Batch saving images (batch processing) (p.86)

)
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Downloading Images Using Your Card Reader Display the images downloaded to your computer.
In the [DCIM] folder copied to your desktop, select the folder

where the shot images are saved.

808 Digital Photo Profession

You can also download images to the computer using a third-party card
reader.

I\H!

Load the memory card into the card reader. »® @

Folder Collection(0)
¥ 2 MacOsx
» |4 Applications
[F Temporary Items
Vv [ Users
v & canon

R —

¥ 102CANON ®

» | Documen its IMG_0D01.CR2

b [& Library
= Movies
& Music

B
b (12l Pictures

- Images in the folder are displayed in the main window of DPP.

Be

Open aremovable disk icon in the folder area and
move the [DCIM] folder inside to a suitable place
such as to the [Desktop].

a00 Digital Photo P

!
]

Folder Collection(0)
v = Macosx
b [ Applications
[F Temporary Items
v & Users

Ny
¥ @ canon ~ - . . .
s =)= Checking before downloading images
» |V Document
P [ Library
= Movies
[ & Music
» = Pictures
» (& Public
> [ Sites
» [d Shared
v |_| EOS_DIGITAL
» 1 DCIM

By selecting the memory card folder directly in DPP, the images in the
folder are displayed in DPP and you can check the shot images.

® Ina Mac OS X 10.6 environment, you cannot move files or folders in
the folder area.

The [DCIM] folder is downloaded to your computer.

All images are saved in folder units inside the [DCIM] folder. |§| Copying to your computer may take time when there is a large
number of shot images saved in the memory card.
For details on the [DCIM] folder structure and the file names of
shot images, refer to “Folder Structure and File Names in the
Memory Card” in the “EOS Utility Instruction Manual” (PDF
electronic manual).
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Viewing an Image
Images downloaded to your computer are displayed as a thumbnails list Ch ang i ng the Size of Thumbnail |mag es

n the main W|_ndow. You_ can dOUbIe'C“CI.( an image to open the edit You can change the size of the thumbnail images displayed in the main
window and display the image at large size.

Introduction

window and display them with shooting information attached. Contents at
a Glance
View Images as Thumbnails in the Main Window Select the [View] menu b desired item.
%
o Rotate selected image Edit in Edit image window - Oper@tion
Main window ‘ View collections T#G
- - v Tab
v Folder view
S| e i ¥ Toolbar Advanced
Cobetonss . B = Tool palette HT Operation
Large thumbnail #1
v Medium thumbnail 2
Small thumbnail ¥3 Advanced
Thumbnail with information 34 lr:naglez,ﬁgtlitrl]ngg
Sort >
> The display changes to the selected item. L;g’ecﬁjrﬂggrs
of Images
Editing
JPEG/TIFF
Images

Click to select the image
Display thumbnails of all the images inside the Reference
folder selected in the folder area on the left

@ Images displayed with the ["® ] icon are movie files and cannot

be played back in DPP. Please use “ImageBrowser”, which is Index
compatible with EOS DIGITAL movie files. -
If the message [Insufficient memory.] appears, there are too many

images in one folder. Decrease the number of images in one

folder such as by dividing them into smaller folders. @

|§| When aspect ratio information is attached to the shot image with the
EOS-1D Mark 1V, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS 7D or S
EOS 60D, the image is displayed as a trimmed image (p.38, p.98).

For a list of main window functions, refer to p.110.
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Enlarge and View an Image in the Edit Window

Double-click

The edit window appears.

Edit window '

CIala) Do e Prafermml M U s oot o v o ot AU 5583 AT

[N TS | e 23 iy

It may take time for the image to redraw itself.

Click the [@®] in the upper left of the edit window to close the edit
window.

|§| By selecting the [View] menu » [AF Point] in the edit window, you can
display the AF points selected in the camera at the time of shooting.
However, AF points are not displayed for images which have had their
image size changed and then been converted and saved (p.42, p.119),
or which have had settings specified during RAW processing on the
camera for distortion correction and chromatic aberration correction.
For a list of edit window functions, refer to p.113.

Enlarging and Viewing a Specific Area
Double-click the area you want to enlarge.

e N e e T T

The area you double-clicked is enlarged to 100% (actual pixel
size). If you wait for a while, it changes to a clearer display.

© Double-click again to revert to the full view.

® To change the display position, drag on the image or drag the
enlargement display position of the tool palette.

Tool palette enlargement display position

Change the enlargement
display position by
dragging

5@/5 To display an image in an enlargement ratio other than 100%

Select the [View] menu » [200% view] or [50% view].

|§| You can change the enlargement ratio when you double-click (p.78).
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Adjusting an Image

You can perform a variety of image adjustments, such as adjusting the
brightness or changing the Picture Style of an image using the tool
palette of the edit window. You can easily restore an image to its original
settings with the [] button even if you have made the wrong
adjustment. Try out the various adjustments.

As an example, the procedure to adjust the brightness of an image is
explained here.

Tool palette
————{ RAW | RGE | NR/Lens/ALO
e .
|En’gi‘|tness adjustment l| = Reverts the Image to
...ﬁﬁz 00 the orlglnal. settings

|White balance adjustment | i| [_)rag the S“der Ieﬁ: or

— — right

7]

[ Shot settings | :] ¥ Funes—%
|Pictura Style | B |

Standard %) [ erowse... )

100 ZR0 S0 A0 =20 0 200 A0

Contrast: o —u-u-u-u‘eu-u-u-
Highlight: {4 s v S
Shadow: A
| Linear
Color tone: o '.—._.-.-@:T
Color saturation: o —._._._e.—.-.-.-
Unsharp mask ':]
Strength: 0 m
Fineness: o 9..........
Threshald: 1] Q—..—.-.-.-._.-.'

The image brightness changes in real time according to the
amount of adjustments.

? The tool palette does not display

Select the [View] menu P [Tool palette].

About the Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens/ALQ] tab sheets according to your editing
requirements.

Because adjustment made with the tool palette (it undergoes automatic
development processing each time) only changes the image processing
conditions, the “original image data itself” remains unaffected.
Therefore, there are no problems with image deterioration that arise with
editing and you can readjust your images any number of times.

See Chapter 2 onwards for more detailed information on the various
functions of the tool palette.

About Recipes

In DPP, all the adjustment contents (image processing conditions
information) made with the tool palette is saved to an image as data
called a “Recipe” (p.83).

@ For a list of tool palette functions, refer to p.114.
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Saving an Image

If you perform the save operation described here, you can save all the
adjustment contents (recipe) made with the tool palette to the RAW
image.

Select the [File] menu » [Save].

Close window HEW
[ save %S
Save As... i 35
Convert and save... ®D
Page setup... {r 3P
Print... 3P
Print with detailed setting... {r3D
Contact Sheet Prints... ~ 3P
Plug-in printing
Info... |

Your adjustment contents (recipe) are saved to the image.

Saving

With DPP, you can perform the following types of saving according to
your requirements. For detailed information on each saving method,
refer to Chapter 2 onwards.

Save (p.41)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save.

Save as (p.41)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save as a separate RAW image. The original RAW image
remains unaffected.

Add thumbnail to image and save* (p.23)

Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images
redraw themselves more quickly.

Convert and save (p.42)

Convert adjusted RAW image to a JPEG or TIFF image and save.
The original RAW image remains unaffected.

Batch process (p.86)

Convert in batches adjusted multiple RAW images to JPEG or TIFF
images and save.

The original RAW images remain unaffected.

* Option available in the main window.
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Printing an Image

You can print images with a printer. As an example, the procedure to
print one image on one sheet of paper is described here.

Select the [File] menu » [Print].

Close window HEW
Save 3£5
Save As... ir38s
Convert and save... ®D
Page setup,.. {r P
[ Prine.. 3P )
Print with detailed setting... 13D
Contact Sheet Prints... ~3EP
Plug-in printing
Info... |

The [Print] dialog box appears.

Print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [Print] button.
Printing begins.

-Z\@/i— To change the paper size

To set the paper size etc., select the [File] menu » [Page setup].

Printing
With DPP, you can perform the following types of printing according to
your requirements. For detailed information on each printing method,
refer to Chapter 2 onwards.

Print one image (p.49)

Print using a Canon inkjet printer (p.43, p.46)

Print with a high-end Canon printer (p.74)

Print with shooting information (p.72)

Printing a thumbnail list (contact sheet printing) (p.73)

Quitting DPP

In the main window, select the [Digital Photo
Professional] menu » [Quit Digital Photo
Professional].

Digital Photo Professional

About Digital Photo Professional
Preferences... 3,
Service >
Hide Digital Photo Professional 3H
Hide Others NC3EH

1O Al

[ Quit Digital Photo Professional EEQ)
» DPP quits.

|§| A confirmation dialog box for saving the images appears when you
try to quit DPP without saving the adjusted image. Click the [Yes to

all] button to save the adjustment contents (recipe) to all the images

adjusted.
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D Advanced Operation

A more advanced operation — from efficiently checking images, to
various ways of editing an image, printing a RAW image using a Canon
printer and sorting images — is explained here.

Efficiently Checking/Sorting Images.........ccccccoeeeeeee. 16
SOortiNg IMAgES......oeeiiii e 18
Attaching Check Marks........cccoooeeiiiiiiiii. 18
Setting Ratings ..., 18
Sorting Images in the Main Window .......................... 19
Attaching Check Marks in the Main Window ......... 19
Setting Ratings in the Main Window ...................... 19
Arranging Images in the Main Window...................... 20
Arranging by TYPe ...coovvviiiiiiie e 20
Arranging Freely ..o 21
Displaying a RAW Image and JPEG Image as a Single
[ gT= T = ST 22
Improving the Quality of an Image in the Main Window ... 23
Checking Image Information...............cccooeoeel. 23
Editing an Image ........ccoooovvieiiiie e 25
About the RAW Tool Palette.........cccooeeveeiiiiieiinnennnnn. 25
Editing with the Tool Palette in the Main Window.. 25
Adjusting Brightn@ss.............uvviiiviviiiiiiiiieeans 26
Changing a Picture Style ............cccooeeeeiii 26
Picture Style File.......cccooiiiiiiiiii 27
Adjusting Color Tone by Changing White Balance.... 27
Adjusting Color Tone Using Click White Balance....... 28
Adjusting Contrast ... 29
Changing Color Tone and Color Saturation............... 29
Adjusting MoONOChrome...............eevveviivviiieniiniiinnnnns 30
Adjusting Image Sharpness.........cccccceeeeviiiiieeiiiinnnnn. 31

Detailed Setting of Image Sharpness..................... 32
Automatically Adjusting Brightness and Color (Tone
CUIVE ASSISE) coiiiiiiiiiiie e 33

Editing Efficiently ... 34
Editing in the Edit Image Window.............................. 34
Changing the Thumbnail Display Position to a Horizontal
POSIION ...t 36
Gathering and Editing Images in the Collection Window ... 36

Trimming and Adjusting the Angle of an Image....... 38

Applying Adjustment Contents to Other Images...... 41

Saving Editing Results...........cccccceiviiiiiiiiiiieeen, 41
Saving Editing Contents to a RAW Image.................. 41
Saving as a JPEG or TIFF Image................cceevveeeee. 42

Re-Editing an Image..........ccoeiiieiieiiiiineeeeiicee e 43

Printing an IMage ..........coovvviiieiiieeiie e 43
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint EX .............cceeeven... 43
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint.................cc.cooee. 46
Printing Photographs with a Printer other than Canon
INKJEt PriNterS.....ccooiieeii e 49

Organizing IMages .......ccuveeeieeeveiiiii e 49
Deleting an Unwanted Image ..., 49
Creating a Folder for Saving Images..............cccceeeeee. 50
MOVING IMAGES ....eeeviiiiiiei et 50
Moving Images in Folders .........ccccoovvveiiiiciiinieeeeeeees 51
Registering Frequent-Use Folders (Bookmark
RegiIStration) ........ccuuuiiiiii e 51

Organizing Bookmarks ..........cccccevvviiiiiieeeeeeeiin. ol
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Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window Double-click the area you want to enlarge.
and efficiently check each image. You can attach check marks and sort
images into five groups.

Display the quick check window. Double-click

Click the [Quick check] button.

Digital Photo Professional - [ MacOSX /Users/canon/Piq

The area you double-clicked is enlarged to 50% view.
To change the display position, drag on the image.
Double-click again to revert to the full view.

The quick check window appears. 2 To quit, click the [OK] button.

Click the [Next] or [Previous] button to switch
between images to be checked.
Quick check window

GGIala) 115 MG 0002 CRT 11436 « 2304

== @ When [AF Point] is checkmarked, you can display the AF points

' selected in the camera at the time of shooting. However, AF points
are not displayed for images which have had their image size
changed and then been converted and saved (p.42, p.119), or which
have had settings specified during RAW processing on the camera
for distortion correction and chromatic aberration correction.

All the images displayed in the main window can be checked in
the quick check window.
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s

> Convenient functions of the quick check window

To check only selected images

You can use the quick check window to check only selected images
by selecting the desired images from those displayed in the main
window and then performing step 1.

Switch between images using the keyboard

You can also switch between images by pressing the <3> + <—> or
<3> + <> keys.

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

|§| The enlargement ratio when an image is enlarged is half (50%) of
the 100% (actual pixel size).

You can change the enlargement ratio to 100%, when an image is
enlarged (p.78).

For a list of quick check window functions, refer to p.117.
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Sorting Images

You can sort images by attaching check marks or setting ratings
(indicated with [ %] marks) for each subject or theme.

Attaching Check Marks

Display the image you want to attach a check mark
to, and then click any one of [v] to [«4].

Click

The selected check mark appears in the upper left of the window.

C|:heck mark

2/15 IMG_OD02.CR2 [3456 x 2304]

Click the [Clear] button to remove the check mark.

|§| The values of check marks attached to images in DPP version 3.8
or earlier are maintained as they are.
You can also attach check marks from the menu that appears by
clicking on an image in the main window while holding down the
<control> key.

Setting Ratings
Display the image you want to rate, and then click
any one of the [ +].

Click (changes to [ % ] after
clicking [ = ])

The rating is set and an icon corresponding to the selected [ %]
appears in the upper left of the window.
(Window shown with a rating of three [%])

@ To set [Reject], click the [Reject] button. Click the [Reject] button
again to cancel.

Rating icon

2/15 IMG_OD02.CR2 [3456 x 2304]

| soxview || rullscreen |
it

Check mark

b B B

Raring

To cancel the rating, click the same [ ] as when the setting was
made on the right of the window.

|§| You can also set ratings (including [Reject] setting) from the menu
that appears by clicking on an image in the main window while
holding down the <control> key.
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Sorting Images in the Main Window

You can also sort images in the main window by attaching check marks
or setting ratings (indicated with [E4] marks) for each subject or theme.

Attaching Check Marks in the Main Window
Select the images you want to attach a check mark
to, and then click any of [i] to [&&] in the toolbar.

Clear all  Rotate feft Rotats right

® & & 92

Batch
process

check Aingle n

Click

The selected check mark appears in the upper left of the image
frame.

- IMGODDZCR2 ~ IMG_ODO3.CR2
I | = ) .

@@ MGOmDiCRz

Click the check mark in the toolbar again to remove the check
marks.

Setting Ratings in the Main Window

Select the images you want to rate, and then click
any of the [@&] in the toolbar.

Click (changes to [E1]
after clicking [H])

Select

_IMG_0002.CR2 _ @ GO00SCR2 Jorm MG.O00SCRZ

The rating is set and an icon corresponding to the selected [E1]
appears in the image frame.
(Window shown with a rating of three [E4] as an example)

process

Rating icon

@ M W] 2 [ﬁ
e en Mo ODodcR: lgm

IMG_0002 CR2

To cancel the rating, click the same [E1] as when the setting was
made in the toolbar.

[Reject] cannot be set with the toolbar. Set [Reject] with the
[Label] menu or the quick check window (p.18).
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Y

=@> To select multiple images in the main window

Click on desired images while holding down the < 38> key. To select
multiple consecutive images, click on the first image, and then click on
the last image while holding down the <shift> key.

-Z\@/E To display more thumbnails in the main window

You can display a large number of images by setting the size of
thumbnail images to small (p.10). Then, by selecting the [View] menu »
[Rating] and removing check marks so that ratings no longer appear in
the image frame, you can display still more thumbnail images in the main
window.

|§| The [Label] menu can also be used to attach check marks and set
ratings.
By selecting the [Edit] menu » [Check mark] or [Rating] » image
selection criteria, you can refine criteria for selecting
checkmarked or rated images.
You can display and change the rating settings set in DPP with
other bundled software or on the EOS 60D camera.
« EOS Utility version 2.9:
Ratings set in DPP are displayed on image thumbnails in the
viewer window. However, [Reject] is not displayed and you
cannot change rating settings.
* ImageBrowser version 6.6:
Ratings set in DPP are displayed in the main window (Preview

Mode) and viewer window. You can also change rating settings.

* On an EOS 60D camera:
Ratings set in DPP are displayed in the playback screen. You
can also change rating settings. However, you cannot display or
change settings for [Reject].
Reversely, you can also display and change with DPP the rating
settings set for still images in ImageBrowser version 6.6 or on an
EOS 60D camera.

Arranging Images in the Main Window

You can arrange images in the order of the types of check marks you
have attached to images, or in the order of date and time at which the
images were shot. You can also freely arrange images by moving them
individually.

Arranging by Type

Select the [View] menu » [Sort] » desired item.

View collections NHEG
v Tab
v Folder view
+ Toolbar
Tool palette ®T
v Rating
Large thumbnail B
¥ Medium thumbnail 382
Small thumbnail ##3
Thumbnail with information 384

0 Rating : Ascending order
Rating : Descending order

v File name
Shooting Date/Time
RAW priority

Check mark1
Check mark2
Check mark3
Check mark4
Check mark5

The images are arranged in the order according to the selected
item.
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Sort item Description
Rating: ascending Sorted in order of fewest [ % ].
order
Rating: descending Sorted in order of most [ ].
order
File name Images are sorted by file name in alphanumeric

order (0to 9 = Ato 2).

Shooting Date/Time Images are sorted by shooting date and time
from the earliest.

RAW priority Images are sorted in the following order: RAW

images - JPEG images - TIFF images.
Check mark1 - Images with check marks take priority and are
Check mark5 sorted in number order.

-Z@/E Check mark sorting order

When check marks from 1 to 5 have been set, the images are sorted as
follows:

Check markl selected: 1»2->3->4-5

Check mark2 selected: 2->3->4->5-1

Check mark3 selected: 3»4->5->1->2

Check mark4 selected: 4-»5->1->2-3

Check mark5 selected: 5»>1-2->3->4

Arranging Freely
Drag and drop the image to the desired location.

[ @ oigmal Fhocs Professional fie Beokmark  Lital ASmvimast  Teoh  Widow  Hein o wed DA AM D

| At 88 i 82 Sy e g s ot i 81 D e N

The image moves to the desired location.

@ You can also select multiple images (p.20) and move them.

©® The order of rearranged images is maintained until you quit DPP
or select another folder in the folder area.
Select the [View] menu » [Sort] P [File name] to revert to the
order before the images were rearranged.

E@E Maintaining the order of rearranged images

You can maintain the order of rearranged images even if you quit DPP
or select another folder in the folder area.
Maintain order without changing image file names
You can use the [View settings] tab sheet in the [Preferences] to
maintain the order of images without changing the image file names
(p-78).
Maintain order and change image file names
You can use the rename function to maintain the order of images and
change the image file names all at once in the order they were
rearranged (p.88).
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Displaying a RAW Image and JPEG Image as a Single Image

You can display and handle a RAW image and JPEG image shot
simultaneously as a single image. In particular, you can halve the
number of images displayed in the main window and you can streamline
the checking of a large number of images shot simultaneously.

Select the [Digital Photo Professional] menu »
[Preferences].

Select the [View settings] tab sheet and checkmark
[Display only CR2 images for CR2 and JPEG files of
the same name].

i Y
Preferences

General settings l' View setti -‘]Tnol palette | Color management
Grid pitch
64 Pixels(8-256)

Locking selected image
g Images opened in Edit window remain selected in main window
Magnification in Edit window

(®) Fit to window O so% O 100% O 200%
Magnification when the Edit/Edit image window is double-clicked

@ 50% O 100% O 200%

and IPFC
E Display only CR2 images for CRZ and JPEG files of the same name J

Sort order in main window
g Retain sort order

Highlight/shadow warning

Highlight 255 (192-255) (N
Shadow 0 (0-64) ]

Quick check tool display

® s0% () 100% (moiré reduction off)

( Cancel )] f 0K a

The main window display updates and the simultaneously shot
RAW image and JPEG image are displayed as a single image
with the [GZXD] mark (p.112).

? RAW images with the extension “.CR2” can be displayed as a
single image

Images that can be displayed as a single image are images shot with a
camera that shoots RAW images with the extension “.CR2” and JPEG
images simultaneously. Images that have been simultaneously shot with
a camera that shoots RAW images with the extension “.CRW” or “.TIF”
cannot be displayed as a single image.

-Z\@/E When a single image is displayed

Image displayed

The RAW image is displayed in all windows.

Edited image

The content which has been adjusted with any of DPP’s functions (the
tool palette etc.) will be applied to the RAW image only.

However, if you have used the following functions, the adjustments
will be applied to both the RAW image and the JPEG image.

* Deleting an image (p.49)

» Moving or copying an image (p.50)

» Checkmarks (p.18, p.19)

» Rating (p.18, p.19)

» Rotating an image (p.110, p.117, p.118)

« Attaching a thumbnail to an image and saving (p.23)

Images added to the [Collection] window

When you add a RAW image and JPEG image displayed as a single
image to the [Collection] window, the single image is marked with the
[XXD] mark. However, because the RAW and JPEG images are
actually added individually, the number of images shown on the
[Collection] tab sheet increases by 2 (p.111).

|§| In step 2, if you uncheck [Display only CR2 images for CR2 and
JPEG files of the same name], the RAW image and JPEG image
are displayed as separate images.
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Improving the Quality of an Image in the Main Window
Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images redraw
themselves more quickly.

With all the images selected, select the [File] menu »
[Add thumbnail to image and save].

Open in Edit window HO
Open in Edit window (enlarged)

Close all

Open window 3N
Close window HEW
Save #5
Save As {1 38

( Add thumbnail to image and save 3T ]

Convert and save... #D
Batch process... #B
Create new folder... 1+ 38N
Page setup... {+ 8P
Print... 3P
Print with detailed setting... {+3#D
Contact Sheet Prints... ~HP
Plug-in printing >
Add to collection #G
Remave fram collection 1+ 3#G

=@> The extent of the improvement in quality

The quality is improved for any JPEG or TIFF image. While the image
quality improves regardless of the thumbnail size (p.10), selecting [Large
thumbnail], with its larger display size, shows the improvement more
clearly than [Medium thumbnail] and [Small thumbnail].

|§| A large number of images may take some time to add.
You can specify a presetting for JPEG images to improve the
quality of all main window thumbnails (p.76, p.77).

Checking Image Information

Select the image for which you want to check the

iImage information.

Click the [Info] button.

8006
Folder Collection(0)
v = ENG

» & Applications
» [ Developer
» [ Phota 1

=» The image information window appears (p.24).
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Select a tab sheet and check information.

[Shooting Information] tab sheet

[Metadata] tab sheet

Shooting information is displayed in the [Shooting Information]
tab sheet, while IPTC* information appended to the image in

Photoshop CS3 or later after shooting is displayed in the
[Metadata] tab sheet. IPTC* information provides additional

comments on images, such as captions, credits and the shooting
location. The information is sorted into 5 different categories and

e 8 [¥ IMG_oo01.CR2 e 8 ¥ IMG_0001.CR2
—E Shooting Information | Metadata St ing Information | Metad. }
: Item Name Value
File Name IMG_0001.CR2 u Description -4
Camera Model Canon EQS XXXX :
Firmware Firmware Version XXXX | [Document Title]
Shooting Date/Time O ] 00000000
Author Photographer:XXX : [Author]
Copyright Notice Copyright: XXX | m.
= [Author Title]
Shooting Mode Program AE ]
Tv( Shutter Speed ) 1/40 : [Description]
Av( Aperture Value } 5.6 \ W00
Metering Mode Evaluative Metering | [Description Writer]
Exposure Compensation 1] 1 200000000
150 Speed 3200 ! [Keywords]
Auto 150 Speed OFF \ MO0
Lens EF-518-55mm f/3.5-5.... : [Copyright Status]
Focal Length 55.0mm | Public domain
Image Size MO0 | [Copyright Notice]
Image Quality RAW : 00000
Flash Off | [Copyright info URL]
FE lock OFF ] HOOOCK
White Balance Mode Auto |
AF Mode One-5hot AF :
Picture Style Landscape ]
Sharpness 4 :
Contrast o \ |
Saturation o ]
Color tone 0 :
Color Space sRGE \
Long exposure noise red... 0:0ff ]
High ISO speed noise re...  2:5trong 1
Highlight tene priority 0:Disable :
Auto Lighting Optimizer 0:Standard ]
Peripheral illumination c... Enable o ‘
File Size KAXHKKB
Dust Delete Data No
Drive Mode Low-speed continuous s... |
Live View Shooting OFF
AF Microadjustment X *
Date (TimeallITC) Lo
| |

can be viewed by selecting [Description], [IPTC Contact], [IPTC
Image], [IPTC Content] or [IPTC Status] from the list box in the
[Metadata] tab sheet.

* International Press Telecommunications Council (IPTC)

The contents of the [Shooting Information] tab sheet will vary
depending on the camera model.

1/

> Convenient uses in the main window

-

Ay

Difference with the [Thumbnail with information]

Detailed shooting information for each image is displayed in the
image information window. However, if you want to only check the
main shooting information, you can check it for each image in [View]
menu » [Thumbnail with information] (p.10).
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Editing an Image

This section explains how to adjust an image using the tool palette in the
edit window.

You can easily restore an image to its original condition with the []
button even if you have made the wrong adjustment. Try out the various
adjustments.

How to make adjustments using the [RAW] tool palette functions, and
how to adjust automatically with the [RGB] tool palette are explained in
this section.

Edit window

Tool palette

[T e 253 sy

The image changes in real time according to adjustments
performed with the tool palette.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <38> +
<Z> keys.

|§| You can rotate an image in the [Adjustment] menu.
You can adjust an image while comparing the image before and
after adjustment (p.53).
You can synchronize multiple images and edit while comparing
them (p.54).
Refer to p.113 for a list of edit window functions, and p.114 for a
list of tool palette functions.

About the RAW Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens/ALQ] tab sheets according to your editing
requirements.

Adjustments similar to those that can be performed with the functions of
your camera can be performed using the functions of the [RAW] tool
palette. When the camera settings were incorrect during shooting, or
when the shooting result is not what you visualized, you can get closer
to what you envisaged with the [RAW] tool palette which is similar to the
camera.

All functions other than [RGB] tool palette automatic adjustment, and
each function of the [NR/Lens/ALQO] tool palette are explained in
Chapter 3.

Editing with the Tool Palette in the Main Window

By clicking the [Tool palette] button (p.110) in the toolbar on the main
window, the same tool palette that appears in the edit window is
displayed and you can edit images.
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Adjusting Brightness

The brightness of an image can be adjusted. Move the slider to the right
to make the image brighter and to the left to make the image darker.

. — BEREETR Reverts the image to
el I [ ® ) the original settings
( -
L O I A | 1 MI LI B O I B l G-DD)’ Enter a numerlcal
|While balance afjustment L i_ b || value
1| 2 | 3 | Register...
Shot settings | #] ¥ —Tune=—%

Drag the slider left or right

|§| The adjustment range is —2.0 to +2.0 (in 0.01-stop increments when
entering a value).

Changing a Picture Style

If the image you shot is different to what you visualized, you can change
the Picture Style to get closer to what you envisaged.

Even if you have saved the image (p.41) with [Monochrome] (p.30)
selected, you can still change to another Picture Style at any point by
simply selecting a Picture Style other than [Monochromel].

|
[Ficture Style [ = | Reverts the image to
the original settings
[Standard l:_]y Browse... |
Select

W o]

-t

h—!ﬂ_ﬂ =30 -60 =40 -284 0 2.0 40

A

Caontrast: {0) W
Highlight: i di
Shadow: 0 ".T._.@.—.T
! Linear
Color tone: o T@T
Color saturation: 10) T;@TT
Unsharp mask ! ”
Strength: {0) m
Fineness: il m
Threshald: {0 m

|§| Even if the RAW image is from a camera that does not have
Picture Style settings, you can still set a Picture Style as long as
the RAW image is compatible with DPP (p.3).
You can retain the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings, even if you change the
Picture Style (p.79).
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Picture Style

Standard

Portrait

Landscape

Neutral

Faithful

Monochrome

(Picture Style file
registered in the
camera)

[Picture Style file
applied in DPP]

Description

The image looks vivid.

Ordinarily, this setting is suitable for most images.

For nice skin tones.

Effective for close-ups of women and children. By
changing the [Color tone], you can adjust the skin
tone (p.29).

For vivid blues and greens.
Effective for making images of landscapes
impressive.

For natural colors and subdued images.
Effective for base images which are to undergo
adjustment.

When the subject is photographed under a color
temperature of 5200K, the color is adjusted
colorimetrically to match the subject’s color.
Effective for base images which are to undergo
adjustment.

For black and white images.
You can also adjust with [Filter effect] or [Toning
effect] (p.30).

Displayed when selecting an image shot with the
Picture Style file registered in the camera.

In the list, the name of the Picture Style file is
displayed in ().

The name of the Picture Style file applied in DPP
is displayed in [].

Picture Style File

A Picture Style file is an extended function file of Picture Style. Refer to
p.59 for how to use Picture Style files.

Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural,
change the white balance to make it appear natural. You can make the
color tone natural by setting the light source at the time of shooting an
image of, for example, pale-colored flowers.

---------- —{SRAWS| RGB | NR/LensjALO ———
‘En’ghmess adjustment = .‘
:I:II!:I'III'\._/I':I:Illiilll \'}DD
‘White balance adjustment l. - i} Reverts the image to
[#] . Register. the original settings
[ Shot settings b ): Tune... )
Select

? The color tone does not become more natural even when the
white balance is changed

If the color tone of the image does not appear natural after changing the

white balance, adjust the white balance using click white balance (p.28).

A/
~

== Tune with color tone

To make further fine adjustments to color tone after adjusting the white
balance, you can use [Color tone] (p.29) to get closer to your
requirements.

® You cannot register the adjustment results as personal white
balance (p.85) when you have selected [Shot settings] from the list
box.

@ Refer to your camera’s Instruction Manual for details on each white
balance setting.
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Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

———["RAW] RCB | NR/Lens/ALO
|Erighrness adjustment = |
IIIIIIIIIIIFZIIIIIIIIIII G-DD
White balance adjustment |y |
[ 1] 23 |(register... ) Click
Shot settings f :}[ Tune... :I Ic

A Dol P Frofiiasonal | MacT v aman Focture s/ P waxs o_on MG, 906 R 1 OO0 s

Click Reverts the
The coordinates of the cursor position and the image to the
RGB values (8-bit conversion) original settings

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, click the [[*]] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

|§| The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.
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Adjusting Contrast

Modulation and degree of contrast can be adjusted. Move the slider to
the right to make contrast stronger and to the left to make contrast

weaker.

| Picture Styla

|
(= | Reverts the image to

Standard

F#1( Browse.. )

5

e

A

Cantrast:
Highlight:
Shadow:

! Linear
Color tone:

Color saturation:

100 S3.0 6.0 -4.0

=20 0 2.0 __4.0

{DJII [
10 [T B B e o B

(o |||||i|||||

Unsharp mask

4]

Strength:
Fineness:

Threshold:

{O]illllllllll
{Dlillllllllll
{Olillllllllll

the original settings

—— Drag the slider left or
right (9 steps)

AL/
~ N
/@\

Displays the value of the setting

[Linear] - A function for advanced adjustment

Use [Linear] when you will be adjusting separately using image editing
software that has advanced editing functions. Note that when [Linear] is
checkmarked, the image will become dim.

|§| The Auto Lighting Optimizer (p.61) will not function when [Linear] is

checkmarked.

Changing Color Tone and Color Saturation

Skin tone and overall color saturation can be adjusted.
If Picture Style (p.26) is set to [Monochrome], [Color tone] and [Color
saturation] switch to [Filter effect] and [Toning effect] (p.30).

| Picture Style

(=]

Standard

|¢]I” Browse... |

W

4

A

n ] : b
-10.0°-3.0 -0 40, -2.0 D0 20 4.0

— Reverts the image to
the original settings

T Drag the sliders

left or right

Contrast: AWt .5. i
Highlight: Ui ,5. i
Shadow: 0 m
| Linear
Color tone: L T
Color saturation: A= T
| Unsharp mask | ”
Strength: 0 E. SR
Fineness: il m
Threshold: 10 E. R
Displays the values of the settings
Color tone:

Color saturation:

Mainly used for adjusting skin tones. Move the

slider to the righ

t to make skin tones more

yellow, and to the left to make skin tones

redder.
The overall colo
adjusted with co

r depth of the image is
lor saturation. Move the slider

to the right to make the color deeper, and to

the left to make

the color weaker.

@ The adjustment range is —4 to +4 (in 1-stop increments).
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Adjusting Monochrome

When the Picture Style (p.26) is set to [Monochrome], you can create
monochrome photographs with effects similar to filtering and with the
look of a single-color photograph.

Select [Monochrome] in the [Picture Style] list box.

|Pictuw Style [ = [ Reverts the image to
the original settings

Monochrome | :] (" Browse... )

¥ 4

A

r:II}.CI -5.0 -6.0 4.0 -20 O 20 4.0

Contrast: Ll T-.-.e._.-.-.-
Highlight: 1 s v e
Shadow: 0]} —.-.T.-ﬁ_.-..-.-
[ Linear
Filter effect: {None) ETERTE Drag the sliders
i None)(O)——— J left or right
Unsharp mask | :]
Strength: 10 m
Fineness: L] m
Threshold: u] m

Displays the values of the settings

Filter effect: Creates an image where the white of clouds and the
green of trees are emphasized in the same
monochrome photograph.

Filter Example of effect
None Ordinary monochrome image without filter effect.
Blue sky is reproduced more naturally and white
Yellow
clouds emerge clearly.
Orange Blue sky becomes somewhat darker. The
9 brightness of the setting sun increases further.
Blue sky becomes quite dark. Autumn leaves
Red :
become clear and bright.
Human skin tones and lips become softer. The
Green

green leaves of trees become clear and bright.

® Toning effect: You can create a monochrome photograph to which a
single color has been added.
You can choose from [None], [Sepia], [Blue], [Purple]
and [Green].

=@ Increase the [Contrast] to emphasize the filter effect

To emphasize the filter effect, set the [Contrast] slider closer to the right.
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Adjusting Image Sharpness

You can make the overall atmosphere of an image harder or softer.
Adjustment can be made by selecting from two modes, [Sharpness] and

[Unsharp mask].

[Sharpness]:

Controls the sharpness of an image by adjusting the
level of emphasis for the outline of the image. The
further to the right the [Sharpness] slider is moved (the
larger the setting), the more the edges are
emphasized for a sharper image.

[Unsharp mask]: Adjusts the image’s sharpness more finely.

[Strength]:

[Fineness]:

[Threshold]:

Shows the level of emphasis for the outline of the
image. The further to the right the slider is moved (the
larger the setting), the more the image’s edges are
emphasized for a sharper image.

Shows the fineness of the emphasized outline. The
further to the left the slider is moved (the smaller the
setting), the more fine detail can be emphasized.
Sets “how much contrast difference there should be
compared to surroundings before emphasizing
edges”.

Select [Sharpness] from the list box and make the

setting.

‘ Picture Style

[|_“-_'>__,JN— Reverts the image to

Standard

I:]Ii Browse... |

the original settings

I

e

A

100 -8.0 -60 -40 -2.0
Contrast:
Highlight:
Shadow:
| Lingar
Color tone:

Color saturation:

0
o)

0 |||||i|||||
o |||||i|||||

10 ||||i||||
10 ||||i||||

l.' Sharpress

=)

2.0 4.0

Select [Sharpness]

Sharpness:

\' {0 B R R A B |

I
Drag the slider left or right

Displays the value of the setting

@ The adjustment range is 0 to 10 (in 1-stop increments).
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Detailed Setting of Image Sharpness

Select [Unsharp mask] from the list box and make
the setting.

| Picture Style Ii“

Standard i-#]( Browse... j

- = ]

o
A

TR e e U e

Caontrast: o T@T

Highlight: (L o s

Shadow: o m
| Linear

Color tone: 1o T@T

Color saturation: 10 T@T

| gre—— =3 Select [Unsharp mask]

Strength: |
Fineness: _.‘
Threshald: T
Displays the values Drag the slider left or right

of the settings

? The effects of sharpness adjustment appear unnatural

Adjust image sharpness with the window view set to [200% view],
[100% view] or [50% view]. If the view is set to [Fit to window] (full view),
the effects of adjustment may seem unnatural.
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.125). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click on the [RGB] tab sheet and click the desired
automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most

images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.
oo " raw [RGB ] NR/Lens/ALO
\Tfm curve assist I | I+ |Z» }—— Reverts the tone curve
Tone curve adjustment =3 to the original settings
e ¢ | G [ s ]
255 A High
Standard
0 \ |
0 255
Eﬂghtﬂ!ss trrrirerrfrerrrrene Dz
cuntras“ trrrrrerrYrerrerrent D?
Hue: e e Yy |3! Dz
Satul'atil:mi ety nrrrene Lgi lDD 3
Sharpness: Q—m,: 0 ?

The tone curve changes as adjusted.

|
\\/

=@~ Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

* Images which have been shot with the proper exposure

* Images where the brightness is unbalanced

* Images which are too dark

* Images which have extreme backlighting

(D Ifyou click the [(E25]] button, the tone curve as well as the [Hue] and
[Saturation] revert to the default settings. Take care when adjusting
the [Hue] and [Saturation] individually (p.94).
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Editing Efficiently
Editing in the Edit Image Window

The thumbnail display and the edit window are combined and images can
be edited efficiently while quickly switching between images to be edited.
Images to be edited are selected beforehand in the main window.

In the main window, select the images you want to edit.

Switch to the edit image window.

Folder Collection(()
v 8 ENG
bt & Applications
L L-. Developer

"7 phata i

Click

The main window switches to the edit image window.

Edit the image.
Change the size

Edit image window

[ ol s Protes T

Select the image to be edited
The selected image is displayed as an enlargement in the
middle of the window

It may take time for the image to redraw itself.

The same tool palette as in the edit window is displayed and you
can edit the image.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <38> +
<Z> keys.

ﬁl By selecting the [View] menu » [AF Point] in the edit window or edit
image window, you can display the AF points selected in the
camera at the time of shooting. However, AF points are not
displayed for images which have had their image size changed and
then been converted and saved (p.42, p.119), or which have had
settings specified during RAW processing on the camera for
distortion correction and chromatic aberration correction.
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Double-
click

[£100%, W3sas - 11 126, s A o Wk o pasben £,

The area you double-clicked is enlarged to 100% (actual pixel
size).

To change the display position, drag on the image or drag the
enlargement display position (p.114) of the tool palette.
Double-click again to revert to the full view ([Fit to window]).

To return to the main window, click the [Main Window] button on
the toolbar.

=@> To display an image in an enlargement ratio other than 100%

Click the [50% view] or [200% view] on the toolbar.

You can change the way the tool palette is displayed (p.79).

You can change the enlargement ratio when you double-click
(p-78).

With the edit image window, you can only select images from one
folder. To gather images from several folders for editing, refer to
“Gathering and Editing Images in the Collection Window” (p.36).
For a list of edit image window functions, refer to p.118.
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Changing the Thumbnail Display Position to a Horizontal Position

Select the [View] menu » [Change thumbnail
position].

=

=

[— prp— [

If you select [Change thumbnail position] again, the thumbnail
display reverts to the vertical position.

Gathering and Editing Images in the Collection Window

You can gather any randomly selected images together in the
[Collection] window for viewing, comparison and editing. You can gather
images from several folders as well as from only one folder, allowing you
to work with them efficiently.

Select images from the [Folder] window in the main

window, and select the [File] menu » [Add to collection].

Open in Edit window *O
Open in Edit window (enlarged)

Close all

Openswindow #N
Close window HW
Save #S
Save As... {35
Add thumbnail to image and save {#T
Convert and save... ®D
Batch process... #B
Create new folder... 13N
Page setup... 3P
Print... 3P
Print with detailed setting... 3D
Contact Sheet Prints... ~¥FP
Plug-in printing »

[ Add to collection #G ]

Remave from collection 3G

The selected images are added to the [Collection] window and the
number of selected images is shown on the [Collection] tab sheet.
When you add RAW and JPEG images displayed as a single
image (p.22), the number of images shown on the [Collection]
tab sheet increases by 2.

You can select several images and add them to the [Collection]
window.

You can also add images to the [Collection] window by selecting
images, clicking on the image while holding down the <control>
key, and selecting [Add to collection] from the menu that appears.
You can add up to 1,000 images to the [Collection] window.

Introduction

Contents at
a Glance

Basic
Operation

Adv ed
Op ion

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00
©

36



Select the [Collection] tab sheet.

800
2 (£
Folder Collection(14)
¥ =4 MacOSX

b A Applications

[Z Temporary ltems
¥ | & Users

v @ canon

The selected images are displayed in the [Collection] window.

Check displayed images in the [Collection] window.

& Digital Photo Professional File Edit View Bookmark Label Adjustment Tools Window Help
ollection]

Adobe RGB / Adobe RGB High quality  Recipe data: No

Edit the images.

You can now edit the images displayed in the [Collection]

window.

Images displayed in the [Collection] window are retained in the
[Collection] window even after exiting DPP.

|
\\/

:@5 To remove images from the [Collection] window

Removing randomly selected images
Select the images to be removed in the [Collection] window and then
select [Remove from collection] in the [File] menu. (You can also remove
images from the [Collection] window by selecting the images, clicking on
the image while holding down the <control> key, and selecting [Remove
from collection] from the menu that appears.)
Note that even if you remove an image from the [Collection] window, the
original image remains unaffected.

Removing all images
Select [Clear collection] in the [File] menu. (You can also remove all
images from the [Collection] window by clicking while holding down the
<control> key, and selecting [Clear collection] from the menu that
appears.)
Note that even if you remove all images from the [Collection] window,
the original images remain unaffected.

® Modifications to the image are applied to the original image
Modifications made to images added to the [Collection] window are
all applied to the original image.

|§| You can arrange images displayed in the [Collection] window the
same way as in the [Folder] window (p.20, p.21). You can
maintain the order of rearranged images even after quitting DPP
by checkmarking [Retain sort order] on the [View settings] tab
sheet in the [Preferences] (p.78).

You cannot use the following functions in the [Collection] window.

« Starting of EOS Utility (p.7), or synchronizing of folders with
EOS Utility
¢ Batch change the file name of images (p.88)
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Trimming and Adjusting the Angle of an Image

Introduction

You can trim only the part of an image you need, or change the Adjust the angle of the image as needed.
composition of an image where an image shot horizontally becomes Trimming/angle adjustment window
vertical. You can also adjust the angle of an image before trimming. L
. Contents at
. . a Glance
Select the image to be trimmed. : Largest
Sl e . possible
Open the trimming/angle adjustment window. trimming Basic
range Operation

Click the [Trimming Angle] button. _
Click

Digital Photo Professional - [ MacOSX /Users/canon/Pic (rotate
image left Ad%ed
L~/ or right in Opgidion
Stamp Frimming 90-deg|’ee
increments) Advanced
T S | Image Editing
< \ ' and Printing
Drag* (0.01-degree increments;

e _ _ adjustment range: -45 to +45 degrees) Processing
The trimming/angle adjustment window appears. Large Numbers
Editing can be done once the image is displayed clearly in the Use the mouse (click A/¥) to adjust the angle or of Images

increments; adjustable range: -45 to +45 degrees) Editing
* You cannot adjust the angle of images that exceed 6666 x 4444 J'TrEgéL'SFF

pixels in size.

If you click [Center on Screen], you can display the trimming
range in the center of the window. Reference
When correcting lens aberrations, it is recommended to perform
[Lens aberration correction] before adjusting the angle of the
image.

If you click the [OK] button after adjusting only the angle of the
image, the image will be trimmed at the largest possible trimming
range.

Index

00

|§| When aspect ratio information is attached to an image shot with the @
EOS-1D Mark IV, EOS-1Ds Mark 1ll, EOS-1D Mark Ill, EOS 7D or
EOS 60D, the trimming range based on the aspect ratio information
is displayed.

38



Select aratio and drag the trimming range.

ann = 171 IMG_0001.CR2 [3456 x 2304]

Full seseen

Cancel

Select a
trimming
ratio

Drag the
trimming
range

A7, 362 ) -> {228, 141D} = ( A6T7 % 0052 11050 )

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.

List of aspect ratios (width : height)

v Free
1:1
3:2
2:3
4:3
3:4
5:4
4:5
A Size Landscape
A Size Portrait
Letter Landscape
Letter Portrait
Custom

[Free]: You can trim an image to any size, regardless of the
selectable ratio.
[Custom]: You can trim an image at the specified ratio.

Click the [OK] button to return to the main window.
The trimming range frame is displayed in the trimmed image
(p.112).

When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its trimmed form.
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? About trimmed images

The trimmed range can be reverted to its original condition at
any time

A trimmed image is displayed or printed as a trimmed image.
However, since the image is not actually trimmed, you can always
revert to the original image by clicking the [Reset] button in the
trimming/angle adjustment window or performing the “Re-Editing an
Image” procedure (p.43).

Display of the trimmed image in each window

» Main window: The frame showing the trimming range is
displayed on the image (p.112).

* Edit window: The image is displayed in its trimmed condition.

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when converted and saved
The trimmed RAW image actually becomes a trimmed image when
converted to a JPEG or TIFF image and saved (p.42).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to a RAW image shot with
EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS 7D or
EOS 60D, the set trimming range based on the aspect ratio
information is displayed. Since the image is not actually trimmed, you
can change the trimming range or revert to the condition before
trimming.

However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect
ratio set with the EOS 60D, its trimming range cannot be changed nor
reverted to the condition before trimming, since the image is actually
trimmed and saved in the set trimming ratio.

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.120).

~
-

Ay

> Convenient functions of the trimming/angle adjustment
window

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming/angle
adjustment window. With the trimmed image displayed, click the
[Copy] button and then click the [Apply All] button. This will apply the
trimming range to all the images selected when the trimming/angle
adjustment window is displayed.

To select multiple images in the main window, click the images while
holding down the <38> key. To select multiple consecutive images,
click on the first image, and then click on the last image while holding
down the <shift> key.

© For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view image details in the trimming/
angle adjustment window, so using this function is not
recommended.

|§| For a list of the trimming/angle adjustment window functions, refer

to p.120.
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Applying Adjustment Contents to Other Images

You can copy the image adjustment contents (recipe) adjusted with the
tool palette and apply it to other images.

You can efficiently adjust multiple images by adjusting one image and
applying the results of this to multiple images shot in similar shooting
environment.

Select the adjusted image and then select the [Edit]

menu » [Copy recipe to clipboard].
The recipe is copied.

Select the image to which the recipe is to be applied
and then select the [Edit] menu P [Paste recipe to
selected image].

The recipe is applied to the image.

|§| The recipe (p.83) can be saved as a separate file from the image
and loaded and applied to another image (p.84).

Saving Editing Results
Saving Editing Contents to a RAW Image

All the contents (recipe) adjusted with the tool palette as well as the
trimmed (p.38) range information can be saved to a RAW image or to a
separate RAW image.

The adjustments made with the tool palette (p.56 to p.66) and the dust
erase processing explained in Chapter 3 (p.67 to p.71) can also be
saved in a RAW image.

Select the [File] menu » desired item.

Open in Edit window ¥0
Open in Edit window (enlarged)

Closeall

Qpenwindow N

Close window EW
Save 3ES

Save As. .. {35

Add thumbnail to image and save {r3T

Convert and save... #D
Batch process... #B

Create new folder... 13N

Page setup... 3P

Print... 3P

Print with detailed setting... 3D
Contact Sheet Prints... ~¥FP

Plug-in printing »
Add to collection £

Remave from collection 4 #G

Clear collection

Delete 3 <
Info... 4|

Your adjustments are saved to the image.
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Saving as a JPEG or TIFF Image

To view, edit and print a RAW image with software other than DPP,
convert to a more versatile JPEG or TIFF image and save.

The image is saved as a separate image, so the RAW image remains
unaffected.

Select the image to be converted.

Select the [File] menu » [Convert and save].

Open in Edit window #0
Open in Edit window (enlarged)
Close all
Open window 1N
Close window HEW
Save 35
Save As... {+ 385
' Convert and save... ®D l
Batch process... #*B
Create new folder... 13N
Page setup... {+ 3P
Print... *EP
Print with detailed setting... {+ 3D
Contact Sheet Prints... ~¥P
Plug-in printing b
Add to collection *G
Remave fram collection 138G
Clear collection
Delete <=
Info... 4|

The [Convert and save] window appears.

Specify the necessary settings, and then click the

[Save] button.
By default, the image is converted and saved to a JPEG image

with the highest image quality, without changing the image size.

Change the settings according to your requirements.

Convert and save
[SM as: [ REE E]Jf— Enter a file name
( Where: L Photo ':])7— SeleCt the save
I destination
(Kind of file Exif-JPEG 4])—— Select an image type
Image quality P . — ¥ ' T ' e 10
Qutput setting
Output resolution 350 dpi [} Embed ICC profile
Resize setting
| Resize
Width Height Unit
3504 x 2336 pixel
{3504 pixel ) {2336 pixel )
¥ Lock aspect rati
(Cancel ) [Csae )}+— Click and save

The RAW image is converted to a JPEG or TIFF image which is
then saved as a new image in the specified save destination.

AL/
~

=)= To save the developing/editing results for the version you are
currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two differing versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, it is recommended that you convert and
save images as JPEG image or TIFF images.

|§| By saving as explained on this page, a trimmed image (p.38) or
dust-erased image explained in Chapter 3 (p.67 to p.71) actually
becomes a trimmed image or dust-erased image.
You can reduce the noise characteristic of JPEG images which

occurs when you convert and save an image as a JPEG (p.76, p.77).

You can batch convert and save multiple images (p.86).
For a list of [Convert and save] window functions, refer to p.119.
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.25 to p.33), so the “original image data itself”
remains unaffected.

Also, the trimming range information of a trimmed image (p.38) is simply
saved to the image.

For this reason, you can undo any adjustments saved (p.41) to the
image, trimming information, and revert to the condition when last
saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu P desired item.

The image reverts to the conditions of the selected item.

Printing an Image

This section explains how to print high-resolution photographs easily
with Canon inkjet printers compatible with the Canon printing software,
Easy-PhotoPrint EX or Easy-PhotoPrint. It also explains how to print
photographs using other printers.

Proceed to the page for the printer you are using.
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint EX (Same page)
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint (p.46)
Printing Photographs with a Printer other than Canon Inkjet Printers

(p.49)

Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint EX

You can perform the following types of photograph printing with Canon
inkjet printers compatible with Easy-PhotoPrint EX (hereinafter, “EPP
EX"):

© Simple printing of RAW images

@ Printing with faithful colors

To perform this printing, it is necessary to first install EPP EX version 1.1
or later on your computer.
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Select the image to be printed.

Start up EPP EX.
Select the [File] menu » [Plug-in printing] » [Print with Easy-
PhotoPrint EX].

Open in Edit window *O
Open in Edit window (enlarged)

Close all

Open window 3EN
Close window HEW
Save 3#S
Save As... 1+ 38S
Add thumbnail to image and save {t+3T
Convert and save... #D
Batch process... #*B
Create new folder... {r#EN
Page setup... {+ 3P
Print... 3P
Print with detailed setting... {+3ED
Contact Sheet Prints... ~¥P

Plug-in printing

Add to collection ®G
Remave from collection i+ #G ‘

EPP EX starts up.

In the EPP EX window, select the [File] menu »
[Preferences].

My Recent Files »

Next Step

Preferences...

The [Preferences] window appears.

In [Print Quality], select [Quality Priority], click the
[Option] button, and then in the dialog box that
appears, checkmark [Print with the best quality when
you select [Quality Priority]].

-

ann Preferences
Print Advanced

MNumber of copies : i 2 Copies

Printing Order By Date ﬂ

Amount of extension of borderless printing : = Default ﬂ

Print Quality [ Quality Priority ﬂ)i— Select
{‘. Option... :' Quallty

Priority
~ Defaults
Help .‘_l l‘. Cancel ._Jl ( 0K )

Click and checkmark [Print with the best quality
when you select [Quality Priority]]

Select the [Advanced] tab, checkmark [Enable ICC
profile], and then click the [OK] button.
The [Preferences] window closes.
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Specify the number of sheets to be printed, and then

click [Select Paper].

EPP EX
ane Mew Photo Print - Eavy-PhosoPrint EX
Spacey T rumber of copus 1 prt 11 mach & uge
Fhata Frin

Exif Print

SR T

T T 5 0)—===——Click to
. ‘Ep a increasethe
s ' number of

e go11 02 G017 08 o C 0034087

=)0 =) =il =] =TI (=i =) sheets to be
printed

| ﬁ;]g-g‘is":H‘ﬂﬂ‘i
Click

7 Select the paper type, and then click the [Layout/

Print] button.

X5 Mew Phata Print

Easy-PhotoPrin EX

Phata Print o e i Prnt
Pieser Conon XX ]
B ~/ ....,,.;J... o e 2
.~ |——Selectthe
_‘ PE paper size
r——r— P drunse Pt Fagar and type
[I—T—
[ Exit :I
Click

8 Specify the layout, and then click the [Print] button.

Mew Phoco Print - Easy-PhotoPrint EX

Exif Print

- - ! Select the
' i layout

' ]

Inaice Fages

i o e Ve

Click to print

=»Printing begins.
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? Additional information

Print up to 1000 images at a time
You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

The printed image’s color is not what you expected

In the EPP EX window, select [Preferences] in the [File] menu and
then click the [Advanced] tab in the [Preferences] window to display
the [Advanced] tab sheet.

In the [Advanced] tab sheet, select [Enable ICC profile] in [Color
correction for printing] and try printing using the [Perceptual] setting
(p.126).

|§| DPP is also compatible for printing with Easy-PhotoPrint Pro (p.74).

Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint

You can perform the following types of photograph printing with Canon
inkjet printers compatible with Easy-PhotoPrint (hereinafter, “EPP"):
Simple printing of RAW images
High quality printing using the color reproduction range of Adobe RGB
and a Canon inkjet printer

To perform this printing, it is necessary to first install EPP version 3.5 or
later on your computer. When using an Easy-PhotoPrint EX-compatible
inkjet printer, it is recommended that you print using Easy-PhotoPrint EX

(p-43).

Select the image to be printed.

Start up EPP.
© Select the [File] menu P [Plug-in printing] » [Print with Easy-

PhotoPrint].

Open in Edit window ¥0
Open in Edit window (enlarged)

Close all

Open window N
Close window EW
Save 3#ES
Save As... 1+ 38S
Add thumbnail to image and save 43T
Convert and save... #¥D
Batch process... ¥B
Create new folder... {+38N
Page setup... {+ 3P
Print... P
Print with detailed setting... {+3ED
Contact Sheet Prints... ~3P
Plug p g Print with Easy-PhotoPrint  3E
Add to collection #¥G
Remove from collection 438G

EPP starts up.
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In the EPP window, select the [Easy-PhotoPrint]
menu » [Preferences].

Easy-PhotoPrint

About Easy-PhotoPrint...
| Preferences... 3, '

Services [ ]

Hide Easy-PhotoPrint  3H
Hide Others
Show All

Quit Easy-PhotoPrint  3Q

“2EH

The [Preferences] window appears.

In [Print Quality], select [Quality Priority].

Preferences

Print

)
Print | Advanced

(o)
)

Copies

Number of copies : 1
Printing Order : "By Date
Amount of extension of { Default

borderless printing :

Print Quality :

[ . Quality Priority

'_H
B
'_L]

) e

( Cancel

: ]7_ Select

Quality
Priority

Select the [Advanced] tab sheet and check that the
EPP image compensation function is disabled.
If not disabled, the operation of the EPP image compensation
function may prevent images being printed with faithful color

reproduction.
Preferences
{Print | Advanced
Image @ptimize images automatically

® Rotate Left

) Rotate Right

gApply Rotate/Trimming to the same images in the same manner
When landscape images are rotated depending on the selected

Layout ) Always trim when you select the layout with the margins
akt margins to the minimum when you select the layout
with the margins
| g Print filename when you select the index in layout
| E Preview all layouts of A4 and Letter
| Image ] Select imagesfrom multiple folders
Selection

( Defaults

—_—

@ Cane O [EGoe)

If checked,
click to
remove the
check mark

Click to
close the
window

£ Specify the number of sheets to be printed, and then
click [Next].

Click

Click to
increase the
number of
sheets to be
printed
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Check that the image compensation function is
disabled, select the paper type and then click [Next].
If checked, click to remove the check marks

866 Easy-PhotoPrint

Click

Select the
paper type

R Faga Si00 ;A4 Pidin Tyge s e Pagee Pro 19 Pagetn)

Specify the layout, and then click [Print].

Click to print

Select the layout

=» Printing begins.

2 Additional information

@ Print up to 1000 images at atime
You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

© The printed image’s color is not what you expected
Change the [Rendering intents when using Easy-PhotoPrint] (p.80) to
[Perceptual] (p.126) and print.

@ In a Mac OS X 10.6 environment, the Apple application Rosetta
must be installed beforehand to use EPP.

@ DPP is also compatible for printing with Easy-PhotoPrint Pro (p.74).
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Select the image to be printed.

Select the [File] menu » [Print].

Printing Photographs with a Printer other than Canon Inkjet Printers

You can print one image on one sheet of paper.

Open in Edit window F#O
Open in Edit window (enlarged)

Close all

QOpen window N
Close window HEW
Save #5
Save As... 1+ 35S
Add thumbnail to image and save 3T
Convert and save... ®D
Batch process... #B
Create new folder... {+3#EN
Page setup... it 3P
Print... %P )
Print with detailed setting... {4 #ED
Contact Sheet Prints... ~HP
Plug-in printing >
Add to collection ®G
Remove from collection T+ #G
Clear collection

Delete E |
Info... = |

The [Print] dialog box appears.

Set to photograph printing and print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [Print] button.

Printing begins.

Organizing Images
This section explains how to delete unwanted images, create folders for
saving images, move or copy images, etc., and organize your images.

Deleting an Unwanted Image

Be aware that you cannot recover deleted images.

Select an unwanted image in the main window.

Select the [File] menu » [Delete].

Open in Edit window #O
Open in Edit window (enlarged)

Closeall

Qpen window N
Close window W
Save 35
Save As... 135S
Add thumbnail to image and save 3T
Convert and save... HD
Batch process... #B
Create new folder... 3N
Page setup... {r3EP
Print... 3P
Print with detailed setting... 4D
Contact Sheet Prints... ~¥P
Plug-in printing >
Add to collection #G
Remove from collection {+#G
Clear collection

Delete 3@@]
Info... £ |

The image is moved to the [Trash] and is deleted from DPP.
The images are deleted completely from your computer by
selecting the [Finder] menu » [Empty Trash] on the desktop.
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Creating a Folder for Saving Images

You can create a folder for sorting images.

In the folder area, select the location where the new

folder is to be created.

800 Digital Photo P|

11113,

Folder Collection(0)
v = MacOsx
» (A Applications
[7 Temporary ltems
v (8 Users
v @ canon
» @ Desktop
» [ Documents
P [#@ Library
# Movies
[# Music

» Y
P [ Sites
» [ shared

Select the [File] menu » [Create new folder].

Open in Edit window FO
Open in Edit window (enlarged)

Close all

Open window #N
Close window EW
Save #S5
Save As... 35
Add thumbnail to image and save {&T
Convert and save... #D
Batch process... #*B

( Create new folder... {+ 3N ]

Page setup... {+ 3P
Print... #EP
Print with detailed setting... {+#D

The dialog box for entering a folder name appears.

Enter a folder name and click the [OK] button.

The new folder is created in the folder selected in step 1.

Moving Images

You can move or copy images to a separate folder and sort by shooting
date or themes.

Drag the image to be moved or copied.
To move: Drag the image and release when the image is in the
destination folder.
To copy: Drag the image while holding down the <option> key
and release when the image is in the destination

folder.
e R Digital Photo Profession
2 (i E i
- Foldih Collection(0)
¥ =} MacOsx
» | A Applications
[ Temporary Items
¥ | Users
¥ @ canon
¥ [ Desktop
L2 Travel
» U Documents
» [# Library
| Movies @
¥ Music " IMGODICRZ :

v |4 Pictures
v [ photo
[ o0 _xx_xx
b & Public
» | Sites
» [3 shared

The images are moved or copied to the destination folder.

® In a Mac OS X 10.6 environment, you cannot move files or folders in
the folder area.
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Moving Images in Folders

You can move or copy folders that contain images, and sort the images
by folders.

Drag the folder to be moved or copied.
To move: Drag the folder and release when the folder is in the
destination folder.
To copy: Drag the folder while holding down the <option> key

and release when the folder is in the destination folder.

806 Digital Photo Profession

11113,
1A

Folder Collection(0)
¥ =l Macosx
» | A Applications
[ Temporary Items
v [ ¥ Users
¥ 1 canon
v [ Desktop

[ Travel
¥ |¥ Documents
> ¥ Library

< L A

IMG 0001 CR2 i
4

P [ Sites
» [ Shared

The folders are moved or copied to the destination folder.

® In a Mac OS X 10.6 environment, you cannot move files or folders in
the folder area.

Registering Frequent-Use Folders (Bookmark Registration)

You can register frequently used folders in bookmarks.
Registered folders appear by clicking the [Bookmark] menu.

Select the folder for which a bookmark is to be
registered.

8086 Digital Photo Profession

B (€ =

Folder Collection(0)
v 2 MacOsX
» [A Applications
[ Temporary Items
¥ & Users
v @ canon
¥ [@ Desktop
L2 Travel
» |3 Documents
» |® Library

[# Music IMG_D001.CR2 z
v (4 Pictures

- — - Select
> @ \ o R
» |1 Sites — .
» [ Shared

AL Select the [Bookmark] menu » [Add].

=» The folder selected in step 1 is registered in the [Bookmark]
menu.
Select a registered folder from the [Bookmark] menu to display
images in the selected folder in the main window.

Organizing Bookmarks

You can change a folder name or delete a folder registered in
[Bookmark].

Select the [Bookmark] menu » [Organize].
The [Sort bookmarks] window appears and you can change
folder names or delete folders.
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3 Advanced Image Editing and Printing e

Introduction
Various preferences including advanced image adjustment, automatic Performing Automatic Dust Erasure Processing _____ 67
dust erasure processing, various _p”““”g functions for printing out Wf)rk’ Compatible Cameras............ooocuvvviiiiieieeee e 67 Contents at
and color management are explained here, geared to the user who is Automatic Dust Erasure Processing in the Main Window .. 68 a Glance
competent in the handling of third-party image editing software. 9
Manually Erasing Dust (Repair Function)................ 69 _
Adjusting While Comparing with the Original Image... 53 Erasing Unwanted Parts of an Image (Copy Stamp B
Changing How the Window is Split............................ 53 FUNCLION). .., 71
Adjusting by Comparing Multiple Images................. 54 Transferring a RAW Image to Photoshop................ 71 Advanced
Displaying an Area Beyond the Set Range as a Setting Work Color SPace ...........cceveeeeveeeereveerenenns. 71 (LoReEen
Warning Indicator (Highlight/Shadow Warning) ....... 95 Printing with Shooting Information.................c......... 2
Performlng Advanced Ed|t|ng ................................... 56 Prlntlng a Thumbna" Llst (Contact Sheet Prlnt|ng) 73 Ir;na(:jg%t'n]%g
Adjusting White Balance with Color Temperature ..... 56 Printing RAW Images on a High-End Canon Printer.. 74
TL(;rllng White Bal_ance with Color Wheel ................. 2? Printing with a High-End Canon Inkjet Printer ............ 74 L;B%‘ﬁjrﬂggrs
A rustrng Dynamlc Range .............. e Printing with a Large-Format Canon Printer ............. 75 of Images
Adjusting Brlgh-tness of Shadows/HIghlights ........... >7 Specifying Preferences.........ccoooovvieieiviiiiccieecceenn, 76 Editing
Tone CUrve AdJUSIMENT...ovverssoooivvvrrssssss e $S General SEttiNgS.......ccccveeeveveeeieeeeeeeeeeeee e, 76 | JREG/TIFE
Example of a Tone Curve Operation ..................... 59 View Settings -3 Images
Using a Picture Style File..........cocooeveveeeeeeeeenen. 59 Tool Palette 29
About the RGB Tool Palette .............ccooeeeererernennn. 60 Color Manag.t;r.'r;(;r.].t. """"""""""""""""""""""""""""""""""" g | Reference
Using the Auto Lighting Optimizer..........cccccceeeeeeeeees 61
ReduCing NOISE.....cooiviiiiiiiieeiiiiiicie e 62 Index
Correcting Lens Aberration .........cccooeevveiiiiiieveeennnnnn. 63 -
Compatible Cameras.........cccoeveii 63
Compatible LENSES ..o 63 @ @
Making COrreCtiONS............uvvvvvuviviviiiiiiniieninns 65
About Shooting Distance Information Slider.............. 66 @
Correcting Multiple Images ata Time........................ 66
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Adjusting While Comparing with the Original Image

You can display before and after versions of an adjusted image in the
same window and adjust while checking the adjustment results.

In the edit window, select the [View] menu » [Before/
after comparison].

[

The image divides into a left and right window.
The window on the right shows the image after editing.

Change the image display.
Select the [View] menu » [Change up/down/left/right] » [Up/
downl].

[ZXal5) Dagral

L samni: e a7 e ey

The layout of the two images changes to top and bottom.
The bottom window shows the image after editing.

|§| Images can also be displayed in the edit image window by the same
operation.

Changing How the Window is Split

You can change the display of the image to a single image split in two.

In the edit window, select the [View] menu » [Display
mode] » [Split single image].

T L e L T e T

[T e [T TR B
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Adjusting by Comparing Multiple Images

You can synchronize the display position of multiple edit windows and Move the display position.
adjust images while comparing them with each other. If you move the enlargement display position in one of the edit
__ ] ] ] windows, the enlargement display position will also change in the
In the edit window, display the multiple images to be other edit windows.
compared. To cancel synchronization, select the [Window] menu »

Align the images. [Synchronize] again.

Align the images for easy comparison.

Select the [Window] menu » [Synchronize].

Enlarge the image.
Enlarge and display any of the edit windows.

W Dvgital Fhoto Professional e ew  Adpstmers Toshs Wandew o W 4 WedsiiR @
Ann - Er——

— ]

o ity i Ak S 20

The other edit windows will also be displayed in the same
position/enlargement ratio.

|§| Synchronization only applies to the enlargement display position
and the enlargement ratio. Adjustments to the images are not
synchronized.
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)

Displaying an Area Beyond the Set Range as a Warning Indicator (Highlight/Shadow Warning) |
Introduction
You can set up a warning indicator in both the highlighted part and the Display the edit window.
shaded part, which is effective for checking the light and dark areas and
preventing excessive adjustment of an image. Where the area on the . . . .
image has exceeded that set range, you can display the highlighted part Select the [View] menu » [Highlight]. Similarly, select Cgrg;a;r;cgeat
in red and the shaded part in blue. [Shadow].
On the opened image, if there is an area that exceeds the value
Select the [Digital Photo Professional] menu » entered in step 3, the highlighted part of that area is displayed in Basic
[Preferences]. red and the shaded part is displayed in blue. Operation
Select the [View settings] tab sheet.
Advanced
) . ) Operation
Enter the warning value for [Highlight] and [Shadow].

s 2
Preferences
Advapced
Ceneral settings | View i | Tool palette = Color management Im ag |t| n g
and Pfinting
Grid pitch
64 Pixels(8-256)
= : Processing
Locking selected image L N b
a Images opened in Edit window remain selected in main window argfel umobers
OoT Images
Magnification in Edit window g
#) Fit to window O s0% O 100% O 200%
Magnification when the Edit/Edit image window is double-clicked J PEEdIGt/I!FlgFF
50% O 100% O 200%
® Images
RAW and JPEG
g Display only CR2 images for CR2 and JPEG files of the same name
Sort order in main window
™ Retain sort order Reference
Highlight/shadow warning
Highlight 255 | a9z-255 [N
Shadow 0 f (0-64) ]
Quick check tool display Index
® 50% () 100% (mairé reduction off)
f Cancel ] f’ oK " @ @
Click the [OK] button to close the window. @

|§| You can also display the warning with the same operation in the edit

image window.
55



Performing Advanced Editing

This section explains how to use the advanced adjustment function on
the tool palette in the edit window.

Adjustments made using the high-level functions of the [RAW] and
[RGB] tool palettes, as well as the functions of the [NR/Lens/ALO] tool
palette are explained in this section.

Adjusting White Balance with Color Temperature

White balance can be adjusted by setting a numerical value for color
temperature.

Select [Color temperature] from the [White balance
adjustment] list box.

Set the color temperature.

——[“RAW"| RGB | NR/LensjALO —— ]
‘Eﬂ'ghmess adjustment | = |‘

||!Illlllllmllllllll|ll {}DD
‘While balance adjustment [ |‘

I?‘ 1 2 : 3 Register...
( Color temperature | :] Tune... :I

i o .
7 (sso0_k)——— Displays the value of the

setting
Drag the slider left or right

|§| The adjustment range is 2500 to 10000K (in 100K units).

Tuning White Balance with Color Wheel

White balance can be tuned by moving a cursor in the color direction
shown in the color wheel.

In the [RAW] tool palette, click the [Tune] button.

Tune by dragging a point.
You can also fine-tune your adjustment by directly entering the
adjustment values.

enn White balance fine adjustment
Color tone: — Enter the values
Color saturation: tO Set
"'_ Cancel ‘ f OK 3
|
Drag

® To register adjustment results as personal white balance (p.85),
select a setting other than [Shot settings] from the [White balance
adjustment] list box, and then tune with the color wheel. You cannot
register the adjustment results as personal white balance when you
have selected [Shot settings] from the list box and have done any
tuning.

@ The adjustment range of color tone is 0 to 359 (1 unit in numerical
value input), and the adjustment range of color saturation is 0 to 255
(1 unit in numerical value input).
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Introduction
Adjusting Dynamic Range Adjusting Brightness of Shadows/Highlights
Dynamic range (width of gradation expression) from dark points to bright You can adjust the brightness of shadows and highlights in an image.
points in an image can be adjusted. By adjusting shadows and highlights in an image with a restricted ngf;rfgeat
brightness, you can reduce the effects of clipping in shadows and
g highlights.
|P|clure Style - || ]
. Move downwards Basic
: Standard 1 Bruw‘se... qj OUtpUt hlghllght pOintS |Picture o [_'b_J| Operation
d / ' Standard B Browse.. )
Move to the left or right . : . Advanced
Input highlight points 3 / Operation
ST\ S — ——
Emtr-ast:- i ﬁal i = . e : Im/:(é Ciet?ng
ighlight: (0| T — -10.0 -8.0 -6.0 -40 -20 0 20 40 and nting
Shadgw {0] LN I B I | L B O | Cﬂ-mra![: {UJ T o] ool
_J Linear Move upwards Highlight o &)= Drag the sliders left or :
Eojcetnng B g Output shadow points S o Tright Processing
Color saturation: (]} TQT [ Linear Ll it Laggljcelrlr\]ll;r;ggrs
Unsharp mask '+ Color tone: 1) T@T
Strength: ) e —— Colar saturation: L e .
Fineness: ]} m | Unsharp mask ) JPEEdIGt}-T-IgFF
Threshold: {0] ill [ Strength: {0 m Images
. Fi E {0 9
Move to the left or right T'::E:E H i 9_
Input shadow points el
Reference
The horizontal axis shows the input level and the vertical axis
shows the output level.
Index
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Tone Curve Adjustment

You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.125).

In the tool palette, select the [RGB] tab sheet.

Select the tone curve mode and interpolation

method.
RAW | RGB | NR/Lens/ALOD
|T0ne Curve assist O I+ E2e
Tone curve adjustment -y

4

RGB [_R_F c[s]| [#]

255
v Clurve
Straight
v RGBRGB
Luminance R G B
Piasiiia r
D |
] 255
. 5 e = — n
Erlghtness |I!!!IIII:\E/IIIIIIIII! I:I L—
cnntraSt |Il||i||||\Y;IIIIIIIII D -\i’
=
Hue: DY 2 o L* 3
s — e ————— T
Saturatlun :III::iIII‘Y"IIi-IiIII 3 lDD ;
Sharpness: (4 0 ':"

oo A st

<control> + click inside
the graph to display the
menu

Make adjustments.

Batch adjusts RGB
Adjusts each channel

-+ RAW [“RGB | NR/Lens/ALO

|Tone Curve assist Ol 2e ‘
Tone cprve adjustment ]
RGE | R [ c| EJ T
= i S J L_ .'l
255
\
J 1
D - -, |
255
G X —— n
Erlghtness .I!!!IIIIMIIIlIIII! D L
contras‘ II'I'iIIIMI'IiIiIII D -\L
Hue ||||||I||M|!|III||! -\2 D '\:r
Saturatlﬂn. !I|I!=:II;\I/'I|:-I:II| Mt lDD -:
Sharpness: o/ o
p \I/illlllllllllllllllll 2 D -\:'-

Click to add a [[] (point)
Adjust by dragging [[]

The horizontal axis shows the input level and the vertical axis

shows the output level.
The maximum number of [[J] is 8.

To delete a [[]], double-click on the [[]].

The histogram display changes according to adjustment. You can

also fix the histogram display to the display before any

adjustments (p.79).

The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.79).
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Example of a Tone Curve Operation

Makes medium tones brighter

Makes medium tones darker

Makes tones harder

Makes tones softer

/|

Using a Picture Style File

A Picture Style file is an extended function file of a Picture Style.

With DPP, you can apply to RAW images Picture Style files that you
have downloaded from Canon’s web site effective for various scenes or
Picture Style files created with “Picture Style Editor”. When using a
Picture Style file, save it to your computer beforehand.

Display the image to which the Picture Style file is to
be applied in the edit window (p.11).

Select the [RAW] tab sheet in the tool palette, and
click the [Browse] button.

‘ Picture Style - ‘

Standard

A

\-1[}_".] -8.0 -b0 -40 =20 O 2.0 4.0

The [Open] dialog box appears.

Select a Picture Style file saved on your computer,
and click the [Open] button.
The Picture Style file you selected is applied to an image.

To apply a different Picture Style file, follow the procedure from
step 2 again.

ﬁl The Picture Style files that you can apply to the camera are files with
the “.PF2” extension only. Furthermore, you cannot apply Picture
Style files with the extension “.PSE” to an image; however if such a
file is registered in the camera and the image is shot, the image will
display correctly.
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About the RGB Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens/ALQ] tab sheets according to your editing
requirements.

The [RGB] tool palette functions are the same as ordinary image editing
software, such as tone curve adjustment that is explained here, with
which you can adjust RAW images.

However, because the adjustment width of the functions in the [RGB]
tool palette is wider than the [RAW] tool palette, the image color may be
saturated, or the image quality may deteriorate if you adjust too much.
Therefore we recommend for functions other than tone curve
adjustment (p.58) and automatic adjustment (p.33), that you adjust
images using the same functions available in the [RAW] tool palette.
Refer to Chapter 5 for explanations on functions of the [RGB] tool
palette other than tone curve adjustment.

@ Using the tool palette

We recommend that as a general principle you edit RAW images using
the [RAW] tool palette. However, where the adjustment width with the
[RAW] tool palette is not wide enough and you wish to use the special
functions in the [RGB] tool palette, we recommend that you adjust your
images at the necessary lowest limit with the [RGB] tool palette after
having completed basic adjustment with the [RAW] tool palette.

Use the adjustment function of the [NR/Lens/ALQO] tool palette (p.115)
when applying the Auto Lighting Optimizer (p.61), reducing noise (p.62)
or correcting aberration (p.63) after you have made any required
adjustments with the [RAW] and [RGB] tool palettes.
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Using the Auto Lighting Optimizer
If the shooting result is dark or the contrast is low, you can use the Auto
Lighting Optimizer function to auto-correct the brightness and contrast,
and obtain a more pleasant image.

You can also change the settings of the image shot with the camera’s
Auto Lighting Optimizer function.

This function is compatible only with RAW images shot with EOS-1D
Mark 1V, EOS 5D Mark Il, EOS 7D, EOS 60D, EOS 50D, EOS REBEL
T2i/550D and EOS REBEL T1i/500D.

* ALO stands for Auto Lighting Optimizer.

Select the [NR/Lens/ALQ] tab sheet from the tool
palette in the edit window or edit image window.

RAW | RGB || NRfLens/ALo H———
|Autn Lighting Optimizer |
E 1 1
Low  Standard  Strong
| Moise reduction Apply | |
RAW [ NF. Preview... |
Luminance noise reduction
{ZJ D tirrrrrrrrrrrrrr e 20
Chrominance noise reduction
{SJ D trrrrrrrrrirrrnr e 20
TIFF/JPEG
Luminance noise reduction
[V)] 1 L 20
Chrominance noise reduction
1) 0 20
Lens aberration correction Tune... ] |
Peripheral illumination 63
Distartion OFF
Chromatic aberration OFF
Color blur OFF

Checkmark the checkbox.

RAW | RGCB | NR/LensfALO |}

‘Autu Lighting Optimizer

® — o

Low Standard  Strong

Checkmark

For images shot with the camera’s Auto Lighting Optimizer
function, the checkbox is already checked.

Change the settings according to your preferences.

RAW | RGCB | NR/LensfALO |}

‘Autu Lighting Optimizer ‘

—Q

Low Standard  Strong

Select from three levels:

Low/Standard/Strong

Auto correction is applied to the image to match the settings.
For images shot with the camera’s Auto Lighting Optimizer
function, the settings at the time of shooting are applied as the

default values.

To cancel the Auto Lighting Optimizer, remove the check mark

from the checkbox.

@ When [Highlight tone priority] is set to [Enable] in EOS 7D, EOS

60D and EOS REBEL T2i/550D Custom Functions, the Auto

Lighting Optimizer function cannot be set.
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Reducing Noise

You can reduce noise that arises in RAW images shot at night or with a
high 1ISO speed.
NR is an abbreviation for “noise reduction”.

Select the [NR/Lens/ALQO] tab sheet from the tool
palette in the edit window or edit image window.

Click the [NR Preview] button.

( )

The [NR Preview] window appears.

Adjust an image.

800 NR Preview

Navigator
window

— Enlargement
display
position

Luminance noise reducty

& ) = Drag the
Chrominance noise redygi .
» sliders

[
P Y —

3 Cancel

NR check| window
You can set a noise reduction level from within a range of 0 to 20.
The larger the setting, the larger the noise reduction effect.
The noise reduction effect can be checked when an image is
displayed at 100% in the NR check window.
You can change the display position of the NR check window by
dragging the enlargement display position in the navigator
window.

Click the [Apply] button.
Noise reduction is applied to the image and the image is
redisplayed.

? The noise reduction function does not work

Noise reduction cannot be applied when [Viewing and saving RAW
images] (p.76) is set to [High speed] in the [Preferences] window.
Select [High quality] to reduce noise.

Vi
~Q= To set the same noise reduction level for several images

After selecting multiple images in the main window, you can set the
same noise reduction level for the images without displaying the [NR
Preview] window, by adjusting the noise reduction level in the [NR/Lens/
ALOQ] tool palette (p.115) using the [Luminance noise reduction] and
[Chrominance noise reduction] sliders, and then clicking the [Apply]
button.

|§| © You can set the default noise reduction beforehand, using

[Default noise reduction settings] in the [Tool palette] tab sheet in

the [Preferences] (p.79).

« When [Apply camera settings] is selected, you can pre-set a
noise reduction level that suits the camera settings beforehand
as the default.

* When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand. This is
particularly useful for applying noise reduction to all the images
in a folder at once, such as batch noise reduction for images
with high 1ISO speeds.

However, for images with recipes attached, the noise level

recorded in the recipe will be applied.

If [Luminance noise] has been set, resolution may be reduced

along with reduction of noise.

If [Chrominance noise] has been set, color bleeding may occur

along with reduction of noise.

For a list of [NR Preview] window functions, refer to p.116.
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Correcting Lens Aberration

You can easily make corrections to drops in peripheral illumination,
distortions in the subject, and color blur which occur by the physical
characteristics of the lens or slightly remaining aberration.

Please note that you can only correct RAW images which have been
taken with the compatible cameras and lenses listed below. JPEG or
TIFF images cannot be corrected.

Compatible Cameras

EOS-1D Mark IV EOS-1Ds Mark llI EOS-1D Mark Il
EOS-1D Mark II N EOS-1Ds Mark II EOS-1D Mark I
EOS-1Ds EOS-1D EOS 5D Mark I

EOS 5D*1 EOS 7D EOS 60D

EOS 50D EOS 40D EOS 30D*?

EOS REBEL EOS REBEL EOS DIGITAL REBEL
T2i/550D T1i/500D XSi/450D

EOS DIGITAL REBEL EOS DIGITAL REBEL
XTi/400D DIGITAL XS/1000D

*1 Requires firmware version 1.1.1
*2 Requires firmware version 1.0.6

Compatible Lenses

Ultra wide and wide lenses

EF 14mm f/2.8L USM

EF 20mm /2.8 USM

EF 24mm f/1.4L 1l USM*3
EF 28mm /1.8 USM

EF 35mm f/1.4L USM

EF 14mm f/2.8L Il USM*3
EF 24mm f/1.4L USM

EF 24mm /2.8

EF 28mm /2.8

EF 35mm f/2

Standard and medium telephoto lenses

EF 50mm f/1.2L USM*4
EF 50mm /1.8

EF 85mm f/1.2L USM
EF 85mm /1.8 USM

EF 50mm /1.4 USM

EF 50mm /1.8 Il

EF 85mm f/1.2L Il USM*>
EF 100mm f/2 USM

Telephoto lenses

EF 135mm /2L USM

EF 200mm f/2L 1S USM*3
EF 200mm /2.8L 1l USM
EF 300mm /4L IS USM

EF 400mm f/5.6L USM

EF 500mm /4L IS USM

EF 800mm f/5.6L IS USM*3

EF 135mm /2.8
(with Softfocus mechanism)

EF 200mm /2.8L USM
EF 300mm /2.8L IS USM
EF 400mm f/2.8L IS USM
EF 400mm f/4 DO IS USM
EF 600mm /4L IS USM
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Zoom lenses

EF 16-35mm f/2.8L Il USM*3

EF 17-40mm f/4L USM

EF 24-70mm f/2.8L USM

EF 24-105mm f/4L IS USM

EF 28-90mm f/4-5.6 USM

EF 28-90mm f/4-5.6

EF 28-90mm f/4-5.6 Il
EF 28-105mm f/3.5-4.5 USM EF 28-105mm f/3.5-4.5 Il USM
EF 28-105mm f/4-5.6 USM EF 28-105mm f/4-5.6
EF 28-135mm f/3.5-5.6 IS USM  EF 28-200mm f/3.5-5.6
EF 28-200mm f/3.5-5.6 USM EF 28-300mm f/3.5-5.6L IS USM
EF 55-200mm f/4.5-5.6 Il USM  EF 55-200mm f/4-5.6 USM
EF 70-200mm f/2.8L USM EF 70-200mm f/2.8L IS USM
EF 70-200mm f/2.8L IS Il USM*3 EF 70-200mm f/4L USM
EF 70-200mm f/4L 1S USM*4 EF 70-300mm f/4-5.6L IS USM*3
EF 70-300mm f/4-5.6 IS USM EF 70-300mm f/4.5-5.6 DO IS USM
EF 75-300mm f/4-5.6 11*3 EF 75-300mm f/4-5.6 11I*3
EF 75-300mm f/4-5.6 USM EF 75-300mm /4-5.6 Il USM
EF 75-300mm f/4-5.6 IIl USM EF 90-300mm f/4.5-5.6
EF 90-300mm f/4.5-5.6 USM EF 100-300mm f/4.5-5.6 USM
EF 100-400mm f/4.5-5.6L IS USM —

EF 16-35mm f/2.8L USM
EF 17-35mm f/2.8L USM
EF 20-35mm /3.5-4.5 USM
EF 24-85mm f/3.5-4.5 USM
EF 28-70mm f/2.8L USM
EF 28-90mm f/4-5.6 Il USM
EF 28-90mm f/4-5.6 Il

Macro lenses
EF 50mm /2.5 Compact Macro*3 EF 100mm /2.8 Macro USM
EF 100mm f/2.8L Macro IS USM*3 EF 180mm f/3.5L Macro USM

MP-E 65mm /2.8 1-5x Macro
Photo*3

EF-S lenses
EF-S 60mm f/2.8 Macro USM EF-S 10-22mm f/3.5-4.5 USM
EF-S 15-85mm f/3.5-5.6 1S*3 EF-S 17-55mm /2.8 IS USM
EF-S 17-85mm f/4-5.6 ISUSM  EF-S 18-55mm f/3.5-5.6
EF-S 18-55mm /3.5-5.6 Il EF-S 18-55mm f/3.5-5.6 USM
EF-S 18-55mm f/3.5-5.6 Il USM  EF-S 18-55mm f/3.5-5.6 1S*3
EF-S 18-135mm f/3.5-5.6 1S*3 EF-S 18-200mm f/3.5-5.6 1S*3
EF-S 55-250mm /4-5.6 1S*3 —

Aberration correction will not apply to images shot with a combination
of lenses *3 *4 *5 and EOS 5D or EOS 30D with the firmware versions
below.

* You cannot attach an EF-S lens to EOS 5D.

*3 EOS 5D with firmware version 1.1.0 or earlier, EOS 30D with
firmware version 1.0.5 or earlier

*4 EQS 5D with firmware version 1.1.0 or earlier, EOS 30D with
firmware version 1.0.4 or earlier

*> EOS 5D with firmware version 1.0.5 or earlier, EOS 30D with
firmware version 1.0.4 or earlier

You can also correct RAW images taken with the compatible lens
even when the extender is attached.

You can also correct RAW images shot with EF 50mm /2.5
Compact Macro fitted with Life Size Converter EF.

The aberration correction function is not available for images shot
with combinations of camera/lens other than those given under
“Compatible Cameras” and “Compatible Lenses”. They are
therefore not displayed and cannot be used.
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. Introduction
Checkmark the items to be corrected.

800 .ens aberration correction - [IMG_1001.CR2]

Making Corrections

You can make corrections to any of the four aberrations as below, either
one at a time or simultaneously.

Contents at

. . o a Glance
Peripheral illumination
Distortions
Chromatic aberration (color fringing which occurs in the periphery of Basic
an image) Operation
Color blur (blue or red color blur which sometimes occurs at the edge
of the highlighted area of an image)
Advanced
Operation

In the tool palette, select the [NR/Lens/ALQO] tab
sheet.

Click the [Tune] button. |m’§$3§ﬁ?ng
RAW = RGB | NR/Lens/AlO || and nting
|Autc| Lighting Optimizer |
= % The image is corrected and redisplayed. Processing
R \ ((j:_h?cl':_ the (eséﬁltsf o|1; corrections to peripheral illumination or La{, %ﬁrh‘gg‘gsers
- : istortions in the full view.
Moise reduction [ Apply | i i .
| m | ® Check the results of corrections to chromatic aberration and color —
RAW __tePevew. ) blur by clicking the area on the image you want to check. In the Editing
Luminance noise reduction top right of the window, the area is displayed at 200% in the ‘]FI’EG/T'FF
. . mages
0 i T enlargement display section (p.121).
peReE '?“f"ﬂe— i You can lessen the degree of correction by moving the slider to
the left for the item you want to correct. e
.33 42 - You can respectively correct red chromatic aberration with the [R] elerence
Luminance noise reduction slider of the [Chromatic aberration] or blue chromatic aberration
gmminance noise r:::luctinn ” Wlth the [B] S”der'
0] () —— 0 When the list box for selecting an extender is displayed, select Index
the extender attached at the time of shooting from the list box.
Lens aberration correction Tune... .
( J Click the [OK] button.
T—— os The [Lens aberration correction] window closes and the result of
Sl e the corrections is applied to the image in the edit window and the @ @
Chromatic aberration OFF image is rediSpIayed.
Color blur OFF The result of the settings of the [Lens aberration correction] @
window is also displayed in the tool palette.
The [Lens aberration correction] window appears. In the main window, the [ g)¥] mark is displayed on the image to

indicate the lens aberration corrections (p.112).
65



About Shooting Distance Information Slider

When correcting RAW images shot with the cameras in the table below,
if shooting distance information has been saved to the image, the slider
is set automatically according to this shooting distance information.
However, if no shooting distance information is saved to the image, the
slider is set automatically to the right end at infinity position and a [<!>]
appears above the slider.

If the image’s shooting distance is not infinite, you can minutely adjust
the distance by operating the slider while looking at the screen.

EOS-1D Mark IV EOS-1Ds Mark llI EOS-1D Mark Il

EOS 5D Mark II EOS 7D EOS 60D

EOS 50D EOS 40D EOS REBEL
T2i/550D

EOS REBEL EOS DIGITAL REBEL EOS DIGITAL REBEL

T1i/500D XSi/450D XS/1000D

When correcting RAW images shot with the cameras in the table
below, it is set automatically to the right end at infinity position. You
can then minutely adjust the distance by operating the slider while
looking at the screen if the shooting distance is not infinite.

EOS-1D Mark II N EOS-1Ds Mark 11 EOS-1D Mark I
EOS-1Ds EOS-1D EOS 5D
EOS 30D EOS DIGITAL REBEL

XTi/400D DIGITAL

For RAW images shot with MP-E 65mm /2.8 1-5x Macro Photo or EF
50mm /2.5 Compact Macro with Life Size Converter EF, the slider
indicator changes to [Magnification factor].

[Shooting distance information] slider is applied to all the correction
items with check marks.

Correcting Multiple Images at a Time

Select multiple images to correct in the main window. Display tool
palette by clicking the [Tool palette] button (p.110) in the toolbar. If you
perform correction procedures (p.65) when tool palette is displayed, you
can apply the same corrections to all the images selected in the main
window.

Also, you can apply same corrections by copying the recipe of the
corrected image and pasting it onto the multiple images (p.41).

? Additional information

Some noise appeared in the periphery of an image after
correcting [Peripheral illumination]

You can reduce the noise by using luminance and/or chromatic noise
reduction of the noise reduction function (p.62). However, if you had
applied high amount of [Peripheral illumination] correction to the
images that have been shot at night or with a high ISO speed, the
noise might not be reduced.

The image appears with less resolution after correcting
[Distortion]

You can make the image similar to the one before correction by
applying more sharpness with the sharpness adjusting function
(p.31).

The colors of the image became weaker after correcting [Color
blur]

You can make the image similar to the one before correction by
adjusting the color tone (p.29) and/or the color saturation (p.94) to
make the color deeper.

The result of [Color blur] correction cannot be detected
[Color blur] correction is effective for correcting blue or red color blur

which occurs at the edge of the highlighted area of an image. If
conditions do not match, correction cannot be made.

® The periphery of the image may be truncated when [Distortion]
correction is made.

|§| For a list of the [Lens aberration correction] window functions, refer
to p.121.
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Performing Automatic Dust Erasure Processing

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

ana ¥ 112 MG 00S0.CAZ (3436 x 2304)

The Dust Delete Data that is appended to images shot with the camera

that can attach this data, can be used to automatically erase dust spots.

Compatible Cameras

EOS-1D Mark IV EOS-1Ds Mark Il EOS-1D Mark Il

EOS 5D Mark Il EOS 7D EOS 60D

EOS 50D EOS 40D EOS REBEL
T2i/550D

EOS REBEL EOS DIGITAL REBEL EOS DIGITAL REBEL

T1i/500D XSi/450D XTi/400D DIGITAL

EOS DIGITAL REBEL L L

XS/1000D

In the main window, select an image appended with
Dust Delete Data.

Click the [Stamp] button.

Digital Photo Professional - [ MacOSX /Users/canon/Pic

The copy stamp window appeatrs.

% e —

~» Dust spots are erased in a single operation.

Click the [OK] button to return to the main window.

S The [ &1 mark (p.112) is displayed on an image from which dust

spots have been erased.

Introduction

Contents at
a Glance

Basic
Operation

Advanced

Operation

Advamced
Imag iting
and PPinting

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00
©

67



? Additional information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.43).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.69) or the copy stamp function (p.71).
The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.42).

Ay

~
-

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

@ For a list of the copy stamp window functions, refer to p.122.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].

Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one.

In the main window, select the image you want to
erase dust spots.

Click the [Stamp] button.

Digital Photo Professional - [ MacOSX /Users/canon/Pic

® 9

Friniming Barch
Angle process

The copy stamp window appeatrs.

When the image has redrawn itself, double-click the
point from where dust is to be erased.

L] ¥ 112 MG 00%0.CRZ (3436 x 2304]

00 view ||| Full size wiew

Agply Duin Delete Data

- == D_ouble-
Ce= =0 click

The display changes to 100% view.
The display position can be changed by dragging.

Click the button that matches the dust spot to be
erased.
If the dust spot is dark in color, click the [ ] button, and if
the dust spot is light in color, click the [ ] button.
When you move the cursor over the image, the dust erasure
range appears as [O].
Place the dust spot to be erased within the [O] and
click.

Yl 171 MG_00%0.CRZ 1456 x 2104]

Click

The dust spot within the [Q] is erased.

Click on another part of the image to continue erasing dust spots
in the image.

To erase dust in another part of the image, click the button
clicked in step 4 again to cancel dust erasure processing and
perform the operation again from step 3.

When the dust spot cannot be erased, [(§)] is displayed.

Click the [OK] button to return to the main window.
The [8,] mark (p.112) is displayed on an image from which dust
spots have been erased.
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.71).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.43).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.42).

Ay

~
-

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 5, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 5, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

To apply dust erasure to the same place in several other images, you
can efficiently erase dust spots by clicking the images while holding
down the <38> key in the main window, or, by selecting multiple
images by clicking the first image and then clicking the last image
while holding down the <shift> key, and then displaying the copy
stamp window.

® For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.

|§| For a list of the copy stamp window functions, refer to p.122.
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Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1to 3in “Manually Erasing Dust (Repair
Function)” (p.69).

Specify the section to be copied.
Click on the section that is to be the copy source while holding
down the <option> key.
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy
Source position].

Correct the image.
Click or drag on the section you want to correct on the image. [+]
in the window indicates the copy source and [Q] indicates the
copy destination.
The copied image is pasted in the position to which it was
dragged.
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Click the [OK] button to return to the main window.
The [8,] mark (p.112) is displayed on a corrected image.

Transferring a RAW Image to Photoshop

A RAW image can be converted to a TIFF image (16bit) and transferred
to Photoshop.

Select the [Tools] menu » [Transfer to Photoshop].
Photoshop starts up and the transferred image is displayed.

? A single image can be transferred at a time

Only one image can be transferred at a time. To send multiple images at
a time, refer to p.87.

|§| Compatible versions of Photoshop are CS or later.
Transferred images are automatically converted to TIFF images
(16bit) to which an ICC profile (p.125) is added. The ICC profile
contains information about [Preferences] (p.80) or work color
space set for each image as described below and the appropriate
color information is relayed to Photoshop.
When you quit Photoshop, only the original RAW image remains,
and the transferred image will disappear. Saving the transferred

image as a separate image in Photoshop is highly recommended.

Setting Work Color Space

A different work color space (p.126) from the default settings (p.80) can
be set for each image.

Select the [Adjustment] menu » [Work color space] »
color space to be set.

? A color space set individually does not change even when the
default setting is changed

If you set an image with a color space different to the default setting and
then subsequently change the default color space setting (p.80), this
default setting will not be applied and the individually set color space will
remain.

A/

~

:@3 The color space of a RAW image can be changed freely as
many times as required

Since only the image processing conditions information changes, the
color space of a RAW image can be changed at any time.
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Printing with Shooting Information

You can freely lay out one image on one sheet of paper and print
together with titles and shooting information, etc.

Select one image to be printed.
Select the [File] menu » [Print with detailed setting].
Specify the required settings for printing, and then

click the [Print] button.
Switches the settings tab sheet

¥ IMG_0001.CR2

({ Printer | Image Text Settings )

Printer :

Media
Ad

Media orientation >

e 7
{_ Portrait

® Landscape

Media size:
297.0 mm x 209.9 mm

Print profile:

CMYK profile: h ¥

oo X_cme e )

Print preview

The image can be moved by dragging.

Drag the four corners of the image to change the size.

For the shooting information, click [E]] on the [Text] tab sheet
and select the necessary items in the window that is displayed.

Ay

Q= To maintain the settings

The settings of each tab sheet in step 3 are memorized when the [Apply]
button is clicked (excluding the contents of the [Text] tab sheet). The
settings can be applied to another image when printing.

|§| You can set printer profiles (p.80).

If CMYK simulation has been set, the image is printed in the set
colors (p.80).

)

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advapced
Imag iting
and Pfinting

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00

72



)

Printing a Thumbnail List (Contact Sheet Printing)

You can print rows of multiple images on one sheet of paper. _\"@'/_ To maintain the settings

Introduction

Select images to be printed in a thumbnail list. The settings of each tab sheet in step 3 are memorized when the [Apply] i ot
button is clicked (excluding the contents of the [Text] tab sheet). The g%ﬁ;ngea
. . settings can be applied to another image when printing.
Select the [File] menu » [Contact Sheet Prints]. g PP g P g
; ; : P |§| You can set printer profiles (p.80) hi'h
Specify the required settings for printing, and then _ ) OX) o _ Operation
click the [Print] button If CMYK simulation has been set, the image is printed in the set
' _ _ colors (p.80).
Switches the settings tab sheet Advanced
| Operation
Contact Sheet Prints
Printer : Ad ced
Imag iting
Media and Pfinting
A4
. Media orientation: Process'ng
 porteait Large Numbers
CLandscape Of |mageS
Media size:
S Editing
JPEG/TIFF
Images
CMYK profile: m
Reference
Apply Cancel Print
Index
Print preview
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Printing RAW Images on a High-End Canon Printer

Printing with a High-End Canon Inkjet Printer

For high-end Canon inkjet printers that are compatible with the printing
software Easy-PhotoPrint Pro, you can print with DPP by a simple
operation that has the following features:

Simple printing of RAW images

Printing in faithful colors

High quality printing using a wide color space of Adobe RGB, etc. and

the wide color reproduction range of a high-end Canon inkjet printer

To print with DPP, first install Easy-PhotoPrint Pro version 1.3 or later on
your computer.

Select the [File] menu » [Plug-in printing] » [Print
with Easy-PhotoPrint Pro].
Easy-PhotoPrint Pro starts up.

Match on-screen image colors and printing result

colors.
Select [Custom] in [Print Quality], click the [Set] button, and in the
window that appears, drag the slider to [1] at the right end, and
then click the [OK] button to close the window.
Next, click the [Color Adjustment] button to display the [Color
Adjustment] window and display the [Color Management] tab
sheet. Set [Color Mode] to [Enable ICC Profile] and [Printer
Profile] to [Auto], and then click the [OK] button to close the
[Color Adjustment] window.

Specify any other required settings for printing, and

then print.

? Additional information

Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
Function set in DPP that is not applied to printing

Specified CMYK simulation (p.80) is not applied.

The printed image’s color is not what you expected

In the Easy-PhotoPrint Pro window, click the [Color Adjustment]
button to display the [Color Management] tab sheet, set [Rendering
Intent] to [Perceptual] (p.126), and try printing.

Y

-@> Advantages of printing with Easy-PhotoPrint Pro

Printing with faithful colors

When a color space is set (p.71, p.80), it is automatically transmitted
from DPP to Easy-PhotoPrint Pro, allowing you to print with faithful
colors.

Printing with a wide color reproduction

When the color space setting (p.71, p.80) is set to a color space wider
than sRGB (such as Adobe RGB), the image is printed with a wider
color gamut than an image that has an sRGB color space, with green
and blue in particular being reproduced vividly.
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Printing with a Large-Format Canon Printer

You can use DPP to print with the DPP-compatible Canon large-format
imagePROGRAF printer. To print with DPP, first install imagePROGRAF
Print Plug-In for Digital Photo Professional on your computer.

Select the [File] menu » [Plug-in printing] » Plug-In
for the printer you use.
The Plug-In starts up.

Specify the required settings for photograph
printing, and then print.

? Additional information

A single image can be printed at atime

You can print a single image selected in DPP at a time. When printing
multiple images, perform printing for each image individually.
Functions set in DPP that are not applied to printing

Specified output resolution (p.76) and CMYK simulation (p.80) are not
applied.

Ay

-@> Advantages of printing with imagePROGRAF Print Plug-In

Printing with faithful colors
When a color space is set (p.71, p.80), it is automatically transmitted
from DPP to the Plug-In, allowing you to print with faithful colors.

Printing with a wide color reproduction

When the color space setting (p.71, p.80) is set to a color space wider
than sRGB (such as Adobe RGB), the color reproduction range of the
imagePROGRAF printer is fully utilized and the image is printed with
a wider color gamut than an image that has an sRGB color space,
with green and blue in particular being reproduced vividly.
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Specifying Preferences

You can change the various functions of DPP in the [Preferences]
window. Check the contents of each window and set.

Also, depending on the item, a detailed explanation may be available,
so refer to each window.

Select the [Digital Photo Professional] menu »
[Preferences].
The [Preferences] window appears.

Select the tab sheet, specify the settings, and then
click the [OK] button.

s ~)
Preferences

49 General settings | View settings Tool palette Color r gement }

Startup folder

) Last displayed folder

) specified folder

Browse... MacOSX Users [canon/Desktop

Save recipe

%) Display message when adding file |
() Add to file automatically |

Viewing and saving RAW images

® High quality (recommended)
| View images at high speed (moiré reduction off)
) High speed View/save RAW images at high quality
Moiré is reduced and the NR tool palette can be used

JPEG image guality

| Remove block noise and mosquito noise

[_| Display thumbnails at high guality

Default value of output resolution

350 dpi(1-60000)

At EOS Utility startup

| Edit image window enabled at EOS Utility startup

( Ccancel NE 0K b)

General Settings

You can specify the folder that opens when DPP is started up, image

guality of displayed and saved RAW images, etc.

Preferences

—{ General settings | View settings Tool palette Color management

Startup folder

{®) Last displayed folder

) Specified folder

Browse... MacO5X /Users canon/Desktop

Save recipe

)
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Viewing and saving RAW images

You can select from two types of image quality for displaying/saving
RAW images: high image quality with false color reduction processing
and noise reduction function (p.62) used, or high speed without false
color processing and noise reduction function used.

[High quality]
False color reduction processing is automatically applied, and the
image can be displayed/saved as a false color reduced-high quality
image. Furthermore, you can use the noise reduction function (p.62)
to reduce the luminance noise and chrominance noise.
Because the effects of the false color reduction processing and noise
reduction function are difficult to see in the [50% view] or [Fit to
window] display of the edit window and edit image window, use
[100% view] or [200% view] to check.
We recommend that you normally set [High quality] for a balance
between image quality and display speed.

[View images at high speed (moiré reduction off)] of [High quality]
If you checkmark [View images at high speed (moiré reduction off)],
when the image is displayed in the edit window or the edit image
window, false color reduction processing is hot applied. However, you
can use the noise reduction function.

As the setting is the same as [High quality] other than for image
display, the image undergoes false color reduction processing when it
is saved.

[High speed]
Since false color reduction processing is not applied, the display
speed of a RAW image in the edit window or the edit image window,
and the time it takes to save a RAW image is shorter than with [High
quality].
You cannot use the noise reduction function (p.62).
Depending on the image, it may be displayed/saved with false color
or noise being noticeable.

© For images shot with ISO speed range expansion set, the difference
in image quality between [High quality] and [High speed] becomes
remarkable. To check the image quality of images shot with ISO
speed range expansion, make sure to set [High quality] and check
the images in the edit window or edit image window.

JPEG image quality

[Remove block noise and mosquito noise]
You can improve the quality of a JPEG image by reducing the noise
particular to JPEG images.
This setting is also effective when RAW images are converted to
JPEG images and saved (p.42, p.86) and for JPEG images that have
been saved with a different name.

[Display thumbnails at high quality]
You can have the thumbnails for JPEG images automatically displayed
at high quality. If you checkmark [Display thumbnails at high quality],
all subsequent JPEG image thumbnails imported into DPP will be
displayed at high quality.

? The extent of the improvement in noise reduction

The higher the JPEG image’s compression rate, the more noise is
reduced. When the compression rate is low, the effect of noise reduction
is negligible.

Default value of output resolution

You can set the resolution for RAW images converted and saved as
JPEG or TIFF images (p.42, p.86).
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View Settings

You can specify settings relating to the display.

Preferences

General settings | View i | Tool palette Color gement

Crid pitch
64 Pixels(8-256)

Locking selected image

E Images cpened in Edit window remain selected in main window

Magnification in Edit window

Fit to window () 50% O 100% O 200%
@ - L

Magnification when the Edit/Edit image window is double-clicked

® s50% ) 100% O 200%

'RAW and JPEG

E Display only CR2 images for CR2 and JPEG files of the same name

Sort order in main window

# Retain sort order

_Highlight/shadow warning

Highlight 255 (ez-255 [N
Shadow o oo

Quick check tool display

B 50% C 100% (moiré reduction off)

r Cancel ) E’ —CH(—§

Sort order in main window

You can set the order of images which have been rearranged in the
main window to be maintained or not maintained (p.21).

If you checkmark the checkbox, the order of the rearranged images is
maintained even if you quit DPP or select another folder in the folder
area.

If you remove the check mark, the order of the rearranged images is not
maintained and reverts to the previous order when you quit DPP or
select another folder in the folder area.

Highlight/shadow warning

Highlighted/shaded areas that exceed the set range can be displayed
on the image as warning indicators (p.55).
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Tool Palette

You can specify settings for the tool palette.

Preferences

General settings View settings | Tool palette | Color m. gement

Default settings of RGB Tone curve mode

Tone curve mode Tone curve interpolation method Histogram
) RGERGEB ® Curve

) Luminance R G B () Straight

() Before adjustment

%) After adjustment

Tool palette display in Edit Image Window
(®) Docking display
) Floating display

Modified Picture Style settings

E Retain settings of each Picture Style

Tool palette display mode

[ Same for Main window and Edit window

Default noise reduction settings

@ Apply camera settings

() Set as defaults

RAW luminance noise reduction: o

RAW chrominance noise reduction: o

TIFF{JPEG luminance noise reduction: 10

TIFF/IPEG chrominance noise reduction: {0

r Cancel ) f 0K a

Default settings of RGB Tone curve mode

You cannot apply changes to the settings until you re-open the folder.

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

Modified Picture Style settings

You can select whether the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings will be changed or retained,
when you change the Picture Style.
If you checkmark the checkbox, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be changed to match the
camera’s preset settings, when you change the Picture Style.
If you remove the check mark, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be retained, even if you
change the Picture Style.

Default noise reduction settings

You can set a default beforehand for the noise reduction level.
RAW Images
» When [Apply camera settings] is selected, you can pre-set a noise
reduction level that suits the camera settings beforehand as the
default.
* When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand.
JPEG/TIFF Images
* You can set a desired default noise reduction level beforehand.
For images not having a recipe attached, the default set here for noise
reduction level is applied. However, if you want to apply settings to
images in the opened folder, you need to re-open the folder after making
settings here. For images with a recipe attached, the noise level
recorded in the recipe remains as it is and the default for noise reduction
level set here is not applied.

AL/
~

== Advantages of setting a noise reduction default

In instances where the same level of noise occurs in several images,
such as images shot with high ISO speed, setting an appropriate default
noise reduction setting enables you to apply a batch noise reduction
default to all the images displayed in DPP (excluding images with a
recipe attached). This eliminates the need to apply noise reduction to
each individual image. And, since you always shoot with the same
conditions, it is also useful when you want to set the same noise
reduction level for all shot images.
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Color Management

You can specify settings relating to color management, such as settings
for work color space, conditions for color matching, etc.

Preferences

+ General settings View settings Tool palette | Color management }

Default settings of Work color space
) sRGB

) Adobe RGB

) Wide Gamut RGE

) Apple RGB

) ColorMatch RGB

CMM settings for print
For display :
%) SRGB

) Monitor profile
ENG/Library/ColorSync/Profiles/Displays/Acer AL1922-1CAB49E4.icc

Printing profile: Rendering intents:

" None =)

CMYK simulation profile: Rendering intents:

None '¢]

Rendering intents when using Easy-PhotoPrint
) Perceptual

(®) Relative Colorimetric

Cancel \ f OK %

Default settings of Work color space

You can select from five types of color space (p.126) that is applied as a
default setting in RAW images. Color space that has been set is applied
as the color space when a RAW image is converted and saved (p.42,
p.86) or printed (p.43, p.46, p.49, p.72 to p.75).
If you have changed the setting, and you restart DPP, the new setting
is applied as the default setting color space.
You can check color space that has been set in an image in the main
window (p.110, p.111), the edit window (p.113), and the edit image
window (p.118).

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

|§| You can set a color space that is different from the default settings
for each image (p.71).

Display setting (color setting of the monitor)
Where a profile (p.125) is attached to the monitor you are using, you can
display an image in more faithful colors by setting the profile.

Select the [Monitor profile], click the [Browse] button and in the dialog
box that appears, select a profile for your monitor.

A/

5@3 Precise coloring with a third-party monitor color reader

If you use a profile created using a third-party monitor color reader,
images can be displayed in even more precise colors.
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Setting of printing profile (color setting of the printer)

Where a profile (p.125) is attached to the printer you are using to print
images, you can print an image and simulate the colors displayed on
screen by setting the profile. The profile that has been set is applied to
all printing (p.49, p.72, p.73) except for printing using a Canon inkjet
printer (p.43, p.46) or linked printing (p.74, p.75).

? The adjustment function of the printer driver should not be
used

Even if you set a printer profile, if you use the color adjustment function
of the printer driver, the image may print in colors different from those
displayed on screen.

-:\@/E Automatic settings for printing using EPP EX, EPP, and
linked printing

If you are printing using a Canon inkjet printer (p.43, p.46) or using
linked printing (p.74, p.75), a profile is set automatically even when the
[Printing profile] setting is not performed. This allows you to print faithful
colors easily.

Setting of CMYK simulation profile

You can select the color when printing in the CMYK environment of a
printing machine, etc. from four types of profiles (p.126) and perform
simulation on screen.
When CMYK simulation has been set, [CMYK] appears (p.110, p.111,
p.113, p.118) in the bottom of the main window, edit window and edit
image window, and colors can be checked.
To temporarily cancel CMYK simulation, press the <space> key.

Rendering intents when using Easy-PhotoPrint
You can set a rendering intent (matching method) (p.126) for printing
using Easy-PhotoPrint (p.46).

The rendering intent is ordinarily set to [Relative Colorimetric].

When colors with [Relative Colorimetric] are not satisfactory, set to
[Perceptuall.
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4 Useful Functions for Processing Large Numbers of RAW Images —

Introduction
For users shooting a large amount of RAW images, the convenient
function of batch processing large amounts of RAW images is explained
Contents at
here. a Glance
Utilizing Adjustment Contents (Recipe)................... 83 e
Saving RecipesasaFile.........ccccciiiee, 84 Operation
Loading and Pasting RecCipes...........cccccciviiiiiiiinnnnnn. 84
Copying a Recipe and Applying to Another Image..... 84 Advanced
. . Operation
Batch Apply White Balance to Images (Personal White
Balanc;e) N\ SR HR LR 85 Advanced
Registering Personal White Balance.......................... 85 |Image Editing
. . and Printing
Applying Personal White Balance ............ccccccceeeeene.. 85
Batch Save as JPEG or TIFF Images (Batch Lg’rréocsiggrs
PrOCESSING) . uvuiieiiiiiiie ettt 86 of Im&ges
Batch Transfer Images to Image Editing Software.. 87 E—
Batch Change the File Name of Images.................. 88 J'Trﬁgégf
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Utilizing Adjustment Contents (Recipe)

All the adjustment contents (recipe) made using the tool palette can be
saved as an individual recipe file (extension “.vrd”) and loaded and
applied to another image.
You can edit images efficiently by selecting and adjusting one image
from images shot with the same shooting environment and batch
applying the adjustment results to a large number of images.

& &% ¥ IMG_DO0L.CR2
—{ RAW | RCB = NR/Lens/ALO ]
‘Engmﬂess adjustment [ i|
‘While balance adjustment = ||
Register...
Shot settings i:]'( Tune |
‘Piclurt Style | & i|

Standard

i:]( Browse... |

Sl R

-10.0 -8.0 -6.0
Contrast:
Highlight-
Shadow:

| Linear
Color tone:

Color saturation:

-4.0

=20 0

{UJIII:I\I\

Unsharp mask

Strength:
Fineness

Threshald:

a
20 40

—»

RAW image data

I \N
L.vrdJ

Contents adjusted using the tool
palette can be handled
individually as a recicpe file
(extension “.vrd").

|§| The adjustment contents of JPEG or TIFF images (p.90) can be
saved as a recipe file (extension “.vrd”) and loaded and applied to
another image in the same way as with RAW images.

? Additional information

Recipe data includes tool palette contents

Recipe data includes adjustments made with the tool palette ([RAW],
[RGB] and [NR/Lens/ALOQ]). For this reason, other editing content
such as trimming or dust-erasure (copy stamp) is not included in the

recipe data.

Recipes adjusted with the [RAW] tool palette can only be applied

to RAW images

Adjustments in the [RAW] tool palette, which can only be made for
RAW images, are not applied to a JPEG or TIFF image even if they

are pasted.
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Saving Recipes as a File Copying a Recipe and Applying to Another Image
Select an edited image, and then select the [Edit] You can copy a recipe of an edited image and then apply it to another
menu » [Save recipe in file]. image.

The [Save] dialog box appears. Select the image from which arecipe is to be copied

Select the destination folder, enter a file name, and and then select the [Edit] menu » [Copy recipe to
then click the [Save] button. clipboard].

The recipe is copied.

"2 Check the contents of a recipe file by pasting to an image Select the image to which the recipe is to be applied

o _ _ and then select the [Edit] menu » [Paste recipe to
When you do not know the contents of a recipe file, paste it to an image

and check the settings in the tool palette. When only a few settings are SeleCted_ Imag e]j _
adjusted, we recommend you use a file name that describes the The recipe is applied to the image.
contents or that you separately record the adjustments as text

information.

Loading and Pasting Recipes

Select the image to which arecipe is to be applied,
and then select the [Edit] menu » [Read and paste
recipe from file].

The [Open] dialog box appears.

Select arecipe and click the [Open] button.
The recipe is applied to the image.
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Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific - :
shooting environment can be registered as personal white balance. You Applyl ng Personal White Balance

can then perform efficient white balance adjustment by applying this In the main window, select the image to which white
personal white balance to a large number of RAW images shot in the balance is to be applied

same shooting environment.
Click the [Tool palette] button on the toolbar.
. . . The tool palette appears.
Registering Personal White Balance paletie app
Adjust the white balance (p.27, p.28, p.56).
To adjust white balance, select a setting other than [Shot

Click the personal white balance number button that
IS to be applied.

settings] from the [White balance adjustment] list box (p.27). You ~—{RaW | RGB _NR/Lens/ALO s
will be unable to register the adjustments if you select [Shot [ i B
settings]. N " .00
In the [RAW] tool palette, click the [Register] button. [Whie balance adjustment (5]
The [Register personal white balance] dialog box appears. @ E BABE [[REgiﬁer.._ )
Select the button number to be registered from the L Dayiighe L Tune
list and click the [OK] button.
BN [#| Register personal white balance ‘Pictureswle iE.J
Register current setting in personal white balance Standard B ( Browse... )
Current setting: Click white balance £ 2

[ Custom 1 f :]]

( Cancel

A

h~1I}.EI -3.0 -6.0 -40 -20 O 20 4.0

Contrast: ) e ,5. v
Highlight: i s v s
Shadow: ()] '—.-—.TQ—.-.T
| Linear
Color tone: AU S
Color saturation: A e s
" Unsharp mask f ¢]
Strength: o m
Fineness: L ey
Threshald: 1)

Personal white balance is applied to all the selected images.
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Batch Save as JPEG or TIFF Images (Batch Processing)

You can batch convert and save edited RAW images to highly versatile
JPEG or TIFF images.

The images are saved as separate images, so the RAW images remain
unaffected.

In the main window, select multiple images to be
converted.

Click the [Batch process] button on the toolbar
(p.110).
The [Batch settings] window appears.

Specify the required settings, and then click the
[Execute] button.

Batch settings

Save folder

IMG_0001.CR2
IMG_0002.CR2
IMG_0003.CR2
IMG_0004.CR2
IMG_0005.CR2 Kind of file Exif-TIFF 8bit 3]
IMG_0006.CR2 — =
IMG_0007.CR2
IMG_0008.CR2
IMG_0009.CR2
IMG_0010.CR2
IMG_0011.CR2
IMG_0012.CR2 ' Resize
IMG_0013.CR2 Width Height Unit
IMG_0014.CR2 3456 | % 2304 pixel
IMG_0015.CR2 \/(34559!)«” {2304 pixel )

Lock aspect ratic

ENG/Users/canon/Desktop

File format

Output setting

Output resolution 350 dpi [ Embed ICC profile

Resize setting

File name

@ Current file name
String

C, New file name
String Sequence number
DPP_ 0001

Ex. IMG_0001.TIF, IMG_0002.TIF

Image transfer settings
! Open image using software

The batch processing dialog box appears and saving begins.
When all the images are saved, the [Terminate] button appears in
the batch processing dialog box.

In the processing dialog box, click the [Terminate] button.

'? [Save] cannot be performed

In the [Batch settings] window, you cannot perform [Save] or [Save As]
(p.41, p.105) to edited RAW images.

5@5 To save the developing/editing results for the version you are currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two differing versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, it is recommended that you convert and
save images as JPEG image or TIFF images.

AL/

=@ Skillful batch saving

While saving is being performed, you can continue working in
another window

Since the saving function operates independently in the background,
you can continue with an operation in another window such as the
main window or the edit window during the saving process.

To convert all images and save, do not select an image in the
main window

If you do not perform step 1 and perform step 2 with no image
selected in the main window, all the images displayed in the main
window will be converted and saved.

|§| If you have selected [New file name] in [File name], [Sequence
number] has to be set.
By saving as explained on this page, a trimmed image (p.38,
p.98) or dust-erased image (p.67 to p.71, p.101 to p.105) actually
becomes a trimmed image or dust-erased image.
For a list of [Batch settings] window functions, refer to p.123.
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Batch Transfer Images to Image Editing Software

You can transfer multiple images to image editing software. Unlike
[Transferring a RAW Image to Photoshop] (p.71), you transfer images
that have first been converted and saved as a seperate image, so the
transferred image will not disappear after quitting the destination
software. The software used here as an example is Adobe Photoshop
CS.

In the main window, select multiple images to be
transferred.

Click the [Batch process] button on the toolbar
(p.110).
The [Batch settings] window appears.

Perform settings required for transferring (e.g. file
format).

Click the [Browse] button.

Batch settings

IMG_000L.CR2 Save folder

IMG_0002.CR2 MacOsX /Users/canon/Documents ( Browse... )
IMG_0003.CR2
IMG_0004.CR2 :
IMG_0005.CR2 Kind of file Exif-JPEG 3}

File format

IMC_0006.CR2 Image quality T S eI o o
IMG_0007.CR2

IMG_0008.CR2 Output setting :
IMG_0009.CR2 7 .

IMG_0010.CRZ Output resolution 350 dpi [ Embed ICC profile
IMG_0011.CR2 Resize setting 3y

IMG_0012.CR2 ) Resize

IMG_0013.CR2 Width Height Unit
IMG_0014.CR2 3456 x 2304

IMG_0015.CR2 (3456 pixel ) (2304 pixel )

v
File Name

) Current file name
String

@ New file name

String Sequence number

oPe. ool [ save sequence number
Ex.: DPP_000L.PG, DPP_0002.JPG

Image transfer settings
# Open image using software

' ’ Browse.. ‘ '

Cancel ) (5 Execute )

The [Open] dialog box appears.

Select Photoshop CS.
In the [Open] dialog box, select a Photoshop CS file or an alias
and click the [Open] button.
The [Open] dialog box closes and [Image transfer settings] in the
[Batch settings] window is set to Photoshop CS.

Checkmark [Open image using software].

Image transfer settings

pen image using software

Adobe Photoshop C5 Browse...

f Cancel 3 ( Execute )

Click the [Execute] button.
The processing dialog box appears and batch transfer begins.
=» When the first image has been transferred, Photoshop CS starts
up and transferred images are displayed in transferred order.
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Batch Change the File Name of Images

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].
The rename window appears.

Specify the required settings (p.124) and click the
[Execute] button.

MacOSX/Users /canon/Pictures [Photo /xxxx_xx_xx

File Name Extension

DPP [ Shooting Date/Time |¥] Sequence number  [¥) Do not change 7]
Basic Settings Farmat settings
Sort Sequence number
@ Fit to main window UU.OI ) | Isave seguence number
: File Name
) Shooting Date/Time Shooting Date/Time
v e n Wt PE | Month Day Year 3
__ Copy & Rename r MM-DD-YY s

MacOSX/ Users/canon (Desktop @Insen underbar

Original File Modified File Name

IMG_0001.CR2 DPP_09-13-06_0001.CRZ
IMG_0001.JPG U DPP_09-13-06_0002.JPC U
IMG_0002.CR2 DPP_09-13-06_0003.CR2
IMG_0002.JPG DPP_09-13-06_0004.JPC
IMG_0003.CR2 DPP_09-13-06_0005.CR2
IMG_0003.JPG — DPP_09-13-06_0006.JPC
IMG_0004.CR2 DPP_09-12-06_0007.CR2
IMG_0004.JPG DPP_09-12-06_0008.JPG
IMG_0005.CR2 DPP_09-13-06_0009.CR2
IMG_0005.JPG ; DPP_09-13-06_0010.JPG

C :] < € : ]

Processing begins and the file names are changed.

? Changes cannot be made when the file name is duplicated

If a file name in red text has appeared in [Modified File Name], the file
name has been duplicated. Changes cannot be made if even one file
name has been duplicated. Change the settings so that duplication does
not occur.

@ The name of the movie files cannot be changed in DPP.

@ You cannot start up the rename tool from the [Collection] window
(p.36, p.111).
For a list of the rename window functions, refer to p.124.

Changing the File Name of Images in the Order in the Main Window

When you change the order of the images in the main window, you can
change in one operation the names of the files for the images, in the
order they were rearranged.

Change the order of the images in the main window
(p.21).

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].

Select [Fit to main window].

MacOSsx

File Name

Ll .
DPP ™ Shooting|
Basic Settings

Sort

f*) Fit to main window ]
__ File Name

() Shooting Date/Time

Specify the required settings (p.124).
To copy an image, checkmark [Copy & Rename].

Click the [Execute] button.
The file names are changed and the order in the main window is
maintained.
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5 Editing JPEG and TIFF Images )

Introduction

DPP is software mainly aimed for advanced RAW image editing, but it
also has JPEG and TIFF image editing functions. Here, the editing and

Contents at

saving of JPEG and TIFF images are explained. a Glance
Editing JPEG and TIFF Images...........ccovvvvvieeereenns 90 e
About the RGB Tool Palette .........ccccceeeeiiiiiiiiiiieeeee. 90 Operation
Automatically Adjusting Brightness and Color (Tone
CUrVe ASSISt) ..ocveiiiiii 91 Advanced
Adjusting Brightness and Contrast.................c..c..c....... 92 Gl
Adjusting Color Tone Using Click White Balance....... 93
Adjusting Hue, Saturation and Sharpness.................. 94 ,mAa‘;‘éaEgﬁ?ng
Tone Curve AdjUStMENt...........coveoveeeeeeeeeeeeeeeeeee e, 95 | and Printing
Adjusting Dynamic Range .........cccoeeeeveiiiiinneeeee. 96 Processing
ReAUCING NOISE ......coveeeeie e, 97 '-a{)%em’;";’;ggrs

-

Trimming and Adjusting the Angle of an Image....... 98
Performing Automatic Dust Erasure Processing ... 101 JP'EF,%?FF

Compatible Cameras............cccceeeveeeeeeeeieecccnnene, 101 Im#ges

Automatic Dust Erasure Processing in the Main

WINAOW oo 102 Reference
Manually Erasing Dust (Repair Function).............. 103

Erasing Unwanted Parts of an Image (Copy Stamp

T Ted i) 1) OO 105 Index
Saving Editing Results.............cccocoeieeiiiiiieeeeen, 105

Saving Editing Content to an Image............cccc......... 105

Saving as a Separate Image .............eevvvvrvvernnnnnnnnnnns 106 @ @
Applying Editing Contents to Another Image......... 106 @
PrNtING ..o 106
Re-Editing an Image........ccccceevvevveeiiiiieeeeeeiee e, 106
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Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as
RAW images using the [RGB] and [NR/Lens/ALQO] tool palettes.
Because adjustment made with the tool palette (recipe) only changes
the image processing conditions, the “original image data itself” remains
unaffected. Therefore, there are no problems with image deterioration
that arise with editing and you can readjust your images any number of
times.

000 ¥ IMG_0015JPC
RAW [RGB | NR/Lens/ALO

L0 ) 2]

Tone curve assist

v

Tone curve adjustment

e r [ c | s |

255

;

N

Contrast:

N
- 255
Brightness: O 01 —_—
[ERERRRRNT L (INRERUTRT] s
S

Contents adjusted using the tool
palette can be handled
individually as a recicpe file
(extension “.vrd”) (p.83, p.106).

Hue:

Saturation:

Sharpness:

In DPP all the adjustments (image processing conditions information)
made with the tool palette can be saved in the image as data called a
“recipe” (p.105), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.vrd”) (p.83, p.106).

About the RGB Tool Palette

With the functions in the [RGB] tool palette, you can adjust JPEG and
TIFF images with the same functions as ordinary image editing
software.

However, because the adjustment width of the adjustment functions in
the [RGB] tool palette is wider than the [RAW] tool palette, the image
color may be saturated, or the image quality may deteriorate if you
adjust too much. Therefore, take care not to adjust your images to an
excessive degree.

You can adjust RAW images with the functions in the [RGB] tool palette.

However, for functions other than tone curve adjustment (p.95) and
automatic adjustment (p.91), we recommend adjusting RAW images
using the same functions available in the [RAW] tool palette.
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.125). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click the desired automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most
images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.

RAW | RGB | NR/Lens/ALO

\Tf’"f Curve assist | [0 | [ | H—— Reverts the tone curve
Tone curve adjustment [ 5 | to the original Settings
we « [ [+
255 - High
Standard
D 3 .
u] 255

—

Eﬂghtﬂess trrrrrerrYrnrrn et I:l \:t
Contrast: '——‘Q——‘ ol
trnrrrerrYrrernnrent LA

r.Y

Huse: ||||||||||i|||||||||| |2! 0 :

Saturation: ’ @ B 100 ]
(AR EE R SR ERERE R R — e

Sharpness: @—igi 0 ?
TRLELER TR EEE LRI R ot

The tone curve changes as adjusted.

|
\\/

=@~ Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

* Images which have been shot with the proper exposure

» Images where the brightness is unbalanced

¢ Images which are too dark

* Images which have extreme backlighting

@ If you click the [[2%]] button, the tone curve as well as the [Hue]
and [Saturation] revert to the default settings. Take care when
adjusting the [Hue] and [Saturation] individually (p.94).
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Adjusting Brightness and Contrast

The brightness and contrast of an image can be adjusted.

. RAW | RGB | NR/Lens/ALD

‘Tane curve assist LEJ s H (Wi} |
Tone curve adjustment EJ|
WG R |G| s |

- |

255

0

Brightness:

Contrast:

Drag the sliders left or

right

l Enter numerical values

Hue:
Saturation:

Sharpness:

Pr———

0

YT O
100 =

"
DL

Brightness: Move the slider to the right to make an image
brighter and to the left to make an image darker.
Used to adjust modulation and degree of contrast
of color. Move the slider to the right to make
contrast of an image stronger and to the left to
make contrast weaker.

Contrast:

|§| The adjustment range is —100 to +100 (in 1-stop increments when
entering a value).
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Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

Click the [[~]] button.

[

. RAW | RGB | NR/Lens/ALO

‘Tnne curve assist | HE+ HED|
Tone curve adjustment L“_‘) |
R|c]s]

]

[l
W
LA

Erighm!ss trrrirerrfrerrrrene
Contrast: ’_'_—9_'_‘

Huﬁ: e e Yy [EJ
Satufatiﬂ‘n'_ ety nrrrene JEJ ]-DD.
Sharpness: Q—EJ

=

€D CID | ID | a0

(=]

Click on a point that is to be the standard for white.

ana | Digital Photo Professional - [ MacOSX /Users fcanon/Pictures (Photo/ oo xx_xo: IMG_D010PG |

The coordinates of the cursor position and the RGB values (8-bit
conversion)

=» The color of the image is adjusted with the point you selected as
the standard for white.
If you click on another point in the image, the white balance is
adjusted again.
To finish click white balance, click the [] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

5

The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.

The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any
adjustments (p.79).
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Adjusting Hue, Saturation and Sharpness

You can adjust hue (tone) and saturation and make the overall

atmosphere of an image harder or softer.

. RAW | RGB | NR/Lens/ALD

‘Tane curve assist { 7 i| ¥ I| Ebi|

e e e
Tone curve adjustment =] ||
e < | c |+ ]
e ;

255

Contrast:

0

Brightness:

255
s ot
trrrrrerrfenrrnrenn e
e — e
trnrrrerrYrrrrrnrent L

Hue:

Saturation:

Sharpness:

fivrrenneiinng i_b_j Dz—

Drag the sliders left or right

[EREEN ) et |‘r?|‘| D E_
el (%) 10 3—} Enter numerical values

Hue: Move the slider to the right to make color tones
more yellow, and to the left to make color tones
redder.

Saturation: Move the slider to the right to make the color
deeper, and to the left to make the color weaker.

Sharpness: Move the slider to the right to make an image
harder, and to the left to make an image softer.

? Sharpness is unnatural

Adjust sharpness with the window view set to [100% view], [50% view]
or [200% view]. If the view is set to [Fit to window] (full view), the
sharpness will seem unnatural.

|§| The adjustment range is —30 to 30 for hue, 0 to 200 for saturation,
and 0 to 500 for sharpness (in 1-stop increments when entering a
value).
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Tone Curve Adjustment

You can adjust the brightness, contrast and color of a specific area by

changing the tone curve (p.125).

Select the tone curve mode and interpolation

method.

RAW | RGB | NR/Lens/ALO -
|Tnne curve assist O I ED‘
Tone curve adjustment o]

T —
RGE N R Vs
. 7]
255
v Curve
Straight
v RGERGE
Luminance R G B
| )
] 235
Erlghtness IIIIIIIIIMIIIIIIIII DL
cuntraSL IIIIIIIIII\I/II|IIIIIII I:l-\:,-
Hue IIIIIIIIIMIIIIIIIII 3 D \1"
i — a
Saturﬂ“l}n. iI|IIIiIIMI|IIIiII| 2 ll:”:l A
sh : —_—
arpness \HIIIIIIIIIIIIIIIIIII S I:l-\:o-

<control> + click inside
the graph to display the
menu

Make adjustments.

Batch adjusts RGB
Adjusts each channel

——+— RAW [RGB | NR/Lens/ALOD

(D) T+ [izm]

|Tone Curve assist

Tone curve adjustment

Y

B~ <[+ )

Jﬂl\

—D 25.5 -
Brightness: Fm i i’
Contrast: m 0 i
Hue: m ‘2 _D:.i:
Saturation: m E E“}
Sharpness: m 2 05

Click to add a [[] (point)
Adjust by dragging []

The horizontal axis shows the input level and the vertical axis

shows the output level.
The maximum number of [[J] is 8.

To delete a [[]], double-click on the [[]].

The histogram display changes according to adjustment. You can

also fix the histogram display to the display before any

adjustments (p.79).

The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.79).
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Adjusting Dynamic Range

Dynamic range (width of gradation expression) from dark points to bright

points in an image can be adjusted.

Output
highlight point
numerical
value

Move downwards
Output highlight points

RAW | RGB | MRjLens/ALO

Move to the
right
Input shadow
points

Output shadow —|

pointnumerical
value

Input shadow —

point numerical
value

Sharpness:

Tone curve assist @J@tl@__l‘
Tone curve adjustment L__b_j['
RGE_| & | C | B | E
— 259 (
I
] 2557
Brightnegs: —m z
Cﬂntrasl} "_m‘ 0 z
ol ol
Saturation: _m E’J 'ﬁz

n
D\L

Move upwards
Output shadow points

— Reverts the

image to the
original
settings

— Move to the

left
Input highlight
points

— Input highlight

point numerical
value

The horizontal axis shows the input level and the vertical axis shows
the output level.

The setting range of shadow points is 0 to 247 (in 1-stop
increments when entering a value).

The setting range of highlight points is 8 to 255 (in 1-stop
increments when entering a value).

The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any
adjustments (p.79).
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)

Reducing Noise |
Introduction
You can reduce noise that arises in JPEG and TIFF images that have Click the [Apply] button.
been shot at night or with a high ISO speed. Noise reduction is applied to the image and the image is
redisplayed.
Select the [NR/Lens/ALQ] tab sheet from the tool Cg%ﬁ;&i:‘t
palette in the edit window or edit image window.
Click the [NR Preview] button. Basic
Operation
_ ] Advanced
The [NR Preview] window appears. Operation
Adjust an image.
8NN NR Preview Advanced
_ Image Editing
Navigator and Printing
window
| Processing
E'nlargement S _ ) . Large Numbers
display /@\ To set the same noise reduction level for several images of Images
T'LF:JPEGM . pagich After selecting multiple images in the main window, you can set the
I — Drag the same noise reduction level for the images without displaying the [NR = g
T zu sliders Preview] window, by adjusting the noise reduction level in the [NR/Lens/ JFI’ elsFF
( Cancel ) (ampiy) ALOQO] tool palette (p.115) using the [Luminance noise reduction] and

NR check| window button.
Reference
You can set a noise reduction level from within a range of 0 to 20.
The larger the setting, the larger the noise reduction effect. |§| If [Luminance noise] has been set, resolution may be reduced
The noise reduction effect can be checked when an image is along with reduction of noise.
displayed at 100% in the NR check window. If [Chrominance noise] has been set, color bleeding may occur e

You can change the display position of the NR check window by
dragging the enlargement display position in the navigator
window.

[Chrominance noise reduction] sliders, and then clicking the [Apply]

along with reduction of noise.

You can set the batch processing settings for noise reduction
beforehand, using [Default noise reduction settings] in the [Tool
palette] tab sheet in the [Preferences] (p.79). This is particularly
useful for applying noise reduction to all the images in a folder at
once, such as batch noise reduction for images with high ISO
speeds. However, where images have a recipe attached, the
noise level recorded in the recipe is applied.

For a list of [NR Preview] window functions, refer to p.116.
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Trimming and Adjusting the Angle of an Image

Adjust the angle of the image as needed.

You can trim only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes

vertical. You can also adjust the angle of an image before trimming.

Select the image to be trimmed.

Open the trimming/angle adjustment window.
Click the [Trimming Angle] button.

Digital Photo Professional - [ MacOSX /Users/canon/Pic

Frimming

The trimming/angle adjustment window appears.
Editing can be done once the image is displayed clearly in the
trimming/angle adjustment window.

Trimming/angle adjustment window

# 171 IMG_D001.JFG [3456 x 2304]

Largest
possible
trimming
range

Click
(rotate
image left
or right in
90-degree
increments)

| _
Drag* (0.01-degree increments;
adjustment range: -45 to +45 degrees)

Use the mouse (click A/V) to adjust the angle or
directly enter the adjustment angle* (0.01-degree
increments; adjustable range: -45 to +45 degrees)

* You cannot adjust the angle of images that exceed 6666 x 4444
pixels in size.

If you click [Center on Screen], you can display the trimming
range in the center of the window.

If you click the [OK] button after adjusting only the angle of the
image, the image will be trimmed at the largest possible trimming
range.

|§| When aspect ratio information is attached to an image shot with the
EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark IIl, EOS 7D or
EOS 60D, the trimming range based on the aspect ratio information
is displayed.
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Select aratio and drag the trimming range.

ann 171 IMG_0001 JPG (3456 x 2304]

Select a
trimming
ratio

Drag the
trimming
range

(708, 3620 - (2261, 14130 = (1577 = 051000901 Wk

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.

List of aspect ratios (width : height)

v Free
1:1
3:2
2:3
4:3
3:4
5:4
4:5
A Size Landscape
A Size Portrait
Letter Landscape
Letter Portrait
Custom

[Free]: You can trim an image to any size, regardless of the
selectable ratio.
[Custom]: You can trim an image at the specified ratio.

Click the [OK] button to return to the main window.
The trimming range frame is displayed in the trimmed image
(p.112).

When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its trimmed form.
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However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect
ratio set with the EOS 60D, its trimming range cannot be changed nor
reverted to the condition before trimming, since the image is actually
trimmed and saved in the set trimming ratio.

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.120).

Introduction
? About trimmed images - Convenient functions of the trimming/angle adjustment
window

The trimmed range can be reverted to its original condition at e g

any time Switch between screens using the keyboard a Glance

A trimmed image is displayed or printed as a trimmed image. You can also switch between full screen display/normal screen

However, since the image is not actually trimmed, you can always display by pressing the <38> + <F11> keys.

revert to the original image by clicking the [Reset] button in the Operate using the menu Basic

trimming/angle adjustment window or performing the “Re-Editing an : : ; Operation

ng/angle ad p g 9 Each operation can also be performed with the menu which appears

Image” procedure (p.106). by clicking on the image while holding down the <control> key.

Dlsp!ay Qf the trimmed image in eac.h wmdoyv . . Apply the trimmed range to another image o

* Main window: The frame showing the trimming range is You can apply the trimmed range to another image by clicking the Operation

o displayed on the image (p.112). N [Copy] button to copy the trimmed range, displaying another image

« Edit window: The image is displayed in its trimmed condition. and then clicking the [Paste] button.

* Editimage window: The thumbnail image is the same as the main To batch apply a copied trimming range to multiple images, select the Img‘é‘éaggﬁ?ng
window display, and the enlarged image is the trimmed image and the multiple images to which you want to apply and Printing
same as the edit window display. the trimmed range in the main window, and display the trimming/angle

Printing a trimmed image adjustment window. With the trimmed image displayed, click the PG

You can print as a trimmed image by printing it in DPP. [Copy] button and then click the [Apply All] button. This will apply the Large Numbers

The image becomes a trimmed image when saved as a separate trlmmmg range to aI_I th(_a images selected when the trimming/angle of Images

image adjustment window is displayed.

The trimmed JPEG or TIFF image actually becomes a trimmed image F')E IgFF

when saved as a separate image (p.106). d | b

Images that have aspect ratio set will be displayed as trimmed

Images o o i . © For images shot with ISO speed range expansion set, noticeable

When aspect ratio information is attached to a RAW image shot with noise may make it difficult to view image details in the trimming/ Reference

EOS-1D Mark IV, EOS-1Ds Mark lll, EOS-1D Mark 1ll, EOS 7D or angle adjustment window, so using this function is not

EOS 60D, the set trimming range based on the aspect ratio recommended.

information is displayed. Since the image is not actually trimmed, you

can change the trimming range or revert to the condition before ) S } ) ) Index

trimming. @ For a list of the trimming/angle adjustment window functions, refer

to p.120.
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Performing Automatic Dust Erasure Processing

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

ann ¥ 12 IMG.0080 PG [1436 x 2304

The Dust Delete Data that is appended to images shot with the camera
that can attach this data, can be used to automatically erase dust spots.

Compatible Cameras

EOS-1D Mark IV EOS-1Ds Mark Il EOS-1D Mark Il

EOS 5D Mark Il EOS 7D EOS 60D

EOS 50D EOS 40D EOS REBEL
T2i/550D

EOS REBEL EOS DIGITAL REBEL EOS DIGITAL REBEL

T1i/500D XSi/450D XTi/400D DIGITAL

EOS DIGITAL REBEL L L

XS/1000D

In the main window, select an image appended with
Dust Delete Data.

Click the [Stamp] button.

Digital Photo Professional - [ MacOSX /Users/canon/Pic

The copy stamp window appears.

»Dust spots are erased in a single operation.

Click the [OK] button to return to the main window.
=»The [@,] mark (p.112) is displayed on an image from which dust
spots have been erased.

@ Dust Delete Data is not attached to images having settings specified
during RAW processing on the camera for distortion correction,
chromatic aberration correction, etc. As a result, you cannot perform
automatic dust erasure processing on such images.
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? Additional Information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.106).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.103) or the copy stamp function (p.105).

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.106).

A/

~
-

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, refer to p.122.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »

[Apply Dust Delete Data].
Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one.

In the main window, select the image you want to
erase dust spots.

Click the [Stamp] button.

Digital Photo Professional - [ MacOSX /Users/canon/Pic

® 9

Friniming Barch

The copy stamp window appeatrs.

When the image has redrawn itself, double-click the
point from where dust is to be erased.

Tarn ) 1/2 MG 0050JPC [1456 x 2304]

Double-
click

L0 50 i 1 i s e

The display changes to 100% view.
The display position can be changed by dragging.

Click the button that matches the dust spots to be
erased.
If the dust spot is dark in color, click the [ ] button, and if
the dust spot is light in color, click the [ ] button.

When you move the cursor over the image, the dust erasure
range appears as [O].

Place the dust spot to be erased within the [O] and
click.

A L7 A D050 P [$436 = 2304]

——— Click

fr

NI ARNEE. W
i l

The dust spot within the [O] is erased.

Click on another part of the image to continue erasing dust spots
in the image.

To erase dust in another part of the image, click the button
clicked in step 4 again to cancel dust erasure processing and
perform the operation again from step 3.

When the dust spot cannot be erased, [(§)] is displayed.

Click the [OK] button to return to the main window.
The [ ] mark (p.112) is displayed on an image from which dust
spots have been erased.
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.105).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.106).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.106).

A/

~
-

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 5, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 5, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

To apply dust erasure to the same place in several other images, you
can efficiently erase dust spots by clicking the images while holding
down the <3B8> key in the main window, or, by selecting multiple
images by clicking the first image and then clicking the last image
while holding down the <shift> key, and then displaying the copy
stamp window.

® For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.

|§| For a list of the copy stamp window functions, refer to p.122.
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Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1to 3in “Manually Erasing Dust (Repair
Function)” (p.103).

Specify the section to be copied.
Click on the section that is to be the copy source while holding
down the <option> key.
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy
Source position].

Correct the image.
Click or drag on the section you want to correct on the image. [+]
in the window indicates the copy source and [Q] indicates the
copy destination.
The copied image is pasted in the position to which it was
dragged.
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Click the [OK] button to return to the main window.
The [@,] mark (p.112) is displayed on a corrected image.

Saving Editing Results

Saving Editing Content to an Image

All the contents (recipe) adjusted with the tool palette (p.90 to p.97) as
well as the trimmed range (p.98) and dust-erasure (p.101 to p.105)
information can be saved to a JPEG or TIFF image, or to a separate
JPEG or TIFF image.

Select the [File] menu » desired item.

Open in Edit window #O
Open in Edit window (enlarged)

Close all

Open window N

Close window W
Save #S

Save As... 1+ 35S

Add thumbnail to image and save {r38T

Convert and save... #D
Batch process... ##B

Create new folder... {r3EN

Page setup... {r 3P

Print... P

Print with detailed setting... 4 ¥D
Contact Sheet Prints... ~HP

Plug-in printing >
Add to collection ®G

Remove from collection 4 3G

Clear collection

Delete =
Info... £ |

Your adjustments are saved to the image.
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Saving as a Separate Image

If a JPEG or TIFF image is adjusted with the tool palette (p.90 to p.97)
and then saved in the same way as a RAW image as described below,
the image can be saved as a separate image with the adjustments
(recipe) applied to it.
Furthermore, if a timmed image (p.98) or dust-erased image (p.101 to
p.105) is also saved in the same way, it actually becomes a trimmed or
dust-erased image.

Saving as a JPEG or TIFF Image (p.42)

Batch save as JPEG or TIFF images (batch processing) (p.86)
By saving as a separate JPEG or TIFF image as explained above, the
adjustments made with the tool palette are applied, and some image
deterioration that accompanies editing/saving occurs as when editing
with ordinary image editing software.

Applying Editing Contents to Another Image

You can copy the adjustment contents (recipe) of JPEG and TIFF
images that have been adjusted with the tool palette and apply them to
another image with the procedures below, in the same way as with RAW
images.

Applying adjustment contents to another image (p.41)

Utilizing adjustment contents (recipe) (p.83)

Printing
Edited JPEG and TIFF images can be printed with the procedures
below as with RAW images.

Printing (p.43)

Printing with shooting information (p.72)

Printing a thumbnail list (contact sheet printing) (p.73)

Printing RAW images on a high-end Canon printer (p.74)

Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.90 to p.97), so the “original image data itself”
remains unaffected. Also, the trimming range or dust-erasure
information of a trimmed image (p.98) or dust-erased image (p.101 to
p.105) is simply saved to the image.

For this reason, you can undo any adjustments saved (p.105) to the
image, trimming range and dust-erasure information, and revert to the
condition when last saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu » desired item.

The image reverts to the conditions of the selected item.
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Reference

This reference section has been provided to enhance your experience
using DPP.

It contains various troubleshooting solutions, how to delete DPP from
your computer, explanations of the various windows and a glossary.
An Index is provided at the end of the chapter for you to easily find
information you are looking for.

Troubleshooting........ccuuiiviiiiiiii e, 108
Deleting the Software (Uninstalling) ...................... 109
List of Main Window (Folder Window) Functions .. 110
List of Main Window (Collection Window) Functions... 111
Image Frame Information in the Main Window and Edit

Image Window...........ccooeevviiiiiiieeeeee e 112
List of Edit Window Functions ..............ccccceeeeennnneee. 113
List of Tool Palette Functions ..............cccceeeeeevnnne.e, 114
List of NR Preview Window Functions................... 116
List of Quick Check Window Functions................. 117
List of Edit Image Window Functions .................... 118

List of Convert/Save One Image Window Functions 119
List of Trimming/Angle Adjustment Window Functions 120
List of Lens Aberration Correction Window Functions 121

List of Copy Stamp Window Functions.................. 122
List of Convert/Save Multiple Images Window (Batch
Processing) FUNCLIONS ..........ccoovevviiiiiiieeceeeeiie e, 123
List of Rename Window Functions........................ 124
GlOSSAIY ..ovviieeieeete e 125
[ L0 [ 127
About This Instruction Manual...............ccccocevvneeee. 131
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Troubleshooting

If DPP is not operating correctly, refer to the items below.

Introduction

Installation could not be completed correctly

You cannot install software unless you are logged into an account with
Administrator privileges. Log in again into an account with
Administrator privileges. For how to log in and how to specify
Administrator settings, refer to the User’s Manual for the Macintosh
computer you are using or for OS.

DPP does not work

DPP does not operate correctly on a computer if its system
requirements does not meet. Use DPP on a computer with compatible
system requirements (p.3).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.3), if other applications are running at the
same time as DPP, you may not have sufficient RAM (memory). Quit
any applications other than DPP.

The card reader does not detect the SD card.

Depending on the card reader and computer OS used, SDXC cards
might not be correctly detected. In such a case, connect your camera
and computer with the provided interface cable, and transfer the
images to your computer using EOS Utility (provided software).

Images do not display properly

Images that are not supported by DPP do not display. There are
various types of JPEG and TIFF images, so JPEG images other than
Exif 2.2, 2.21 or 2.3 compatible images and TIFF images other than
Exif compatible images may not display properly (p.3).

When a dust-erased image (p.67 to p.71, p.101 to p.105) is displayed
in a window other than the copy stamp window, it is displayed as it
was before dust erasure was performed. Check dust-erased images
in the copy stamp window.

An image could not be adjusted

The JPEG and TIFF images cannot be adjusted using the image
adjustment function of the [RAW] tool palette. Adjust these images
with the [RGB] tool palette (p.114).

A recipe could not be pasted (applied) to another image

You cannot paste (apply) rotation (p.10, p.25, p.110, p.117, p.118),
trimming (p.38, p.98), dust erasure (copy stamp) (p.67 to p.71, p.101
to p.105) of an image to another image as a recipe. Trim the image or
erase dust of the image using the copy/paste function in each window
and rotate each image individually.

The adjustment contents (recipe) of RAW images that has been
adjusted with the [RAW] tool palette cannot be applied to JPEG or
TIFF images (p.114).

The Auto Lighting Optimizer (p.61) is a function that is only available
for RAW images shot with EOS-1D Mark IV, EOS 5D Mark I, EOS
7D, EOS 60D, EOS 50D, EOS REBEL T2i/550D and EOS REBEL
T1i/500D. You cannot apply the Auto Lighting Optimizer’s adjustment
contents to RAW images shot with other cameras.

Color appears weak in the image when viewed with
other software

A RAW image which has a color space other than sRGB set (p.71,
p.80) and is then converted and saved as a JPEG or TIFF image will
appear weak in color when viewed in software that is only compatible
with SRGB color space. In this case, set the RAW image color space
to SRGB, convert again to a JPEG or TIFF image and save, and then
view this image.
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The colors of the image displayed on screen and
the colors of the printed image do not match

If the color of the monitor that displays an image is not adjusted
correctly, or if a profile for a printer that is to print images, has not
been set up, the color of the image displayed on screen and the color
of the printed photograph may differ greatly. If the color of the monitor
that displays images is corrected (p.80) and a profile for a printer is
set up correctly (p.80), the color of a printed photograph and the color
of an image on screen can be more closely matched. Using a Canon
printer (p.43, p.46) or linked printing (p.74, p.75) automatically sets up
printer profiles, so you only need to set the color of the monitor to
bring the colors closer together.

When printing using Easy-PhotoPrint and the Easy-PhotoPrint
automatic compensation function and the various types of image
adjustment functions are operating, colors are not printed correctly.
Cancel all Easy-PhotoPrint image adjustment functions (p.47).

Even if you set a printer profile, if you use the color adjustment
function of the printer driver, the image may print in colors different
from those displayed on screen. Do not use the color adjustment
function of the printer driver.

Printing a large number of images in batches cannot be performed

If a large number of images are printed in batches, printing may stop
in the middle or the images may not be printed. Reduce the number of
images to print or increase the memory on your computer.

A file remains in the folder after images are deleted

Delete [CRW_YYYY.THM] (camera index display image) if it remains
in the folder from which images have been deleted (p.49).
* Numbers are entered for [YYYY] in the file name.

The image information does not display

A JPEG image set to Adobe RGB and shot with EOS 10D and EOS
DIGITAL REBEL/300D DIGITAL may not display image information
(p.10, p.23).

Deleting the Software (Uninstalling)

Quit any applications before uninstalling the software.

Log into the account used when installation was performed.

When you have moved the folders and the software to be deleted to
the Trash, select the [Finder] menu » [Empty Trash] and empty the
Trash. You cannot reinstall the software until you have emptied the
Trash.

Display the folder in which the software is saved.
Open the [Canon Utilities] folder.

[ lala) 2 Applications =)
= m || %] Q
vor @ ‘J.%
R B
Mac05_10.4 i - gl
Mail OmniGraffle OmniOutliner
= |
| | _—
- | g (&5
Zm Dasktop i ’k(b @ @
| | Preview QuickTime Player Safari
(j'j canon |
N @,_.
‘[ "] Documents | ‘ A Y e
i Sherlock Stickies System Preferences
| % Movies
& Music 7
= i
[ Pictures | ] = e
TextEdit Utilities Canon Utilities
® & 37 items, 217.24 GB available G

Drag the folder for the software to be uninstalled to
the Trash.

Select [Finder] menu on the desktop » [Empty Trash].

The software is deleted.
When uninstallation ends, restart your computer.

@ You cannot retrieve data that you have emptied into the Trash and
deleted, so be particularly careful when deleting data.
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List of Main Window (Folder Window) Functions .10

Introduction

Shows/hides the tool palette (p.114) Image information (p.23) Cancels selection of all images Displays the trimming/
Shows/hides the folder area Selects all images Displays the quick check window (p.117) angle adjustment
S\_/vitches to the editimage ‘ Displays the copy stamp window (p.122) v‘vmdow (p-120) Contents at
window (p.118) 1 A , , , a Glance
@ Digitpl Photo|Professjional Fil§ Edit |View Bookmark Label |Adjustment Tpels Window Help E 4 Wed 10:48 AM Q 1
Digital Photo Professipnal - [ MacOSX/Users/canon/Pictures/Photo/xxxx_xx_xx ] F0|del’ path
Toolbar*! .
Batch conversion/ Basic

H *5 .
[Collection] tab sheet saving Operation

Fold

[Folder] tab sheet*® S— _ (p.86, p.87, p.123)
» | & Applications 3 :
3 Tempoay rams .| NN ’ % — Image rotation ot d
¥ & Users g A TR 4 i e i | . vance
. T;"Se";m., o (90 degree units) Operation
Check mark (p.19) T
o .
08 Muc Lo e i T T | Rating (p.19) Advanced
v 3 Pcures * Image Editing
Vt{:fzh?(:)xx,xx,xx and Prlntlng
» & Public
» [ shared ! Processing
) e Large Numbers
FOIder area* " IMG_0007.CRZ " ~ IMGLODDBCRZ '“ IMG_OD0S.CRZ ' ~ IMG_ODIOCRZ Of lmages
Editing
JPEGI/TIFF
Images
Reference
J Index
‘Adobe RGB / Adobe RGB High quality Recipe Ida(.-:: Yes Numbarlal images: 15 Numberlof selected images: 1 CMYK ,,f — CMYK Slmulatlon
| | display (p.80
Image color space and WOFKJ Display mode** ‘ Number of selected images play (p-80)
*3
color space™ (p.71, p.80) Recipe attachment status (p.83) Number of displayed images @ @
*1 To switch between show/hide, select the [View] menu » [Toolbar]. *4 The item selected in [Viewing and saving RAW images] (p.76) of the @
*2 The images inside the folders selected here are displayed in a [Preferences] window is displayed.
thumbnail list on the right. *5 You can switch between the [Folder] and [Collection] windows.

*3 Displays the coordinates of the cursor position and the RGB values (8-bit
conversion) when click white balance was performed with the tool palette. 110



List of Main Window (Collection Window) Functions 39

Image information Cancels selection of all images

Selects all images

Shows/hides the tool palette Displays the quick check window

Displays the copy

S\_Nltches to the edit image ‘ stamp window
window ,|
@ Digital Photo|Profi | Fil§ Edit |view Bookmark Label [Adjustnjent Tools Window Help E 4 Wed 9:46 AM Q
ano Digjital Photjo Professional - [Collection]
Toolbar ] .
. 1 Batch conversion/

[Collection] tab sheet saving
[Folder] tab sheet Folder

— Displays the trimming/
angle adjustment
window

— Rating

g MO g

— Image rotation
(90 degree units)

— Check mark
Adobe RCB / Adobe RGE High: guality Recipe data: No Number of images: 7 Number of selected images: 0 MK 1 CMYK simulation
. | ! . displa
Image color space and Work4 Display mode Number of selected images play

color space*? (p.71, p.80)

Recipe attachment status Number of displayed images

*2 Displays the coordinates of the cursor position and the RGB values (8-
bit conversion) when click white balance was performed with the tool
palette.

*1 The total number of images added to the [Collection] window is
displayed in the () in the [Collection] tab sheet. Accordingly, when an
image is added that is displayed as a single image (p.22), twice the
total number of displayed images is displayed.
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Image Frame Information in the Main Window and Edit Image Window (.10.p.34)

Information displayed when [Large thumbnail] (p.10) is selected

Digital Photo Professional - [ MacOSX /Users/canon

@U@ﬁw 2®®® ® 3 @
Ed 2 Fold Selec Clear all  Rotate left  Rotate right Cruick Stamp Trimming
Angle
Collection(0)
Check mark v 5 MacOSX
(p.18, p.19) > A Applications
’ 1 Temporary Items
¥ [ £ Users
¥ 1% canon
Ll Deskmp
L Travel
Rating mark P [ Documents
(p.18, p.19) b [# Library
| = Movies
Brightness adjustment Cil Music
value*! (p26) v = Plcture5
v [ Photo
[3 xxoux_xx_xx
> HE Public B MGOOLERE .~ 5 Y e
P | 1 Sites o " g | i g

File name

White balance icon*1 (p.27)

Image type*? Shutter speed*3

*1 Does not display with [Small thumbnail].

*2 Displays in RAW+JPEG images displayed as a single image (p.22).
[RAW] is displayed in RAW images.
(In [Small thumbnail] (p.10), [R] is displayed.)

*3 Does not display with [Medium thumbnail] or [Small thumbnail].

window and the edit image window.

window and the edit image window.

RGB adjustment mark*® *>
Unsaved editing content mark

Copy stamp mark
(p.67 to p.71, p.101
to p.105)

Lens aberration
correction mark (p.65)
Trimming range*®
(p.38, p.98)

Aperture*3

RAW adjustment mark*! *4

*4 Displays in an image edited with the [RAW] tool palette in the edit
*5 Displays in an image edited with the [RGB] tool palette in the edit

*6 When aspect ratio information is attached to an image shot with EOS-

1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS 7D or EOS 60D,

the image is displayed as a trimmed image.
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List of Edit Window Functions .11, p.25)

Path and file name of image

Tool palette*! (p.114, p.115)

/806 E Digital PI:mto Professional - [ MacOSX fUsers/canon/Pictures/Photo/xxxx_xx_xx/IMG_0001.CR2 ]

RAW ]IAdubE RCE CN!VK High qu?\lt\! %J

( 918, 1282): 79, 81, 93

® 6] 8] ¥ IMG_0001.CR2

——{ RAW | RGB | NR/Lens/ALO

|Erigl|mess adjustment - ‘
|While balance adjustment - ‘

Shot settings

|Piclure Style = ‘
Standard I:]( Browse... )
s
i S H
100 3.0 50 -40 20 0 20 40
Contrast: ADY S .5‘ e
Highlight: e
Shadow: e
) Linear
Calor tone: AR |E?\ S
Color saturation: AW .$‘ A
Unsharp mask s
Strength: e
Fineness: )
Threshold: Ol enssngen
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Operation
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of Images

Editing
JPEG/TIFF

Display mode**
Information display*2 _ o
CMYK simulation display (p.80)

Image color space*3 and work color space (p.71, p.80)

*1 To switch between show/hide, select the [View] menu » [Tool palette].
*2 Displays the coordinates of the cursor position and the RGB values (8-
bit conversion).

*3 RAW images are displayed with [RAW].
*4 The item selected in [Viewing and saving RAW images] (p.76) of the
[Preferences] window is displayed.
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List of Tool Palette Functions

RAW Tool Palette (p.25)

| “100 20 60 40 20 0 20 40

Contrast: 0 () 1

Highlight: L e

Shadow: o U?.;un
| Linear

Color tone: o= .E. (it

Color saturation: o &2

£ Unsharp mask | 3! )

Strength: e
Fineness: L
Threshold: |

* If animage is displayed enlarged, the enlargement display position can be

D 1® IMG_0001.CR2
———{ RAW | RGB | NR/Lens/ALO
Brightness adjustment -
| LJJ_ Brightness adjustment (p.26)
White balance adjustmant |3J
BESE e L White balance adjustment
Shot settings I-H(_ Tune... j (p27, p28, p56)
Hmmm =) Picture Style settings (p.26, p.59)
Standard ) ( erowse.. )
“ ' : - Dynamic range adjustment (p.57)

Contrast adjustment (p.29)

Shadow/highlight adjustment (p.57)

Linear setting (p.29)
Color tone and color saturation
adjustment (p.29)

Sharpness adjustment (p.31)

RGB Tool Palette (p.60)

Sharpness I':]
Sharpness: (1) T
\_

Enlargement display position*

moved by dragging. The enlargement display position appears when

[Docking display] (p.79) has been set and the edit image window (p.118)

has been enlarged.

e @ & ¥ IMG_0001.CR2
RAW | RGB | MR/Lens/ALO
|Tone CUrve assist O T | 2]
Tone curve adjustment |' +- |
RG] < [c [ s ] e
255
0 J
0 255
3 : ....—ﬁ@—_. n
Brightness: ERTTRY MO 0f-)
Contrast: 0 (<
i S e
Hue: pricn o el A0
—
Aiowidi - wede
Sharpness: t o 2]

Automatic adjustment
(tone curve assist) (p.33, p.91)

Click white balance (p.93)

- Tone curve adjustment

(p.58, p.95)

- Dynamic range adjustment (p.96)

Brightness and contrast
adjustment (p.92)

Hue and Saturation adjustment
(p.94)

Sharpness adjustment (p.94)

——— Enlargement display position*

)

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEG/TIFF

Images

Reference

Index

Q0O
)

114



)

Introduction
NR/Lens/ALO Tool Palette NR/Lens/ALO Tool Palette
(When a RAW image is selected) (When a JPEG or TIFF image is selected)
slala) 1¥| IMG_1001.CR2 000 1% IMG_1001JPG Contents at
| RAW  RCE | NRfLensfAlO )} _ RAW  RGB | NRfLensfALO } a Glance
IAum Lighting Optimizer I |Autn Lighting Optimizer |
B e—— - Auto Lighting Optimizer (p.61) Basic
L Low  Standard  Streng ) Low  Standard  Strong Operation
|Noise reduction LW‘I‘I— Apply noise reduction button (p.62) |Noise reduction kWTI— Apply noise reduction button (p.97)
RAW ___ NRPreview.. Displays the [NR Preview] window RAW ___ NRPreview.. Disp|ays the [NR Preview] window
minance noise reduction (p62’ pll6) minance noise reduction 97! 116
[ {L;'] “,, —a——— J— Luminance noise reduction for {L"m ”., o o (P b ) é‘;‘g?;‘{i’gﬁ
AT RAW images (p62) Chrominance noise redudr.“!_iTD_r_l
e ——— Chrominance noise reduction for o ; i
_TIFF/JPEG RAW images (p.62) TIFF/JPEG Advanced
Luminance noise reduction ( Luminance noige reduction }— Luminance noise reduction for Image Edltll’lg
0 0 7 1] 7 0 - S 20 JPEG and TIEE images (p97) and Prlntlng
Chrominance noise reﬁuct_i_nn ) Minance noise reguction ] ) )
o oo 20 L | ., Y J— Chrominance noise reduction for E—
. . . . SSI
Lens aberration carrection fwme. ] Lens aberration correction tuning [[ens aberration correction = | JPEG and TIFF images (p.97) Large Numbgrs
button (p.65) A\ U of Images
Peripheral illumination 63 Peripheralillumination
ST 2" |—— Lens aberration correction (p.65) WY~ Editing
Chromatic aberration OFF -::'If Priaticaly atior JPEG/TIFF
L Color blur OFF | Colaghiur |mages

Reference

——— Enlargement display position* —— Enlargement display position* Index
* If an image is displayed enlarged, the enlargement display position can @

be moved by dragging. The enlargement display position appears
when [Docking display] (p.79) has been set and the editimage window

(p.118) has been enlarged. 115
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List of NR Preview Window Functions .62 p.97) _
Introduction
Contents at
| N NR Preview 2 Elenes
Basic
Operation
Enlargement display
position Advanced
Operation
Navigator window
, Advanced
N Image Editing
N\ Image type* and Printing
Luminance noise reduction E ) : .
[{DJ = 5 = _2 55 Lumlngnce noise Processing
| : (ERRES" NN RNNRRN] - redUCtIOI’l LargeNumberS
Chrominance noise reduction ) ) ) of Images
o 06T 20 Chrominance noise
_'7' I A A O IO O O | J redUCtIOI’\ T
. . Editing
( Cancel ) ( Apply )_7 Apply noise reduction JPEG/TIFF
% button Images
NR check window Reference
Index
* When you select a JPEG or TIFF image and display the [NR Preview] @
window, [TIFF/JPEG] appears and you can reduce luminance noise

and chrominance noise for the JPEG and TIFF images.
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List of Quick Check Window Functions .16 p.18)

50% view/100% view (moiré reduction off)/full view*!

Check marks (p.18)

File name of image

2/15 IMt_DDGZ.CRZ [3456 x 2304]

Check mark display —I
Rating mark display

[ S0% view ]{ Full screen }—

Check mark

_(f|ea,- =

e oo

Rating

— Displaystheimage

in full screen*2

| Removes check

marks (p.18)

— Rating (Reject) (p.18)

L Rating (p.18)

( Pre\lrious ) C Next )

JAF Point

Switches between
displayed images

| Imageinformation |

::(:;.vnkotate left ) ( Rotate right )

Displays the AF
points (p.16)

[ Displays the image

information window
(p.24)

Image rotation
(90 degree units)

*1 You can select 50% view/100% view (moiré reduction off) by selecting
[Preferences] in the [Digital Photo Professional] menu and using
[Quick check tool display] in the [View settings] tab sheet. You can
also move the display position in the enlarged display by dragging the
image.

*2 To return to the normal screen, press the <esc> key.
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List of Edit Image Window Functions .3 p36)

Shows/hides tool palette Image information (p.23) Enlargement ratio of displayed image Displays the trimming/

Shows/hides thumbnail display area Shows/hides grid*4 Displays the copy stamp window angle adjustment window
Switches to main window ‘ (p.67 to p.71, p|.101 to p.105, p.122) (p.|38, p.98, p.120)
(pllo) "' Digitil Photo|Professjonal Flile Edit View Label Adjustment Tools Window Help B 4 Thu8:l4PM 1 |mage path and
8Do ¥ Digital Phatlp Professional - [ ENG/Users/canon/Pictures/Photo/xxxx_xx_xx/I1G_0003 [CR2 | == =

file name

Batch conversion/
saving

(p.86, p.87, p.123)

Toolbar

D@D B DO @@ @

—( RAW | RGB  MR/Lens/ALO

‘ Brightness adjustment EJ‘
0.00 .
‘While balance adjustment’ EJ‘ Image rOtatlon
‘12 ww | (90 degree units)
Shot settings B Tune.. )
— 5 Switches between
Standard 14 Bruwsel__—\J dlsplayed images
:/.
+—— Tool palette
: (p.114)
Thumbnail display area*3 Bt ¢ s wE
u p y Highlight: {ﬂlﬁ%
Shadow: {3
Color t:‘::w L e b
‘Color saturation: AT
Strength ) e,
Fineness 0 s
Threshold ([ s
=
®
em  wcoooscr: Lk
Information display*2 k(116 1308) 113,132,172 AW/ Adobe RGB CMYK ) igh quaiy ‘ -

|
I(Lnigieg(élg)r space™! and work color space  c1yk simulation display (p.80)  Display mode*s

*1 RAW images are displayed with [RAW].

*2 Displays the coordinates of the cursor position and the RGB values
(8-bit conversion).

*3 Displays images selected in the main window. The image selected
here is enlarged and displayed on the right.

*> The item selected in [Viewing and saving RAW images] (p.76) of the
[Preferences] window is displayed.
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List of Convert/Save One Image Window Functions .42

File name

Save destination

JPEG compression rate*3

Convert and save
|
Save As: DPP_001 | [+]
Types of image —
: : Where: [ 7 Photo f :*Jj
Type of image Extension
Exit-JPEG PG File format
Exif-TIFF 8bit TIF - — -
TIFF 16bit TIF Kind of file Exif-JPEG ]
Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG Image quality ] — 6 10
TIFF 16bit+Exif-JPEG | .TIF/.JPG _
QOutput setting _ 4 & \
Output resalution 350 dpi ] Embed ICC profile
Resolution*! |
( Resize setting - &R \_ D’
| Resize
. . Width Heigh Uni
Size changing*4 = _ o , -n?t— >
3504 w 2336 pixal
{ 3504 pixel ) (2336 pixal ) ¥y
f Lock aspect ratio
U J
I': Cancel :,I ( Save )7

Embeds of ICC profiles*? (p.125)

— Save

*1 The setting range is 1 to 60,000 dpi.

*2 Color space (p.71, p.80) information that is set in an image is attached
to an ICC profile.
Even if you remove the check mark from images that have been set to
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.71,
p.80), the ICC profiles are embedded automatically.

*3 The setting range is 1 to 10. The higher the numerical value, the higher

the image quality becomes.

*4 The larger of the two values set in [Width] and [Height] is applied to the
longer edge of an image and change its size.
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List of Trimming/Angle Adjustment Window Functions s p.9s)

Cancels all the trimming (aspect ratio) information

eno [ 1/1 IMG_0001.CR2 [3456 x 2304]

[ Full screen

J

{Angle

( Clear ) ( Reset +—

‘Aspect ratio )

[3:2 -

3.00 = 2.00 =]
Y

704 7] 362 [} J

Width Height

1577 [3] 1051 8
10.10 B8

Full screen display/returns to normal screen

—— Reverts to the condition when the image was shot

— Ratio of trimming range (you can also enter

numerical values if you have selected [Custom])*1

— Upper left coordinates of timmed range (you
can also enter numerical values)

—— Size of trimmed range (you can also enter
numerical values)

—— Angle of image adjusted

(Drag bar, use the mouse to click A/V¥ or enter
numerical values to set angle)

—— Copies the trimmed range and applies (pastes)
it to another image*2

—— Applies the copied trimming range to all other
images*?2

Switches between displayed images*2

{ Center on Screen

_— Level of opacity outside a trimmed range

—— Shows/hides grid lines
(Drag bar to set distance between grid lines)

Displays the trimming range in the center of the

( Cancel

) o

window

| (704,362)-> (2281, 1413) = (1577 x 1051) [ 1.50]

Trimming range

Displays borders around a trimmed range

Image rotation (90-degree increments)

*1 If [Free] has been selected in the [Aspect ratio] list box, you can also
drag the borders of the trimmed range to change its range.

*2_ Qperates when you have selected multiple images and the trimming/
angle adjustment window is displayed.
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List of Lens Aberration Correction Window Functions (s e eetion
When the list box for selecting an extender is displayed in the [Lens aberration correction]
window, select the extender attached at the time of shooting from the list box.
re - & Lens aberration correction - [IMG_1001.CR2] N Contents at
w a Glance
Basic
Operation
— Enlargement display section*!
Advanced
Operation
P Reset Reverts to the condition when the
” & \ — image was shot Advanced
Shooting distance information = Image Edltlng
& Shoo'ilng distance information and Printing
= slider*? (p.66)
| Peripheral illumination h . i i i . .
~ |— Peripheral illumination correction Processing
: s i | Large Numbers
) Distortion ) i . . of Images
=2 - m B Distortion correction
| Chromatic aberration : Edltlng
= - l— Chromatic aberration correction JPEG/TIFF
e 100 B Images
¢« Ji -~ })——+—Corrects blue chromatic aberration
i Color blur correction
= Reference
Shows/hides position of
¥ Mavigator enlargement display section
() Grid
( cancel ) (  oOK ) Index
Enlargement display position Corrects red chromatic Grid display

(Navigator display)

aberration

00
)

—

*1 The area you clicked on the image (Enlargement display position) is displayed at 200%.
*2 For RAW images shot with MP-E 65mm /2.8 1-5x Macro Photo or EF 50mm /2.5 Compact

Macro with Life Size Converter EF, the slider indicator changes to the zoom magnification. 121
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List of Copy Stamp Window Functions (.67t p.71, p.101 to p.105)

Introduction

E 1/2 IMG_0050.CR2 [3456 x 2304]

_ooview || rusizeview £— FUIl sSCreen display/returns to normal screen Contents at
{_hoply us peee 0 —i— Applies Dust Delete Data (p.67, p.101) a Glance
[ (L'g:ﬂo | 5:’0 | Types of dust to be erased (p.69, p.103)
~ ... —— Specifies the copy source (p.71, p.105) Basic
_ Fix Copy Source position ———— FjXes the copy source position (p.71, p.105) Operation
["g:::h — ]— Types of stamps (p.71, p.105)

Sets the size of the dust erasure range (p.69,

5o o} ]— p.103) or copy range (p.71, p.105) in a range of Advanced
5 to 100 (in one pixel units) (you can also enter Operation
a numerical value)
— Restores/redoes the image

Copies the dust erasure range or copy range and Advanced
applies (pastes) it to another image Image Editing

. . . and Printin
Switches between displayed images*  &nd Frinting |

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Set to 100% View to perform stamp operation. %

Index

* QOperates when you have selected multiple images and the copy

stamp window is displayed. @ @
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List of Convert/Save Multiple Images Window (Batch Processing) Functions (.se) et
Batch settings
IMG_0001.CR2 [5-4“-{9'#? = I } Save destination Contents at
IMG_0002.CR2 MacOSX /Users /canon/Documents Browse... ) a Glance
IMG_0003.CR2 .
File format
IMG_0004.CR2 m— :
IMG_0005.CR2 Hﬁnd of file Exif-JPEG - ¢D Basic
_ _ :ﬂﬁﬂﬁg?iﬁﬁ Image quality D —— JPEG compression rate*3 Operation
File names of images to be IMG_0008.CR2 Output setting Resolution*1
batch saved IMG_0009.CR2 AR R T .
IMG_0010.CR2 Output resolution 350 dpi W Embed ICC profile —— Embeds ICC pr0f||es*2 (p125) Advanced
IMG_0011.CR2 (Resize setting B Operation
IMG_0012.CR2 | Resize
IMG_0013.CR2 Width Height Unit B .
IMG_0014.CR2 3456 1 x 2304 Iy Slze Changlng*4 Advanced
{ 3456 pixel ) { 2304 pixel )
IMG_0015.CR2 || e J Image Editing
_ . < and Printing
Types of image rename e -
" Current file name
Type of image Extension String I_Procsssigg
Exif-JPEG JPG | e
Exif-TIFF 8bit TIF R e File name
TIFF 16bit TIF String Sequence number Editing
Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG PP 0001 [ save sequence number JPEG/TIEE
- - CExc DPP_0001 JPG, DPP_0002 JPG Images
TIFF 16bit+Exif-JPEG | .TIF/.JPG \ J
rflﬂage_tf:?\ns_fgr settings )
L} Spenlmage ssing oibirece Batch transfer to other image Reference
L bttt J editing software (p.87)
’ Convert RAW images only \ "_'_ Cancel ‘ { Execute }

Index

Images to be converted are limited to RAW images*> Save

*1 The setting range is 1 to 60,000 dpi.

*2 Color space (p.71, p.80) information that is set in an image is attached
to an ICC profile.
Even if you remove the check mark from images that have been set to
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.71,
p.80), the ICC profiles are embedded automatically.

*3 The setting range is 1 to 10. The higher the numerical value, the higher
the image quality becomes.

*4 The larger of the two values set in [Width] and [Height] is applied to the
longer edge of an image and change its size.

*> Appears when you click the [Batch process] button (p.110, p.118)
without an image selected in the main window or the edit image
window. To convert RAW images only, instead of clicking the [Execute]
button, click this button.

Q0
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List of Rename Window Functions @.ss)

Introduction

MacOSX /Users/canon/Pictures/Photo/ xxxx_xx_xx

Contents at

( File Name Extension ) S h il a Glance
DPP 3 Shooting Date/Time 3 Sequence number B Do not change 3 ets the new file name
. J
(- Basic Settings i ) N ( Format SENUIGS e h
) ) ] Sort Sequence number o BaSI(,:
Order in which Images are sorted ¥ Fit to main window 0001 _| Save sequence number peration
" File Name
" Shooting Date/Time : : . .

= g e fTime Sets the format of information
Check mark to apply the same —H{ V' same file name for RAW-) images Month Day Year 3 in the file name Advan(.;ed
name to RAW images and JPEG ( __ Copy & Rename - Browse.. ) MM-DD-YY 3 Operation
ImageS recorded Slmu|tal’leOUS|y MacOSK/Users /canon (Desktop Elnser‘t underbar
Check mark to copy the images L ) Advanced
Click the [Browse] button and set Original File Modified Filediame Irér:nadgg> Er?tlithngg
the save destination IMG_0001.CR2 DPP_09-13-06_0001.CR2

IMG_0001.JPG U DPP_09-13-06_0002JPC U

IMG_0002.CR2 | lDPF_09—13—05_UOD3.CRZ Process'ng

IMG_0002.JPG iDPP_09—13—05_0004JPG La]’ge NumberS

IMG_0003.CR2 DPP_09-13-06_0005.CR2

IMG_0003 JPG — [DPP_09-13-06_0006.JPC Of lmages

IMG_0004.CR2 !DPF_OQ—IZ—Uﬁ_UOD?.CRZ
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Glossary
RAW image

EOS DIGITAL camera RAW images are recorded in an uncompressed
14bit or 12bit format.

Because RAW images are special images in an undeveloped status,
you need software with development processing functions such as DPP
in order to view them. The advantage of the undeveloped RAW images
is that you can make a variety of adjustments to RAW images with
almost no deterioration of the image.

* *RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image

The most ordinary image in non-reversible compressed 8bit format.
The advantage of this is that by saving at a high compression rate, the
file size can be small, even for image data that has a high pixel count.
Because during saving and compression part of the data is thinned out
to make the file size small, every time you edit or save, the image
deteriorates.

With DPP, even if you repeat editing/saving, only the recipe data is
modified, and no overwriting or compression occurs so the original
image data does not deteriorate.

* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image

Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for
saving an image while maintaining the original high image quality.

* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe

The “Image processing conditions information” for RAW images that can
be edited in DPP is called a “recipe”.

Further, in DPP, you can perform image editing on JPEG and TIFF
images that use “recipes” as with RAW images.

bit number

Binary unit of information volume in the color of an image. The number
shows the number of bits per pixel.

The larger the number of bits, the more the color numbers and the
gradation becomes smoother. A one-bit image is a black-and-white
image.

Color Management System (Color Matching)

Digital cameras that shoot images, monitors that display images, and
printers that printimages each have a different way of creating color. For
this reason, there may be a difference between the color of an image
when viewed on a monitor and when printed.

A color management system is a system for managing color in order to
bring these colors closer together. With DPP, you can more closely
match color between different devices using ICC profiles between
different devices.

ICC profiles

ICC profiles are files containing color information such as color
characteristics and color space for various devices, set by the ICC
(International Color Consortium). Most devices such as the monitor we
use to view images or the printer we use to print images can be
managed (color management) using these ICC profiles and the color
between different devices can be more closely matched.

DPP has color management that uses these ICC profiles.

Tone Curve

A tone curve shows values before adjustment (input) as the horizontal
axis on a graph, and the values after adjustment (output) as the vertical
axis. Since the values of before adjustment and after adjustment are the
same before any adjustment is made, the tone curve displays as a
straight line from bottom left to top right, and by changing this tone
curve, you can adjust in detail the image’s brightness, contrast and
color. The more you go right on the horizontal axis, the more the plus
value it becomes, and the higher you go on the vertical axis, the more
the plus value it becomes.
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) ) ) Introduction
Color space CMYK simulation profiles
A color space is the reproducible color range (color gamut A profile that simulates colors when printing in a CMYK environment
characteristics). DPP supports the following five kinds of color space. (printing machine, etc.). With DPP, you can simulate color with four Contents at
sRGB : Standard color space for Windows. Widely used for types of profile. a Glance
the standard color space of monitors, digital Euro Standard : Profile normally used for book printing in
cameras, and scanners. Europe, suitable for simulation of standard
Adobe RGB : A wider color space than sRGB. Mainly used for European printing. Basic
printing for business purposes. JMPA : Profile normally used for book printing, etc. in R
Apple RGB : Standard color space for Macintosh. A slightly Japan, suitable for simulation of magazine
wider color space than sRGB. advertising standard color printing. Advanced
ColorMatch RGB : A slightly wider color space than sRGB. Mainly U.S.Web Coated : Profile normally used for book printing in Operation
used for printing for business purposes. North America, suitable for simulation of
Wide Gamut RGB : A wider color space than Adobe RGB. North American standard printing.
Refer to the color chart below for the color area of each color space. JapanColor2001 type3 : Profile becoming a standard in the Japanese Advanced
printing industry, suitable for simulation of 'Qna(?%ﬁgt'ith"gg
Color chart of color spaces compatible with DPP JapanColor standard printing.
Processing
Y . .
Rendering intent o images
Rendering intents are color conversion methods when printing an image.
The conversion method of each rendering intent is shown below. Editing
Perceptual : Before and after conversion, all colors are JPEG/TIFF
Color range that can be converted to maintain the relationship between IEE/ES
seen by the human eye colors. Even where colors slightly change, you
can print a natural-looking image which has
maintained color harmony. However, Reference
depending on the image, the saturation may
change overall.
Relative Colorimetric : There will not be much conversion to colors |
. o : ndex
which are similar before and after conversion,
x but colors which are not similar are converted
appropriately. Because there are little changes
Gamma White point to similar colors which comprise most of an @ @
value (color temp.) image, you can print a natural-looking image in
—— | SRGB 2.2 6500K(D65) which the saturation has not changed greatly.
R Adobe RGB 22 6500K(D65) However, depending on the image, there are
............ Apple RGB 1.8 6500K (D65) cases where the overall tone of an image
- ColorMatch RGB 1.8 5000K(D50) c_ha_nges somew_hat as colors which are not
______ Wide Gamut RGB 22 5000K(D50) similar and highlights change. 126




Index

A

AJUSE JPEG IMAGES......eiiiiiiiiiiiiiiieieee et 90

AdJUST RAW IMAGES.....uuuiiieiiiiiiiiiiiiiiiiiitieiteeeieeseeeebeebeeeeeeeeeesseeseeeseeeeees 25

AJUSE TIFF IMAGES.....eeiiiiiiiiiiiiiiee e 90

Adjusting (JPEG or TIFF Image)
Automatic Adjustment (Tone Curve ASSISt).......ccoeeeeieeiieciiciiiinns 91
BIIGNINESS .oviiieiiiiiiieieeeee ettt 92
Click White BalanCe .............uuuuuuuiiiiiiiiiiiiiiiiiiiiiiiiiiiiineeeeeeeeeenneeneees 93
CONAST ... 92
DYNamiC RANQE .....eeiiiiiiiiieieiiieeeeeeeeee e 96
HUB e 94
RGB TOOIl Palette .....ovveieieieiieeecce e 114
SALUFALION ..t 94
SRAIPNESS ...ttt e ettt e e e e e e e eeeees 94
Tone Curve AdJUSIMENT......cooiiiiiee s 95

Adjusting (RAW image)
ApPlY AdJUSIMENES.....cco e 84
Automatic Adjustment (Tone Curve ASSISt).......ccceeevvieerreeeeviinnnnnn. 33
BIIgNINESS e 26
Brightness of HighlightS.............oooi 57
Brightness of ShadoWws.............ooiiiiiiiiiiiiiice e 57
Click White BalanCe ...........ooovuiiiiiiiiieeiiieeeiee et 28
COlOr SALUFALION ......eeieeeiieee e bes 29
(070 (o] gl =T 0] 01T = L 11| (= 56
L] (o gl o] = SRR 29
COlOr WREE L.t e e e e 56
L7001 1= 1= RSP 29
COPY AQJUSTMENTS ....vviiiiieeeiiiiiieie e 84
DYNaMIC RANQE .....vviiiiiiiieeieeieeeeeeeeee e 57
11 C=T O = 1= o! AP 30
MONOCNIOME ..o 30
Personal White BalanCe ... 85
PiICTUIrE STYIE .o 26
Picture Style File .......ooooiiiiiie e 59
RAW TOOI PalETe .....ceveieiiiiiiiiiiiieee e 114
Save AdIUSIMENTS ....euiiiiiiciceece e e 84
Tone Curve AdJUSTMENT.........uiiii i e e 58
TONING EffECT ..o 30
TOOI PAlBHE «.cceeeeeeeee e 114, 115

White BalanCe .........cooooiiieii e 27
Adjustment Contents (RECIPE)........uuuuuuueeeieeiiiireeeeiieeieeeeeeeeeeeeeeeee 83, 125
AdODE RGB ... s 126
APPIE RGBi.... s 126
AITaNge IMAGES .. .oevei e e e e e enaas 20, 21
AUto Lighting OPtIMIZET .....oooiiiiiiieee e 61
Automatic Adjustment (Tone Curve ASSISt) ......ccoovvvvviiiiiiiniieeeeeeenns 33,91
Automatic Dust Erasure Processing.......cccccveeveveevveenennn. 67, 68, 101, 102
B
Batch Apply White Balance to Images (Personal White Balance)....... 85
Batch Change the File Name of Images.........ccccccevvviiiiiiiiieieeeeeiiee 88
Batch Convert/Save Images (Batch Process) .......cccccccceeeviveeevvveennnnnnn, 86
Batch Process (Batch Save JPEG and TIFF Images)................ 86, 123
Batch Process of Multiple Images

Change File NamMe .........oooiiiiiiii e 88

Convert/Save (BatCh ProCess)..........uuvvvvvvrveevvvervinnrenerennnennns. 86, 123

Personal White Balance............ccccoooviiiiiiiiicee e 85

ReCIpPE Data ........oovvviiiiiiiiiiie 83

= U5 (= 87
Batch Settings WINAOW..........cccooiiiiiiiiiiiiiienes 86, 87, 123
Batch Transfer IMages .........ccocciiuiiiiiiiiiiiiiiiieriiee e reeeeeeeeeeees 87
Batch Transfer Images to Image Editing Software.............cccccoeeuvnnee. 87
Before/After Comparison Display ............coceeiiiiiiiiiiiiiiieeeeeceen, 53
DIt NUMDET ... eeeeees 125
BOOKMArK ... e 51
BIIgNINESS ... 26, 92
C
Change File Name........oouuiiii e e 88
Changing the File Name of Images in the Order in the Main Window. 88
Check Mark ... 18, 19, 112, 117
Chromatic Aberration COrreCtion ..........ccoeeeeieeiieiieececc e 65
Chrominance Noise Reduction (JPEG, TIFF Images).......ccccccceeeeennnn. 97
Chrominance Noise Reduction (RAW IMages) .........ccccuvvvvveeeiiiniinnnn. 62
Click White BalancCe...........ccoooiiiiiiii 28, 93
CMYK SIMUIALION ©.civniiii et e e 80, 81, 126
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Collection WINAOW .......ceuniiiiiiiiiciee e eeans 6, 36, 111
(0] (o] g =1 [ G @o] 1 {=Tox 1 o] o HU TP PPPPTPPPPRR 65
COlOr Chalt.....coeiiieeeeeeeee 126
Color Management (Color Matching)............ccoeeeee e, 125
Color Setting of the Monitor (Profiles) ..., 80
Color Setting of the Printer (Profiles).........cccccccvviiiiiiiennneenn. 80, 81
COl0r SPACE ... ittt 126
[CC PIOfIlES .. 125
Color Management (PreferenCes)......ccccuvveeeiiieeeiiiiiie e 80
Color SAtUrAtioN ......cceeveieee e, 29
Color Setting of the Monitor (Profiles)........ccovvviiiieiiiiiien e, 80
Color Setting of the Printer (Profiles) .........cccocovviiiiiiiiiiiiiieeeeen 80, 81
L0701 [0] g o 1> o1 = S 126
AdODE RGB ...cvviiieeecc s 126
APPIE RGB ... 126
Color Space Setting for Each Image ...........ccevvvevveeviiiiieeeieeveeeeee, 71
(7] [o141Y/ =1 (od 1 2 L €1 = S PP 126
Default Setting of Color Space .......ccvvvevvviiiiiii 80
SRGB ... .t e e e aaaan 126
Wide GamUut RGB........oooiiiii 126
Color Space Setting for Each Image...........cooocvviiiiiieeiiiiiiiiieecee e 71
Color TEMPEIALUIE......cceeeeieieiieeeee e, 56
(0] (o] g o] o [ TN 29
COlOr WNEEI ...t 56
ColorMatCh RGB........cooviiiiiieeeeee e, 126
Compatible Cameras with the Lens Aberration Correction Function.. 63
Compatible Lenses with the Lens Aberration Correction Function..... 63
Contact Sheet Printing (Printing a Thumbnail List)............................. 73
(@0 1 == A 29, 92
Convert to JPEG or TIFF Image and Save................... 42,86, 119, 123
Convert/save One Image WINdOW ...........ccoooriiiiimiiiieeeenniniineee. 42,119
Copy Stamp (Image Correction) .........ccccoeeeeeeeeeeee, 71, 105
Copy Stamp Window ...........ccceeeveiiiiiiiee 67, 69, 101, 103, 122
Copying and Pasting (Applying) ReCIPES.........ccccvvvvveiiiiiiii 84
Correct Images (Copy Stamp Function) .........ccccceveveeeeienn. 71, 105
Creating a Folder ... 50

D

Default Noise Reduction SettingsS............oovvuiiiriiieeeiiiniiiiieeee e 79
Default Setting of Color SPace ..........ccuuvviiiii i, 80
Delete IMAGES ....cooiiiiiiiie e 49
Deleting

Delete IMAageS.....ccovvviiiiiiieiee e, 49

Delete the SOftWare ............uvviviiiiiiii e 109
Deleting DPP (Uninstalling) ......ccoooevviieeiiiiiii i 109
Detailed Setting Printing (Printing with Shooting Information)............. 72
Display

Before/After Comparison Display...........ccccceviiiiiiiiiiiieeiiiiiieeeeenn 53

Enlarged Display (Edit WINAOW) ..........cevviiiiieiiiiiiiiiieeeeeee 11, 113

Enlarged Display (Quick Check Window) ...................ooo. 16, 117

Shooting Information Display ...........ccevevvveiieeiiiiiiieiieeiiieeeee, 10, 23

Single IMage DiSPIAY .........vvveiieiiiiiieeieieeieeeeeeeeeeeeeee e ee e 22

Synchronize Edit WINAOW ..........cooooiiiiiiiiieeeeeeee e 54

Thumbnail Display (Main Window).............ccccvveeeeeeiininiinnne. 10, 110

Thumbnail Display and Enlarged Display

(Edit Image WINAOW) ........cuuriiiieeiiieieeeeeeereereeeeeeeveeseeeeeeeeeeeeees 34,118
D1y (0] g 1[0 ] g I @] ¢ {=Tox i o] o HN PRSP 65
Downloading an Image to Your COMPULET .........coovviiiiiriieeeeeiiiiiiiieeennn 7

Downloading Images from a Camera ..........cccevevvvviiniieeeee e, 7

Downloading Images from a Card Reader..........cccccceevveeeviveeiinnnnnnn. 9
Downloading IMAgES .......uuuuueiiiiiiiiiiiiiiiiiieiieeiieeee et eeeeeeeeeeeeees 7
Downloading Images from a Camera..........cccccuvvvvvvnieminreninninreinnnennnn, 7
Downloading Images from a Card Reader .................ueeveeeeieeieeeeeeennnnnne.
Dust Delete Data ..........cueveeeieeiiiiiiiiiiiiiee i
Dust Erasure Processing

Automatic Dust Erasure Processing .........ccceeeeeieveieeeeeeieenns

Image Correction (Copy Stamp Function)

Manual Dust Erasure (Repair Function) ...............................
DYyNamiC RANQE ......cii it e e e e e eanees 57, 96
E
Edit Image WiNAOW........ccooiiiiiiiiiii it e e ee e 34,118
Edit WINQOW.....oe ittt 11, 113
EdItiNG. ..o —>Adjusting
Enlarged Display (Edit WINAOW) ........coooiiiimiiiiiieeieiiiiieeeeeee e 11, 113

)

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

00
©

128



Enlarged Display (Quick Check WIiNdOW) ...........cooooviiiriiieeeniniiiineee. 117
EOS LY. ..eeeeieee e 7
F
False Color REAUCHION ......u.ieiviiieieee et 76, 77
1= g = =T o 30
(0] [0 L G AV A o o [0 )1V T 6, 110
G
General Settings (PreferenCes) .......vceeiiiiivieeeeiiiiiie e 76
H
H I e Cover
Highlight Area Warning INdiCator .................euevueeiiieiieiiiieiiiiieeeeeeeieeeeee. 55
HUB e 94
I
(@ O = 0] 111 125
Image Frame Information (Image Marks) ........ccccccvvviiiiiieeeeeeeeivnnnnnn, 112
Image Marks (Image Frame Information) .............cccccuveveeieennnniiinnnnn. 112
Image Quality
Default Noise Reduction Settings...........ccvveveeiiiiiiiiiiiieeeeeeiine 79
False Color REAUCHION ........vvieiiiie e 76, 77
Improve the Quality of an Image (Main Window) ......................... 23

Noise Reduction of a JPEG Image (Luminance, Chrominance) .. 97
Noise Reduction of a RAW Image (Luminance, Chrominance) ... 62

View and Save a RAW Image ... 76, 77
Image Shooting Information Display ...........c.eeevviieiiiiiiiiiiieeeeees 10, 23
Improve the Quality of an Image (Main Window)..........c.c.cceevvvvvvvnnnnnn. 23
J
N | o T [ 41= (o [T PP PP PP PP PP PPPPPPPPPT 125
L
Lens Aberration COrreCtioN ........ccccoiiiiii e 63
Lens Aberration Correction Window .............cceeevvniiiieieeeeennnnnns 65, 121
T PSSP 29
Loading and Pasting (Applying) RECIPES ..........uvvvvvvrverieiiirieeeeeeeeeeeeeen, 84
Luminance Noise Reduction (JPEG, TIFF Images).....ccccccccvveerveeennn.. 97
Luminance Noise Reduction (RAW IMages) ........cccvvveeevevveeereereeneenn. 62

M
MAIN WINOOW ..ceiiiiieie et e et e et e eaa s 10, 110
Manual Dust Erasure (Repair FUNCtion) ..........ccovvvvviiinieeeneeeennns 69, 103
MONOCRHIOMEE.....ciiiiii e 30
Filter EffeCt ... 30
ToniNgG EffeCt ... 30
MoOVE O COPY FOIEIS .....ooeieiiiiiiieeeee e 51
Move OF COPY IMAGES ....uuiiiieiii e e e e eees 50
N
Noise Reduction (JPEG or TIFF IMage).......cccvveveeeriiiiiiiiiieeee e 97
Noise Reduction (RAW IMAQJE) ......cccvvveeeiriiiiiii e e e e e 62
Noise Reduction of a JPEG Image (Luminance, Chrominance) ......... 97
Noise Reduction of a RAW Image (Luminance, Chrominance) .......... 62
NR Preview WINAOW ..........oiveuieiie et 62, 97, 116
NR/Lens/ALO Tool Palette ............cuvveeeiiiiiiiiiiee e 115
@)
Organize IMAGES ciiieee ittt 49
Organizing IMaGgES ......oooeeiee oo 49
Create @ FOIEr .........uiiiiiieieeeeee e 50
Delete IMAGES ....vveeiiiieiieeieee et 49
Move or Copy FOIAErS.......coiiii i 51
MoVve OF COPY IMAGES ....uveii e 50
Register Folders as Bookmarks...........ccccceeviiiiiiiieeie e 51
P
Peripheral lllumination CorreCtion ..............c.c..evveeeveeeieereeeeeeeeereeeeeeeeeeees 65
Personal White BalanCe ................uuuuiiiiiiiiiiiiiiiieiiiieiiiieeeeeeeeeee e 85
PICtUre StYIE ... 26
Picture Style File. ... 59
PrefErENCES ...ooiiii et 76
(O] (o 1Y/ =T g F= To [T 1 1T o | P 80
GeNeral SENGS ....uvuuuririiiiiiieiiiiiiierrererreerrre e 76
TOOI PalEHE ....cviiiiii e 79
VIBW SEEINGS ©.eviiiiiiiiiiiitiiie et e e e 78
Printing
Printing a Thumbnail List (Contact Sheet Printing) ............ccccee.... 73
Printing One Sheet of Paper..........occcvviiiiiiiiiiiiiees 14,49
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Printing Using Easy-PhotoPrint ... 46
Printing Using Easy-PhotoPrint EX ...........cccccoiiiiiiiiiie 43
Printing with a High-End Canon Printer...........cccccvvvvvveeeiiiniinnn. 74
Printing with a Large-Format Canon Printer............ccccccoooooeee. 75
Printing with a Printer other than Canon Printers..............c.......... 49
Printing with Canon Inkjet Printers .........ccccccvveeeiiie e, 43, 46
Printing with Easy-PhotoPrint Pro ...........ccccccceiiiiiiiiiin e 74
Printing with Shooting Information (Detailed Setting Printing)...... 72
Rendering Intents when Using Easy-PhotoPrint .................... 80, 81
Printing a Thumbnail List (Contact Sheet Printing) ..........cccvvvvvvvveene... 73
Printing One Sheet of Paper...........ooviiiiiiiiiiiiieeeeee e 14, 49
Printing Using Easy-PhOtOPTINt..............cuuuiiiiiiiiiiiiiiiiiiiieiieneeeeeeeeeeeeeee. 46
Printing Using Easy-PhotoPrint EX..............euueiiiiiiiiiiiiiiiiiiiiieeeeeeieeeeee. 43
Printing with a High-End Canon Printer ............cccccvvvvvveviveveeeeeeeeeeeeee, 74
Printing with a Large-Format Canon Printer ............ccccccvvvveeeveeeeeeeeen.. 75
Printing with a Printer other than Canon Printers..........cccccvvevvvvvveeeee.. 49
Printing with Canon Inkjet Printers.............eveeiiiiiiiiiiiciiieiieeeeeee. 43, 46
Printing with Easy-PhotoPrint Pro...........ccccvvvvvviviiiiieiiieiiieeeeeeeeeeveeeee, 74
Printing with Shooting Information (Detailed Setting Printing) ............ 72
Q
QUICK CheCK WINOOW........ccvvuiieiiiiiceeeee e 16, 117
QUILEING DPP ...t e e 14
R
RALING. ...t i 18, 19, 117
RAW IMAGE....cceeiiiei et 125
RAW TOOI PAIELLE ........ueiiiiiiiiiiiiiiiiiiiiiieiiieiiie ettt 114
Re-Adjusting an IMage ........oooiiiiiiiiiiieeee e 43, 106
o1 01 83, 125
RECIPE FlE .. 83
Re-Editing an IMage ........coevviuiiiiiii e e e e e e e eeens 43, 106
Registering Folders as BoOKmMarks...........cccceveeeeiiiiiiiiiieeeeeseiiie 51
ReNaME WINAOW.........uuiiiiiiiiiiiiiiieeee e 88, 124
Rendering Intent (Matching Method) ..........ccccceeeiiiiiiiii, 126
Rendering Intents when Using Easy-PhotoPrint ................... 80, 81
Rendering Intents when Using Easy-PhotoPrint.......................... 80, 81
Repair (Manual DUSt Erasure) .............eeeeeeerveeeereeeeereeeeeeeeeeeeeeeees 69, 103

RGB TOOl Palette. ... .. eeeeee 114
Rotate Images .......covvvvviiiiiiiii e, 10, 25, 110, 111, 117, 118
S
SALUFALION e ———— 94
Save
Batch Convert/Save Images (Batch Process).........cccccceonee 86, 123
Convert to JPEG or TIFF Images and Save .........cccccevvveeeee.. 42,119
Y=Y PP PP PPPPPPPPPPPPP 41, 105
SV A 41, 105
Save JPEG or TIFF Image as a Separate Image ............ccceuunn... 106
View and Save RAW IMages.......ccooeeiieieieeineeeeeees 76, 77
T VST T 41, 105
SAVING RECIPES. ... i 84
SeleCt IMAGES...cccc e, 10, 16, 34
Shadow Area Warning INdiCator............cooeeeiiiiieiiicciicccens 55
SNAIPNESS ... 31,94
Shooting Information Display...........cccccceii 10, 23
SNOMCUL KEYS ...ciiiiiiieiiieiee et Cover
Single Image Display ... 22
Single Image Display of RAW and JPEG Image...........cccccceveeeviiinnen. 22
Sorting Images
(O g T<Tod Q1 1 1= 1 18, 19
RAINGS ..oieeeiieeeeeeeee 18, 19
SRGB ...t aaas 126
Starting UP DPP ... e e e e 6
SUPPOIEA IMAGES ... 3
Synchronization (Edit WINAOW)..........ccceiiiiiiiiiieiie e 54
Synchronize Edit WINAOWS .........oouuiiiiiiieeiiiiiieee e 54
SYNCHIONIZE IMAQJES ....ccvviiiie e e 54
SyStem REQUITEMENTS ......uviiiiiiiiiiiiiiiii et 3
T
Thumbnail Display (Main WIiNAOW) ..........cccovriiiiiiiiineeniniiiieeeennn 10, 110
Change the Display.......cccccoviviiiiiiiiii e e 10
Thumbnail Display and Enlarged Display (Edit Image Window) ......... 34
Thumbnail Display of Images (Main Window) ..............cooooeeeeeiiieeeene 10
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Change the DiSPlay ...........uueuuueiuuuiiiiiiiiiiiiiiieiieeeieeiieeeeeeeeeeeeeeeeeeeees 10
TIFF IMAQGE ...ttt e e e eeeanes 125
TONE CUINVE ..t e et e e e e eenenes 125
Tone Curve AJUSIMENT .......cvviiiiiiiieiiiieeeeeeeeeeee e ee e 58, 95
Tone Curve Assist (Automatic Adjustment) ..........ceeevvvevviicennnenn. 33,91
TONING EffECT....oi e 30
Tool Palette

NR/Lens/ALO Tool Palette ..........ccvvveviieiiiiiiiiiiiiiieieieeeeieeeeeeeee 115

RAW TOOI Palette......uvvviiiiieiiiiiiiiiieeiieiieeieeeeeeeeeeeeeeeeeeeeee e eeeeeeees 114

RGB TOOI PAIELLE ....cceieeeiiiiiiiiiiiiee e 114
Tool Palette (PreferenCes) ........c.uuiieiiii i 79
Transfer

Batch Transfer Images to Image Editing Software....................... 87

Transfer an Image to Photoshop........ccccociiiiiiiiiiiicins 71
Transfer an Image to Photoshop ... 71
Trimming and Adjusting the Angle of an Image............ccccceeeee. 38, 98
Trimming/Angle Adjustment Window..........ccccooevveevivieiiinnnnnn. 38, 98, 120
U
[0 L] = T 1 1 4 F= T 32
\%

View Settings (PreferenCes) ........evvvieoiiiiiiiiiieee e 78
W
WHhItE BAIANCE.......uuiiiiiiiiiiiiiiiiiiiiiiit ittt eeeeeeeeeeeees 27

Click White BalanCe ............oooouiiiiiiiiiiiiiiiieeee e 28, 93

(070 (o] g =T 0] 01T = L L1 ] (= 56

COlOr WREE L.ttt 56

Personal White BalanCe ... 85
Wide GamUE RGB ........uuuiiiiiiiiiiiiiiiiiiiiiiiieeiievveeeveee e eeeeeeeeeeeeeeees 126
WOTK COlOr SPACE.... oot i e e e e e e aaneens 71

About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademark Acknowledgments

© Macintosh is a trademark of Apple Inc., registered in the United States
and other countries.
Adobe and Photoshop are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other
countries.
Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.
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